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Chapter 1: Introduction to TraCS 

The Traffic and Criminal Software (TraCS) is a data collection and reporting tool for the public 
safety community. In North Carolina, TraCS is used to submit an electronic version of the paper-
based NC Crash Report Form DMV-349. The electronic form is called the North Carolina Crash 
Report Form (NCCRF). This user’s guide contains information on how to use TraCS and 
complete the NCCRF. To view or download the electronic version of this user’s guide, go to 
https://connect.ncdot.gov/business/DMV/Pages/Law-Enforcement.aspx. 

North Carolina Crash Requirements 

Highway safety starts with crash data. 

Only the investigating officer can collect timely information at the crash scene and provide the 
experience, objectivity, and professionalism needed to represent the public’s interest. The 
information recorded by the officer should be based on his or her professional opinion. 

North Carolina General Statute 20-166.1(h) requires that DMV provide the crash form used by 
all law enforcement officers to report motor vehicle crashes in North Carolina. 

North Carolina motor vehicle laws states that a reportable motor vehicle crash must meet at 
least one of the following criteria: 

 The crash resulted in a fatality, or 

 The crash resulted in a non-fatal personal injury, or 

 The crash resulted in total property damage amounting to $1,000.00 or more, or 

 The crash resulted in property damage of any amount to a vehicle seized, or 

 The vehicle has been seized and is subject to forfeiture under North Carolina General 
Statute 20-28.2. 

In addition, a reportable motor vehicle crash must occur on a trafficway (any land way open to 
the public as a matter of right or custom for moving persons or property from one place to 
another) or occur after the motor vehicle runs off the roadway but before events are stabilized. 
The terms collision, accident, and crash are synonymous when describing a motor vehicle 
crash. 

https://connect.ncdot.gov/business/DMV/Pages/Law-Enforcement.aspx
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After the investigation of a crash is completed, North Carolina General Statute 20-166.1(e) 
requires that the investigating officer make a written report of the crash within 24 hours. The law 
enforcement agency (LEA) must submit the report to the Division within 10 days after receiving 
it. 

A Crash Fatality Notification Form must be submitted to DMV within 24 hours after the fatality 
occurs. To download the form, go to https://connect.ncdot.gov/business/DMV/Pages/Law-
Enforcement.aspx. 

The National Highway Traffic Safety Administration (NHTSA) defines a motor vehicle traffic 
crash investigation as the thorough examination of all elements contributing to the crash, 
resulting in a well-founded explanation of the series of events which occurred based upon the 
factual data. 

When an officer submits a NCCRF to DMV, he or she provides valuable data to many groups of 
people working to make North Carolina streets and highways safer. It is important that officers 
are also aware of some of the state level uses of this data, such as enforcement of North 
Carolina’s financial responsibility law by DMV. Other users of the data may include: 

 County engineers planning to resurface a road 

 City consultants developing safe school routes 

 A high school driver’s education teacher planning a curriculum 

 A public works director planning reconstruction of a hazardous intersections 

In addition to county and city officials, other users of crash data include the university 
researcher studying the problems of older drivers, the automobile manufacturer evaluating a 
design or the people at all levels of the public and private sectors that support law 
enforcement’s efforts to combat drunk driving. 

Traffic crash reports are subject to be viewed by lawyers, judges, insurance companies, and the 
public. Crash prevention programs and successful prosecutions in court are dependent upon 
proper and complete crash investigation and report writing. Subsequent levels of investigation 
rely on the quality of the information contained on the DMV-349. The location of the crash, the 
road condition at the time of the crash, and other evidence at the scene, cannot be replaced or 
recreated unless the investigating officer documents the crash accurately. 

  

 

IMPORTANT: When the death resulting from a crash occurs within 12 months after 
the crash, the investigating agency must submit a supplemental report, including the 
death, to the DMV. 

!

https://connect.ncdot.gov/business/DMV/Pages/Law-Enforcement.aspx
https://connect.ncdot.gov/business/DMV/Pages/Law-Enforcement.aspx
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Access Levels 

The TraCS interface varies based on user permissions. Permissions are based on access levels 
assigned to a user by their agency's administrator. One access level is assigned to each user 
and TraCS displays only the functions that apply to the assigned access level. The three user 
access levels are: 

Agency Administrator 

The agency administrator access level is intended for those individuals who are responsible for 
implementing and maintaining the TraCS program within an agency. The agency administrator 
can add and delete users, and assign access levels to their users. The agency administrator 
cannot create or accept crash reports. Refer to the TraCS 10 Law Enforcement Agency (LEA) 
Administrator’s Guide for more information on implementing and maintaining TraCS at the 
agency administrator access level.  

 
NOTE: A user ID can be assigned only one access level. i
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Supervisor 

A supervisor is someone that oversees the patrolling officers of an agency. The supervisor 
access level is intended for those individuals who perform everyday supervisory functions within 
TraCS, such as: 

 Accept a reporter's form before electronically transmitting it to the NC Division of Motor 
Vehicles. 

 Reject a reporter’s form and send the form with the rejection reason back to the reporter. 

 View a reporter’s DMV-rejected form after the reporter completes a send/receive 
transmission. 

In addition to the functions of the supervisor access level, supervisors also have the ability to 
create, validate, and accept their own NCCRF. Figure 1 shows the NCCRF process flow for a 
supervisor. 

 

Figure 1. NCCRF Process – Supervisor 
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Reporter 

Reporter access level is intended for those individuals who collect data from crashes. Users 
assigned to this access level can only view and edit their own forms. 

Reporters send their validated NCCRF forms to their supervisor using the Send/Receive Forms 
function. Figure 2 shows the NCCRF process for the reporter.   

 

Figure 2. NCCRF Process – Reporter 
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Form Status by Access Level 

The NCCRF goes through a series of stages from the time it is created until it reaches its final 
storage location. Each stage is referred to as the form status. The form status displays in the 
Status column on the Forms Grid, as shown in Figure 3, and on the title bar of the Forms 
Viewer. 

 

Figure 3. Forms Grid Status Column (Reporter’s View Shown) 

Locked forms can be viewed but not edited. Table A and Table B describe each status based on 
the user’s access level.  

Table A. Reporter Access Level 

Status Locked Description 

Open No User is currently working on the report. 

Open Yes Improper program shut down (power outage). Requires administrative 
unlock. 

Validated No The report has been validated, but not sent. 

Validated Yes The report has been sent to the supervisor for approval. 

Rejected No The report has been rejected by the supervisor or DMV and sent back to 
the reporter for correction. 

Transmitted No The report has been accepted by DMV and has an assigned Crash ID. 

 

  

Form Status Column 
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Table B. Supervisor Access Level 

If You Need Assistance 

This user’s guide and the TraCS Help system are designed to answer most of your questions. If 
you encounter a system message or need assistance, contact Operations Support at 
(919) 861-3084, Monday through Friday, 8:00 a.m. to 5:00 p.m. 

Training 

DMV offers train-the-trainer classes. Contact Operations Support to schedule TraCS training: 

Phone: (919) 861-3084 
Email: operations-support@ncdot.gov 

 

 

Status Locked Description 

Open No User is currently working on the report. 

Open Yes Improper program shut down (power outage or Easy Street Draw lockup). 
Requires administrative unlock. 

Validated No The report has been validated, but not sent. 

Accepted No The report has been approved but not sent. 

Accepted Yes The report has been sent to DMV for processing. 

Rejected No The supervisor has rejected a reporter’s report or DMV has rejected the 
supervisor’s report. 

Rejected Yes The reporter’s report has been rejected and sent back. 

Transmitted No The report has been accepted by DMV and has an assigned Crash ID.  

mailto:operations-support@ncdot.gov
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Chapter 2: TraCS Interface 

Chapter 1: This section describes the TraCS user interface (UI), which includes the two main 
windows (Forms Manager and Forms Viewer), and the commands and controls used to interact 
with TraCS. 

 
NOTE: The TraCS user interface is based on user access level. i
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Forms Manager 

The Forms Manager is the first window to open when you log in to TraCS. An example of the 
Forms Manager is shown in Figure 4. The Forms Manager is used to organize all forms and 
create new forms. See Chapter 3:“Completing and Submitting the NCCRF” for detailed 
instructions on performing tasks in the Forms Manager. 

 

Figure 4. Forms Manager (Reporter’s View Shown) 
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Status Bar 

The Forms Manager status bar (shown in Figure 5) displays the following: 

 User name 

 Last and first name 

 Number of forms displaying on the Forms Grid 

 Number of forms selected 

The status bar can be displayed or hidden. 

 

Figure 5. Forms Manager Status Bar 

Forms Manager Ribbon 

The Forms Manager ribbon is composed of several tabs, each of which represents a subset of 
the Forms Manager functionality. The tabs contain related commands that are organized, 
grouped, and labeled, as shown in Figure 6. 

 

Figure 6. Forms Manager Ribbon (File Tab Selected) 
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File Tab 

The File tab commands display by default when you open TraCS (as shown in Figure 6). 
Table C describes the File tab commands. 

Table C. File Tab Commands 

Command Click Action 

Print 

 

Opens the Print manager. 

New Contact 

 

Opens a new contact with a new NCCRF. 

Open Form 

 

Opens the selected form on the Forms Grid. If the form is 
already open, the Forms Viewer moves to the front. 

If a form is open and you select a different form, you are 
prompted to close the current Forms Viewer. 

NOTE: Double-clicking the form on the Forms Grid also 
opens the form. 

Delete Form 

 

Deletes the selected form (or forms) on the Forms Grid. 

 
CAUTION: Deleted forms CANNOT be recovered. 

Select All 

 

Selects all forms on the Forms Grid. 

Deselect All 

 

Deselects all forms on the Forms Grid. 

Refresh Current 
Search 

 

Updates the forms listed on the Forms Grid according to 
the current search criteria. 

!
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Command Click Action 

Reset to Last 
Session Defaults 

 

Restores the Forms Manager workspace to the user’s 
default state. Some view options are saved at the time the 
user exits the Forms Manager. This view is called the 
user’s default state. 

Table D shows which viewing options that can be restored 
to defaults on the Forms Manager. 

Reset to TraCS 
Defaults 

 

Restores the Forms Manager workspace to the TraCS 
default state. 

Table D shows the viewing options that are restored to the 
default on the Forms Manager. 

Exit 

 

Closes TraCS. 

 

Table D. Forms Manager View Options 

View Options 

Returns to Default with Reset 

Yes No 

Add to Quick Access Toolbar   

Show Quick Access Toolbar Below Ribbon   

Minimize Ribbon   

Hide Navigation Bar   

Navigation Bar Dock Right   

Quick Add Hide   

Form Preview Hide   

Form Preview Activate   

Open Contacts Hide   

Open Contacts Activate   

Forms Grid   

Status Bar Hide   

Edit Appearance Color Schemes   

Nighttime Mode   
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View Options 

Returns to Default with Reset 

Yes No 

Hide Search Panel   

Search Panel Dock Top   

Perform Auto Search After Login   

Group Forms by Heading   

 

View Tab 

Click the View tab to display the View tab commands (as shown in Figure 7). 

 

Figure 7. View Tab 

Table E describes the View tab commands. 

Table E. View Tab Commands 

Command Click Action 

Show Status Bar 

 

Displays or hides the status bar.  

Navigation Bar 
menu 

 

Controls: 

 Navigation Bar location in the workspace 

 Display of the Navigation Bar and buttons 

See Table F for a description of the Navigation 
Bar menu commands. 

Edit Appearance 
menu  

Displays color scheme options for TraCS 
windows. Black is the default. 

NOTE: A color scheme selected while in 
nighttime mode does not display until nighttime 
mode is turned off. 

Nighttime Mode 

 

Turns nighttime mode on or off. Nighttime Mode 
changes screen illumination. 



 

 

TraCS 10 User's Guide for Supervisors and Reporters    

Chapter 2: TraCS Interface 2-7 

Command Click Action 

Show Search 
Panel 

 

Displays or hides the Search Panel. 

Search Panel 
Dock Top  

Moves the Search Panel to the top of the 
window. 

Search Panel 
Dock Bottom  

Moves the Search Panel to the bottom of the 
window. 

Perform Auto 
Search After Login  

Automatically searches and displays forms after 
logging into TraCS. 

 

Table F describes the Forms Manager Navigation Bar menu commands. See “Forms Manager 
Navigation Bar” on page 2-16 for more information.  

Table F. Forms Manager Navigation Bar Menu Commands 

Command Action 

Show Navigation Bar Hides or displays the Navigation Bar. 

Navigation Bar Dock Left Moves the Navigation Bar to the left of the Forms Manager window. 

Navigation Bar Dock Right Moves the Navigation Bar to the right of the Forms Manager 
window. 

Hide Hides or displays the Quick Add function. 

Form Preview Show/Hide Hides or displays the Form Preview function on the Navigation Bar. 

Form Preview Activate Displays the Form Preview in the Navigation Bar viewer. 

Open Contacts Show/Hide Hides or displays the All Contacts function on the Navigation Bar. 

Open Contacts Activate Displays open contacts in the Navigation Bar viewer. 

External Information Show/Hide Hides or displays the External Information function on the Navigation 
Bar. 

External Information Activate Displays External Information in the Navigation Bar viewer. 
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Actions Tab 

Click the Actions tab to display the Show Rejection command. The supervisor’s Actions tab has 
more commands than the reporter’s, as shown in Figure 8. 

 

Figure 8. Actions Tab 

Reporter’s Actions Tab 

Supervisor’s Actions Tab 
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Table G describes the Tools tab commands. 

Table G. Actions Tab Commands 

Command Click Action 

Accept 

 

Supervisor only. Changes the status of a form from 
validated to accepted. Supervisors can accept reporters’ 
forms and their own forms. 

Reject 

 

Supervisor only. Changes the status of a form from 
validated to rejected. 

Show Rejection 
Reason 

 

Displays the supervisor’s reason for rejecting the form. 

Clear 

 

Supervisor only. Changes the form status of Accepted 
or Rejected to Validated. 
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Tools Tab 

Click the Tools tab to display the Tools tab commands (as shown in Figure 9). 

 

Figure 9. Tools Tab 

Table H describes the Tools tab commands. 

Table H. Tools Tab Commands 

Command Click Action 

Change User 
Password  

Opens the Change Password dialog box. 

Passwords are case-sensitive. 

Send/Receive 
Forms 

 

 Sends completed and validated forms to the 
supervisor. 

 Sends accepted forms to DMV. 

 Retrieves rejected forms from supervisor or DMV. 

Create 
Supplemental  

Opens the Enter DMV Crash ID for Supplemental 
dialog box.  

Transfer Reports to 
Disk  

Opens the About to Transfer Crash Reports to 
Disk message. 

Transfer Reports 
from Disk  

Opens the About to Transfer Crash Reports from 
Disk message. 
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Data Transfer Tab 

Click the Data Transfer tab to display the Data Transfer tab commands (as shown in Figure 10). 

 

Figure 10. Data Transfer Tab 

Table I describes the Data Transfer tab commands. 

Table I. Data Transfer Tab Commands 

Item Click Action 

Archive 

 

Moves selected forms to the archive database. 

NOTE: Locked forms cannot be archived. 

Unarchive 

 

Moves selected archived forms to the current database. 

NOTE: Archived forms must display on the Forms Grid 
before they can be unarchived.  

 

NOTE:  See “Archive and Unarchive Forms” on page 3-49 for instructions on how to 
archive and unarchive forms. i
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Administrative Tab 

Click the Administrative tab to display the Administrative tab commands (as shown 
in Figure 11). 

 

Figure 11. Administrative Tab 

Table J. Administrative Tab Commands 

Item Click Action 

Officer Notes 

 

Opens the text file connected to the selected form. 

See “Officer’s Notes” on page 3-32 for instructions on 
how to add officer notes. 

NOTE: Officers Notes are associated with a form in 
TraCS, but do not print on the form. Officers Notes are 
not sent to the Crash Reporting System. 

Set ESD Version 

 

Opens the ESD Setting dialog box. Enter the version 
number of the installed Easy Street Draw application to 
update the Easy Street Draw launch display. 

Set GPS CommPort 

 

Opens the GPS Com Port Number dialog box. Enter 
the communication port number that the GPS receiver is 
using for broadcasting. The default is 1. See 
“Downloading GPS Driver and Setting Communication 
Port” on page 3-20 for instructions on how to identify the 
communication port number. 

Set CommPort 
Settings 

 

Opens the GPS ComPortSettings dialog box. Enter 

the communications port settings: 

 Baud rate 

 Parity 

 Data Bits 

 Stop Bits 

The default is 4800,n,8,1. 
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Item Click Action 

Set GPS Enable 

 

Opens the GPS Enabled dialog box. Leave the default 

of True to initialize the GPS device when TraCS starts. 

Set GPS Zone 

 

Opens the GPS Zone dialog box. The GPS zone 
number (1–24) is required for projected coordinates. The 

default is 15. 

Set GPS Datum 

 

Opens the GPS Datum dialog box. Datnum is required 

for projected coordinates. Enter NAD27 or leave the 

default of NAD83. 

Set GPS Precision 

 

Opens the Set GPS Precision dialog box. Precision 

refers to the number of satellites required to return 
coordinates. Use this setting only if Mode = NMEA and 
sentence type $GPGGA is available from the GPS 
receiver. The default is 4. 
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Window Tab 

Click the Window tab to display the Window commands (as shown in Figure 12). 

 

Figure 12. Window Tab 

Table K describes the Window tab commands. 

Table K. Window Tab Commands 

Item Click Action 

Set Grouping 

 

Displays the Arrange By menu. Use this menu to sort 
and group forms by a column heading. 

See “Sorting Forms on the Forms Grid” on page 2-19 for 
additional sorting options. 

Undo Grouping 

 

Removes grouping. 

You can also ungroup items by doing one of the 
following: 

 Select Drop Grouping on the Set Grouping/Arrange 
By menu, or 

 Select Reset to TraCS Defaults on the File tab. 
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Help Tab 

Click the Help tab to display the Help tab commands (as shown in Figure 13). 

 

Figure 13. Help Tab 

Table L describes the Help tab commands. 

Table L. Help Tab Commands 

Command Click Action 

About TraCS 

 

Displays the TraCS version, copyright, and serial 
number. 

TraCS on the Web 

 

Opens the NC Division of Motor Vehicles TraCS 
website, which provides additional information. 

dmvcrashweb.dot.state.nc.us/trcs/ 

Technical Support 

 

Opens the TraCS Technical Support Contacts page. 

Help 

 

Opens TraCS Help. 

https://dmvcrashweb.dot.state.nc.us/trcs/
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Forms Manager Navigation Bar 

The Navigation Bar provides quick access to tasks associated with the form. The Navigation Bar can 
be docked to the left or right of the window. Buttons can be displayed, hidden, or minimized. When 
buttons are minimized, you see only the button icons. 

The viewer displays the results of the selected button, as shown in Figure 14. If the selection requires 
a larger portion of the bar, the buttons are minimized to icons at the bottom. 

 

Figure 14. Forms Manager Navigation Bar (Examples of Standard and Minimized Buttons Shown) 
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Table M describes the Navigation Bar buttons. 

Table M. Navigation Bar Buttons 

Button Action 

Quick Add Opens a new contact and NCCRF. 

Form Preview Displays all information contained in the form header. 

Open Contacts Displays opened contact name and lists forms within the contact. If no 
form is opened, the Open Contacts viewer is blank. 

External Information Displays external information retrieved from one or more of the following 
searches: 

 Individual (North Carolina driver information) 

 Vehicle (vehicle registration records) 

 Carrier (commercial  carrier records) 

 Location (ILT) 

Go to “Records Search” on page 3-10 for instructions on performing 
external searches. 

 

CAUTION: DO NOT use the External Information viewer for 
data entry. Doing so does not populate all required fields. Use 
the External Information viewer for display purposes only. 

 

!
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The Navigation Bar can be modified from three menus: 

 Navigation Bar menu (on the View tab) 

 Shortcut menu (right-click on the Navigation Bar) 

 Configure Buttons menu (located at the bottom of the Navigation Bar) 

Table N lists the commands available to modify the Navigation Bar. 

Table N. Forms Manager Navigation Bar Display Options 

Command 
Navigation Bar 

Menu (View Tab) 
Shortcut Menu 

Button 
Configuration Menu 

Show Navigation Bar    

Navigation Bar Dock Left    

Navigation Bar Dock Right    

Hide (hide/show Quick Add)    

Quick Add  Hide/Show    

Quick Add  Activate    

Quick Add  Add Form  NCCRF    

Form Preview  Hide/Show    

Form Preview  Activate    

Open Contacts  Hide/Show    

Open Contacts  Activate    

External Information  Hide/Show    

External Information  Activate    

Explorer Mode    

Show More Buttons    

Show Fewer Buttons    

Add or Remove Buttons    
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Forms Grid 

The Forms Grid displays forms located in your current database. You can choose to display 
some or all of the forms by entering search criteria (see “Search Panel” on page 2-24). Forms 
can be archived to an archive database and unarchived at any time (see “Archive and 
Unarchive Forms” on page 3-49 for instructions). You can sort forms on the grid by clicking the 
grid column headers. Double-click a form to open it in the Forms Viewer. Figure 15 shows an 
example of the Forms Grid. 

 

Figure 15. Forms Grid (Reporter’s View Shown) 

Sorting Forms on the Forms Grid 

By default, the forms listed on the Forms Grid are sorted by form date and time. Forms can be 
re-sorted by clicking on any column heading on the Forms Grid. Click a column heading once to 
sort the forms in ascending order; click a column header a second time to sort the forms in 
descending order.  

Table O lists Forms Grid column names and descriptions. 

Table O. Forms Grid Columns 

Column Description 

Archive Date Indicates the date the file was archived. 

Archive Flag Selected check box indicates that the file is archived. 

Checked Out Does not apply in North Carolina. 

Contact Date Defaults to the date that the contact was created. For agency use 
(see NOTE). Contact date should be changed to the date of the crash. 

Contact Description Defaults to the system-assigned description. For agency use (see NOTE). 
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Column Description 

Contact Key The system-assigned contact identification. 

NOTE: The contact key also displays as the contact name and contact 
description unless new data is entered when the contact is created. 

Contact Name Defaults to the system-assigned contact name. For agency use (see NOTE). 

Contact Time Defaults to the time that the contact was created. For agency use. 
See NOTE. 

Form Date Defaults to the day that the form was created. For agency use (see NOTE). 

Form Description The default is blank. For agency use (see NOTE). 

Form Name The form name is always NCCRF. 

Form Number Indicates the form identification number (displays in the Case Number field 
on the NCCRF) 

Form Time Defaults to the time that the form was created. For agency use (see NOTE). 

Form Version Form version is always 1.00 in North Carolina. 

Is Locked Indicates whether the form is locked or unlocked. When this column is empty, 
the form is available for editing. When the box is checked, the form is not 
available for editing. 

Location Indicates the reporting agency. 

Locked By User ID of the reporter or supervisor who modified the form before 
performing the send/receive function. 

Modified Indicates that the NCCRF was modified in the current log in session. 

Saved Filename Not used in North Carolina. 

Secondary User ID The second ID assigned to a user. The Secondary User ID is commonly the 
user’s badge number. 

Status Indicates the status of the form (for example, open, issued, rejected, or 
approved). 

User First Name Form originator’s first name. 

User ID Indicates which user’s forms are displaying in the form grid. 

User Last Name Form originator’s last name. 

User Middle Name Form originator’s middle name. 

User Name Form originator’s name. 

NOTE: “For agency use” indicates that the value is user-definable. See “Edit Contact Information” on 
page 3-30 for instructions on updating the contact time and date. 
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Column Headings Menu 

The Column Headings menu provides additional sort and display options. To display the column 
headings menu, place the pointer over any column heading on the Forms Grid and right-click, 
as shown in Figure 16. 

 

Figure 16. Forms Grid – Column Heading Menu 
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Table P lists the sort options and descriptions of the Column Headings menu. 

Table P. Forms Grid Columns Menu 

Sort Option Description 

Sort Ascending Sorts forms in ascending order based on the selected column. 

Sort Descending Sorts forms in descending order based on the selected column. 

Clear Sorting Returns the forms to the original order. 

Group By This Column Moves all forms with the same column value to a group. Groups within a 
group can be created. Group view can be collapsed or expanded. 

Show Group By Box Displays the hierarchy of groups, as shown below: 

 

To clear grouping, place the pointer on the Group By Box and select Clear 
Grouping. 

NOTE: You can also clear grouping by: 

 Selecting Drop Grouping on the Set Grouping/Arrange By menu under 
the Window tab, or 

 Selecting Reset to TraCS Defaults on the File tab. 

Hides Group By Box Closes the Group By Box. 

Remove This Column Hides the selected column. The column can be restored from the Column 
Chooser. 

Column Chooser Displays names of columns that are currently hidden on the Forms Grid. 
Double-click a column name to add the column to the Forms Grid. 

Best Fit Adjusts the selected column width. 

Best Fit (all columns) Adjusts all column widths on the Forms Grid. 
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Sort Option Description 

Filter Editor Opens the Filter Editor. Use the Filter Editor to apply conditions to filter the 
forms on the Forms Grid. In the example below, the search is for the value 
entered for the Contact Name column. Click any text in the Filter Editor to 
display menu options or a text box. 

 

Show Find Panel Opens the Show Find Panel. Text entered in the box returns all forms that 
meet the search criteria. Search is based on values in all columns.  

Hide Find Panel Closes the Show Find Panel. 

Show Auto Filter Row Opens the Show Auto Row. A blank row displays at the top of the grid. Forms 
display automatically as values are entered in one or more columns. 

Hide Auto Filter Row Closes the Show Auto Row. 
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Search Panel 

The Search Panel provides a way to search through your local database for forms based on 
specific criteria that you enter. Only forms matching your criteria display on the Forms Grid 
when you run search. If you run a search with no search criteria entered, all forms display. 
Search fields are divided into three tabs, General, Advanced, and Custom. Favorite searches 
can be saved to the Favorites tab. 

General Tab 

Use the search form on the General tab (shown in Figure 17) for customized searches. One or 
more filters can be combined to define the search criteria. After making your selections, click 
Search to display the results on the Forms Grid. See Table Q for a description of the search 
controls on the General tab. 

 

Figure 17. Search Panel – General Tab 

 
NOTE: Search text fields are not case-sensitive. Enter the complete description. i
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Table Q. General Search Tab 

Controls Description/Steps 

User ID The user ID of the user who created the form. Click User ID to select one or 
more User IDs from the Select User(s) dialog box. The dialog box displays all 
users in your TraCS database. 

NOTE: Only a supervisor can view the forms of all users within the agency. 
Reporters can view only their own forms. 

Location The name of the agency where the form originated. 

Click Location to select one or more agencies from the Select Location(s) 
dialog box. 

NOTE: Only DMV can view the forms of all North Carolina agencies. 

Form Displays all form types available to you. In North Carolina the NCCRF is the 
only form type available. 

Status The form status. Select one or more statuses from the Select Status(es) 
dialog box. See Table A and Table B, on page 1-6 for status descriptions 
based on the user’s access level. 

Form Number Enter the entire form number. Only one form number can be entered. 

NOTE: The form number is referred to as the case number on the NCCRF. 

Form Description As entered by the agency. 

Data Source Select Current to include all non-archived forms in the search. 

Select All to include both current and archived forms in the search. 

Select Archive to include archived forms in the search. Select the year from 
the Archive year list. 

NOTE: See “Archive and Unarchive Forms” on page 3-49 for detailed 
instructions on archiving forms. 

Form Date Specify a range of dates to display only forms within that range 

From – Select the search start date from the calendar 

To – Select the search end date from the calendar 

Clear Date – Select to clear dates 

Save button Click Save to save current search criteria as a favorite to use again. 

The Favorites tab displays with the new favorite search row selected. The 
system-assigned search name is in edit mode to enable you to rename the 
search. 

Clear button Click Clear to remove all forms from the Forms Grid and all search criteria from 
the search tabs. 

Search button Click Search to perform a search based on the criteria entered. 

To display all forms, click Search with no criteria entered. 
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Advanced Tab 

Use the search form on the Advanced tab (shown in Figure 18) for additional search options. 
One or more filters can be combined to define the search criteria. After making your selections, 
click Search to display the results on the Forms Grid. See Table R for a description of the 
search controls on the Advanced tab. 

 

Figure 18. Search Panel – Advanced Tab 

Table R. Advanced Tab 

Controls Description 

Secondary User ID Enter the second ID assigned to a user. The Secondary User ID is 
commonly the user’s badge number. 

Contact Name Enter the complete contact name. The field is not case-sensitive. 

Contact Description Enter the complete contact description. The field is not case-sensitive. 

Contact Date Specify a range of dates to display forms by contact dates within that 
range. 

Select the search start date from the From field calendar, or press any 
key to enter the current date. 

Select the search end date from the To field calendar, or press any key to 
enter the current date. 

Click Clear Date to clear the Contact Date fields. 

Definable Fields Not applicable for North Carolina. 

Save button Click Save to save current search criteria as a favorite to use again. 

The Favorites tab displays with the new favorite search row selected. The 
system-assigned search name is in edit mode to enable you to rename 
the search. 

Clear button Click Clear to remove all forms from the Forms Grid and all search 
criteria from the search tabs. 
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Controls Description 

Search button Click Search to perform a search based on the criteria entered. 

To display all forms, click Search with no criteria entered. 

Only Locked Forms button Select to display only forms in locked status. 

Only Forms with 
Attachments button 

Not applicable for North Carolina. 
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Custom Tab 

Use the search form on the Custom tab (shown in Figure 19) to search for a specific field and 
value on the NCCRF. After making your selections, click Search to display the results on the 
Forms Grid. See Table S for a description of the search controls on the Custom tab. 

 

Figure 19. Search Panel – Custom Tab 

Table S. Custom Tab 

Controls Description 

Custom Search Fields 
list box 

Select the field name to which you want to enter a field value. Name 
searches require a person type to be selected in addition to the name. 

Clear All button Click Clear All to remove custom search criteria. 

Enter the search value 
text box 

This box displays for Local Use, Person First Name, Person Middle Name, 
and Person Last Name fields only. Enter the value of the selected field. 

NOTE: A wildcard * (asterisk) can be used in text search fields. Fields are 
not case-sensitive. 

Select the search value 
list box 

This box displays only when County, Municipality, Person Suffix, or Person 
Type fields are selected. Select the value. 

TIP: Names in the Municipality list box are not in alphabetical order. To 
quickly find and select the name, click in the box and press the first letter of 
the name. Repeat until the correct municipality is highlighted.  

Clear List Clears the list selection. This button displays for only if the selected Custom 
Search Field is County, Municipality, Person Suffix, or Person Type fields.  

Search for Blank 
Values? check box 

Select the Search for Blank Values? check box to display forms that have 
no data entered for the selected field.  

 

NOTE: See “Display Forms Based on Person’s Name” on page 3-50 for detailed 
instructions on performing a search based on a person’s name. i
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Controls Description 

Save button Click Save to save current search criteria as a favorite to use again. 

The Favorites tab displays with the new favorite search row selected. The 
system-assigned search name is in edit mode to enable you to rename the 
search. 

Search button Click Search to perform a search based on the criteria entered. 

To display all forms, click Search with no criteria entered. 

Clear button Click Clear to remove all forms from the Forms Grid and all search criteria 
from the search tabs. 

 

Favorites Tab 

The Favorites tab (shown in Figure 20) displays saved searches. After selecting a search, click 
Run Selected Search to display the results on the Forms Grid. See Table T for a description of 
the search controls on the Favorites tab. 

 

Figure 20. Search Panel – Favorites Tab 

Table T. Favorites Tab 

Controls Description 

Is Default column Select this check box to make this search the new default search. 

Search Name column Displays the search name. To rename the search, double-click the name 
and enter a new name. 

Run Selected Search 
button 

Click to run the selected search. The results display on the Forms Grid and 
the associated search tab displays with the favorite search criteria. 

Delete Selected Search 
button 

Click to remove selected search. 
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Forms Viewer 

The Forms Viewer opens as a secondary window when a new contact is created or an existing 
form is opened from the Forms Manager window. Forms can be completed, edited, viewed, and 
validated from the Forms Viewer (as shown in Figure 21). 

 

Figure 21. Forms Viewer 
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Forms Viewer Title Bar 

The title bar provides basic contact and form information (as shown in Figure 22). 

 

Figure 22. Forms Viewer Title Bar 

Forms Viewer Status Bar 

The status bar displays the user’s ID and last and first name (as shown in Figure 23). 

 

Figure 23. Forms Viewer Status Bar 

Forms Viewer Ribbon 

The ribbon is composed of several tabs, each of which represents a subset of TraCS 
functionality. The tabs contain related commands that are organized, grouped, and labeled as 
shown in Figure 24. 

 

Figure 24. Forms Viewer Ribbon (Home Tab Selected) 
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Home Tab 

The Home tab commands display by default when you open TraCS (as shown in Figure 24). 
Table U describes the Home tab commands. 

Table U. Home Tab Commands 

Command Click Action 

Forms Manager 

 

Displays the Forms Manager. 

Edit Form 

 

Changes the edit mode of the form from view-only to edit 
and back to view-only. 

Delete Form 

 

Permanently deletes the form. 

 

CAUTION: Deleted forms CANNOT be 
recovered. 

Save Form 

 

Saves the open form. 

Print 

 

Opens the Print dialog box. 

Close Contact 

 

Saves and closes the contact and all forms in the contact. 

Contact Information 

  

Opens the Contact Information dialog box. 

NOTE: All forms in the contact must be closed or have 
the Edit Mode turned off before any information can be 
entered. The date and time should be changed to the 
date and time of the crash. Information entered here 
displays only on the TraCS interface; time and dates are 
NOT changed on the NCCRF. 

!
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Command Click Action 

Form Description 

 

Opens the Form Information dialog box. 

NOTE: Edit Mode must be turned on before any 
information can be entered. The date and time should be 
changed to the date and time of the crash. Information 
entered here displays only on the TraCS interface; time 
and dates are NOT changed on the NCCRF. 

Add Group 

 

Displays the Add Group menu listing groups that can be 
added to the form. 

Delete Group 

 

Displays the Delete Group menu listing groups on the 
open form. 

If a group is selected that cannot be deleted, only the 
data in the group is permanently deleted. 

 

CAUTION: Deleted groups or data CANNOT be 
recovered. 

Add Current Group 

  

Adds another instance of the current group type. For 
example, when PERSON 1 is active and Add Current 
Group is selected, a PERSON 2 group is created. The 
new group is active and displays in the Navigation Tree. 

Delete Current Group 

 

Permanently deletes the current group and all associated 
data. 

If the current group is a group that cannot be deleted, 
only the data in the group is permanently deleted. 

 

CAUTION: Deleted groups or data CANNOT be 
recovered. 

Skip Group 

 

Skips to the first field in the next group. 

!

!
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Validate 

 

Validates the open form and if applicable, displays the 
errors in the Validation Errors panel.  

Validation Errors 

 

Opens and closes the Validation Errors panel. 
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View Tab 

Click the View tab to display the View tab commands (as shown in Figure 25). 

 

Figure 25. Forms Viewer – View Tab 

Table V describes the View tab commands. 

Table V. View Tab Commands 

Command Click Action 

Show Status 
Bar  

Displays or hides the status bar at the bottom of the Forms 
Viewer window. 

Nighttime 
Mode  

Turns on and off the nighttime mode. Nighttime mode 
changes screen illumination. 

Navigation 
Bar 

 

Controls which buttons are visible in the Navigation Bar. 

See Table W for a description of Navigation menu 
commands. 

Zoom 

 

Displays the Zoom menu commands for setting the zoom 
level of the form. 

Reset 

 

Restores the Forms Viewer to the default workspace. 

See Table X on page 2-37 for the view options that are 
restored to the default on the Forms Viewer. 

Arrange 
Forms 

 

Displays menu commands for displaying open forms in the 
contact. 

Viewers 

 

Switches between open forms in the contact. 
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Command Click Action 

Databar 
Advanced 

 

Default databar. Expands the databar to full size. See 
Figure 31 on page 2-44 to view examples of the advanced 
and basic databar. 

Databar 
Basic 

 

Minimizes the size of the databar and converts information 
in graphical representations into list boxes when applicable. 
See Figure 31 on page 2-44 to view examples of the 
advanced and basic databar. 

NOTE: To display field help in the basic databar, click the 
basic databar help button, as shown in the following 
example. 

 

 

Databar 
Dock Bottom 

 

Moves the databar to the bottom of the form. 

Databar 
Dock Top 

 

Default location. Moves the databar to the top of the form. 

 

Table W describes the Forms Viewer Navigation Bar menu commands. 

Table W. Forms Viewer Navigation Bar Menu Commands 

Command Action 

Show Navigation Bar Opens and closes the Navigation Bar. 

Navigation Bar Dock Left Default. Moves the Navigation Bar to the left of the Forms 
Viewer. 

Navigation Bar Dock Right Moves the Navigation Bar to the right of the Forms Viewer. 

Forms Navigation Tree  Hide/Show Hides or displays the Navigation Tree button. 

Forms Navigation Tree  Activate Displays the Navigation Tree in the Navigation Bar viewer. 

External Information  Hide/Show Hides or displays External Information button. 

External Information  Activate Displays the External Information in the Navigation Bar viewer. 
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Table X shows which view options are restored the default after clicking Reset on the View. 

Table X. Forms Viewer View Options 

View Option 

Returns to Default with Reset 

Yes No 

Show Quick Access Toolbar Below Ribbon   

Minimize Ribbon   

Status Bar Hide   

Nighttime Mode   

Add to Quick Access Toolbar   

Hide Navigation Bar   

Navigation Bar Dock Right   

Quick Add Hide   

Form(s) Hide [navigation tree]   

Form(s) Activate [navigation tree]   

External Information Hide   

External Information Activate   

Navigation Bar Explorer Mode   

Arrange Forms (Tile Horizontally, Tile Vertically, and 
Cascade) 

  

Databar Basic   

Databar Dock Bottom   
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Actions Tab 

Click the Actions tab to display the Actions tab commands. Figure 26 shows an example of 
both the supervisor’s and reporter’s Actions tab. 

 

Figure 26. Forms Viewer – Action Tab 

Table Y describes the Action tab commands. 

Table Y. Actions Tab Commands 

Command Click Action 

Accept 

 

Supervisor only. Changes the status of the form from 
Validated to Accepted. 

Reject 

 

Supervisor only. Changes the status of the form to 
Rejected. 

Show Rejection 
Reason 

 

If the form was rejected by the supervisor, the reason 
displays. 

Supervisor’s Actions Tab 

Reporter’s Actions Tab 
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Command Click Action 

Clear 

 

Supervisor only. Changes the form status back to 
original status.  

Officer Notes 

 

Opens the officer’s notepad. The officer’s notepad can 
also be accessed from the Administrative tab on the 
Forms Manager. 

See “Officer’s Notes” on page 3-32 for instructions on how 
to add officer notes. 

NOTE: Officer’s notes do not display on the form and are 
not transferred to the Crash Reporting System. 
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Help Tab 

Click the Help tab to display the Help tab commands (Figure 27). 

 

Figure 27. Forms Viewer – Help Tab 

Table Z describes the Help tab commands. 

Table Z. Help Tab Commands 

Command Click Action 

About TraCS 

 

Displays the TraCS version, copyright, and serial 
number. 

TraCS on the Web 

 

Opens the NC Division of Motor Vehicles TraCS 
website, which provides additional information. 

dmvcrashweb.dot.state.nc.us/trcs/ 

Technical Support 

 

Opens the TraCS Technical Support Contacts page. 

Help 

 

Opens TraCS Help. 

https://dmvcrashweb.dot.state.nc.us/trcs/
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Forms Viewer Navigation Bar 

The Navigation Bar provides quick access to tasks associated with the form. The Navigation Bar can 
be configured to display or hide the buttons and dock the bar to the left or right of the window. 
Buttons can be displayed, hidden, or minimized. 

The viewer displays the results of the selected button (as shown in Figure 28). If the selection 
requires a larger portion of the bar, the buttons are minimized to the bottom of the bar. 

 

Figure 28. Forms Viewer Navigation Bar (Example of Standard and Minimized Buttons Shown) 
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The Navigation Bar can be modified from three menus: 

 Navigation Bar menu (on the View tab) 

 Shortcut menu (right-click on the Navigation Bar) 

 Configure Buttons menu (located at the bottom of the Navigation Bar) 

Table AA lists the commands available to modify the Navigation Bar. 

Table AA. Forms Viewer Navigation Bar Display Options 

Command 
Navigation Bar Menu 

(View Tab) 
Shortcut Menu 

Button 
Configuration Menu 

Show Navigation Bar    

Navigation Bar Dock Left    

Navigation Bar Dock Right    

Form Navigation Tree  Show/Hide    

Form Navigation Tree  Activate    

External Information  Show/Hide    

External Information  Activate    

Forms in Contact    

Order Quick Add 
(not applicable in NC) 

   

Quick Add Show/Hide    

Explorer Mode    

Show More Buttons    

Show Fewer Buttons    

Add or Remove Buttons    

 

 

NOTE: The commands on the Navigation Bar menu on the View tab override the 
Configure Buttons menu. If you cannot locate a button, go to the Navigation Bar 
menu and select Show to display it. 

i
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Navigation Tree 

The TraCS Navigation Tree contains a hierarchical tree view which displays the NCCRF group 
and collection headings, as shown in Figure 29. The navigation tree allows you to maneuver 
within a form (for example, between groups or collections). 

You can skip to a specific group or collection on a form by clicking the desired group name or 
collection name in the navigation tree. When a group name is selected, the first field contained 
in that group is selected and highlighted. When a collection name is selected, the first field in 
that collection is selected and highlighted. 

 

Figure 29. Navigation Tree 

When a topic is highlighted in the Navigation Tree, the corresponding field on the open form is 
selected. In the example in Figure 30, PROPERTY DAMAGE 1 is highlighted on the Navigation 
Tree which automatically selects the Property Damage Text field on the form. 

 

Figure 30. Selected Tree Topic and Corresponding Field 
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Databar 

The databar displays when the form is in edit mode and it is used to enter information into the 
form. Each field has a specific databar associated with it that determines the type of data that 
can be applied to the field. For example, a numbers databar allows only numbers to be entered. 
The Field Help provides an explanation and instructions for the current field. 

A new form automatically opens in edit mode. Existing forms open in view-only mode and you 
must activate edit mode to display the databar. 

The databar can be displayed in one of two ways, the advanced databar (default), and the basic 
databar. Figure 31 shows examples of both. The basic databar minimizes the size of the 
databar and converts information in graphical representations into list boxes when applicable. 

 

Figure 31. Advanced and Basic Databar 

Advanced Databar 

Basic Databar 

NOTE: Click databar help button to display field help. 
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North Carolina Crash Report Form 

The open NCCRF displays, as shown in Figure 32. When a field is selected on a form, the 
databar associated with that field displays above the form. 

 

Figure 32. North Carolina Crash Report Form 

 





 

 3-1 

Chapter 3: Completing and Submitting 
the NCCRF 

This chapter includes instructions for: 

 Creating a new contact and NCCRF 

 Entering data in fields and setting field defaults 

 Adding and deleting recurring groups 

 Searching driver, vehicle, and commercial carrier records and auto-populating related 
fields with the results 

 Validating and submitting the NCCRF for approval 

 Processing a validated form (supervisor only) 

 Submitting a supplemental report 

Starting TraCS 

To start TraCS: 

1. From the Start menu, select All Programs > TraCS > TraCS 10. Or, double-click the 

TraCS 10 icon  on your desktop. 

2. Log on to TraCS. The Forms Manager window opens. 

  

 
NOTES: 

1. Contact your agency administrator if you have forgotten your log in password. 

2. To avoid submitting duplicate crash reports, perform the Send Receive Forms 
function every time you log in to TraCS. See “Sending and Receiving Forms” 
on page 3-38 for more information. 

i
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Displaying Information about TraCS 

To display the version number of your copy of TraCS: 

1. From the Help tab, click About TraCS. The TraCS software information displays, as shown 
in Figure 33. 

 

Figure 33. TraCS Software Information 

This information is useful to the customer support staff if you need assistance. 

2. Click OK to close the dialog box. 
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Creating a New Contact and NCCRF 

TraCS is designed around the concept of a contact, which is defined as an incident for which an 
officer is called to perform an official act (for example, writing a citation or investigating a crash). 
In North Carolina, the only electronic form designed for TraCS is the NCCRF. Before data can 
be entered into the NCCRF, a contact must be opened. A contact is represented in TraCS as a 
file folder, with each electronic form in the contact represented as a piece of paper in the file 
folder. 

To create a new contact and NCCRF: 

1. In the Forms Manager, run the Send/Receive Form command to avoid submitting a 
duplicate crash report. See “Sending and Receiving Forms” on page 3-38 for instructions. 

2. Click New Contact on the Forms Manager File tab. The Create Contact dialog box opens 
with default content displayed, as shown in Figure 34. 

 

Figure 34. Create Contact Dialog Box 

3. Optional. Replace the default contact name. 

4. Change the date and time to the date and time the crash occurred. 

 

NOTES: 

1. Initially, the default content for contact name, contact description, and 
contact key are the same. Changing the contact name and description 
allows you to enter information that provides quick and easy identification 
(for example, 2-car fender-bender or a 6-car pile-up on expressway). The 
Contact Key content remains the same. 

2. Limit contact name and description length to no more than 25 characters to 
avoid distorting the Forms Grid display. 

i
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5. Optional. Replace the default contact description. 

6. Click Create. 

The Available Forms dialog box opens with the NCCRF selected, as shown in Figure 35. 

 

Figure 35. Available Forms Dialog Box 

7. Click OK. 

The Forms Viewer opens in a new window. The Forms Viewer displays the new contact 
and NCCRF form. The new form is in Edit Form mode. 

  

 

NOTE: When the form is reopened, Edit Form mode must be turned on before any 
modifications can be made. To do this, open the form and click Edit Form on the 
Home tab in the Forms Viewer. 

i
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Entering Data on the Form 

TraCS uses the databar as the primary data entry tool. In addition to facilitating data entry, 
databars also enforce data integrity (for example, a numbers databar allows only numbers to be 
entered). See “Databar” on page 2-44 for more information on the databar. 

See Chapter 4: “The North Carolina Crash Report Form” for a detailed description and 
requirements for each field on the form. 

Saving a Form 

To save a form without closing it, click Save Form on the Home tab, in the File group. 

Form data is automatically saved when you close the form or Forms Viewer. 

  

 

See Chapter 10:“Glossary of Terms” for a list of TraCS terminology used to complete 
the electronic NCCRF. 

 

NOTE: Save the form frequently to avoid losing data because of an unexpected 
power failure or other problem. 

i

i
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Deleting a Form in TraCS 

A form can be deleted in TraCS from either the Forms Manager or the Forms Viewer. 

Deleting a Form on the Forms Manager 

To permanently delete a form:  

1. Select one or more forms to be deleted from the Forms Grid. 

2. From the File tab, in the File group, click Delete Form (or press the Delete key). The Are 

you sure you want to Delete Form dialog box opens. 

3. Click Yes to confirm the deletion. 

The form is deleted from TraCS. 

Deleting a Form on the Forms Viewer 

To permanently delete a form:  

1. Click Delete Form in the File group on the Home tab. A confirmation box opens. 

2. Click Yes to confirm the deletion. 

 
CAUTION:  Deleted forms CANNOT be recovered. 

 

NOTE: Locked forms cannot be deleted. Archived forms must be unarchived before 
they can be deleted. 

!

i
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Field Defaults 

Default values can be set for many of the NCCRF form fields. When a field with a default value 
is active, the value is selected in the databar. Continuing to the next field populates the field with 
the default. You can overwrite, cancel, or change the default value at any time. 

Default field values that you set apply to blank fields on all forms created with your user ID. No 
existing content is overwritten. 

Setting NCCRF Field Defaults 

To set a field default: 

1. Open a form and click Edit Form on the Home tab to change to edit mode. 

2. Point to the field to which you want to set a default value.  

3. Right-click to open the shortcut menu, as shown in Figure 36. 

 

Figure 36. Field Shortcut Menu 
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4. Click Set Default Value. The Default Value field displays the same as the selected field 
databar. Figure 37 shows examples of the Update Field Default dialog box—one with a text 
box and one with a list box. 

 

Figure 37. Update Field Default Dialog Box 

5. Enter default value or click Use Current Value to enter the value in the field. 

6. Keep the value of No for the Retains Last Value field and click OK. 

Applying Field Defaults 

To apply a field default: 

1. Open the form and click Edit Form on the Home tab to change to edit mode. 

2. Go to the blank field to which you want the field default applied. The default value displays 
on the databar. 

The field populates with the default value when you move to another field. 

 

CAUTION: Do not select Yes or Temp for the Retains Last Value field. Doing so can 
result in incorrect data populating the field. !

Text Box List Box 
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Recurring Groups 

Adding a Recurring Group 

The NCCRF is comprised of several groups. Groups that occur more than one time on a form 
are known as recurring groups. Groups that occur only once on a form are known as non-
recurring groups. See “NCCRF Group and Collections” on page 4-1 for detailed information on 
group types. 

To add a recurring group: 

1. Click the Home tab on the Forms Viewer. 

2. Do one of the following: 

 Select a group in the Navigation Tree and click Add Current Group, or 

 Select a group from the Add Group menu. 

 Right-click anywhere in the Navigation Tree and select a group from the Add Group 
shortcut menu. 

The selected group displays in the Navigation Tree. For example, when PERSON is the 
selected group, the Navigation Tree displays PERSON 1 and PERSON 2. 

Deleting a Recurring Group and Clearing Group Data 

Non-recurring groups cannot be deleted. However, the data in a non-recurring group can be 
cleared using the Delete Group and Delete Current Group commands. 

Any instance of a recurring group can be deleted as long as there is more than one instance of 
the group. For example, if the form has two PERSON groups and the PERSON 1 group is 
deleted, PERSON 2 becomes PERSON 1. Because PERSON 1 is the only PERSON group, the 
group cannot be deleted. However, you can permanently clear all data in the PERSON 1 group 
with the delete commands. 

  

 
CAUTION: Deleted groups or group data cannot be recovered. !
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To delete a recurring group or clear group data: 

1. Click the Home tab on the Forms Viewer. 

2. Do one of the following: 

 Select the group in the Navigation Tree and click Delete Current Group, or 

 Select the group from the Delete Group menu. 

Non-recurring group only. The data is permanently cleared from the group fields. 

Recurring group only. The group is permanently deleted from the form. 

Records Search 

The records search function in Tracs allows you to retrieve information on the following: 

 Driver information (based on NC driver’s license) 

 NC vehicle registration information (based on NC license plate or VIN number) 

 Commercial carrier records (based on USDOT number) 

Searches are performed directly from the open NCCRF form. After retrieving the records, you 
can choose to apply the results to the form (populating applicable fields). 

Searching for Driver Information (North Carolina Driver Licenses Only) 

Use the driver search function to perform a search based on a North Carolina driver license 
number. 

To search for driver information and apply results to the form: 

1. Enter the type of unit (Vehicle, Hit & Run, or Commercial) in the Unit Type field. Driver 
fields become available. 

2. Go to the DL State field on the form and select NC from the Select the state in which the 

driver’s license was issued list on the databar. 

3. Click Next to go to the DL Number field. 

 

NOTE: A group can also be deleted by pointing anywhere on the Navigation Tree, 
right-clicking, and selecting the group from the Delete Group menu. i



  

 

TraCS 10 User's Guide for Supervisors and Reporters    

Chapter 3: Completing and Submitting the NCCRF 3-11 

4. Enter the NC driver’s license number and click Search Driver on the databar. If a match 
exists, the results display, as shown in Figure 38. 

 

Figure 38. Search by Driver’s License Results Example 
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5. Click OK. 

Related fields populate with the search results and the data is stored in the External 
Information viewer on the Navigation Bar, as shown in Figure 39. 

 

Figure 39. Driver Information Search Results Example 

External Information Viewer 
(Collapsed View Shown) 

Populated Fields 
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CAUTION: Changing a value in an external search information field does not 
automatically change other instances of that field in other locations. 

External Search 

Information Fields

 

!
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Searching for Vehicle Registration Records (NC Registered Vehicles Only) 

NC vehicle registration information can be retrieved by performing a search based on the 
license plate or vehicle identification number (VIN) number entered on the NCCRF.  

To search for vehicle registration records: 

1. Go to the License Plate State field on the form and select NC – North Carolina from the 
Select the state in which the license plate was issued list on the databar. 

2. To search by the license plate number, enter the license plate number in the License Plate 

Number field and click Search. If a match exists, the results display, as shown in Figure 40. 

 

Figure 40. Search by License Plate Number Results Example 

 
NOTE: Do not enter dashes (-) or any other symbols. i
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3. To search by the VIN number, enter the VIN number in the VIN Number field and click 
Search. If a match exists, the results display, as shown in Figure 41. 

 

Figure 41. Search by VIN Number Results Example 

4. Click OK. 

Related fields populate with the search results and the data is stored in the External 
Information viewer on the Navigation Bar, as shown in Figure 42. 

 

Figure 42. Vehicle Information Search Results Example 

External Information Viewer 
(Collapsed View Shown) 

Populated Fields 
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CAUTION: Changing a value in an external search information field does not 
automatically change other instances of that field in other locations. 

External Search 

Information Fields

 

!
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Searching for Commercial Carrier Records 

The USDOT number is used to access carrier records. Use the Commercial Carrier Search 
function to perform a search based on a USDOT number. 

To search for a commercial carrier’s records: 

1. Go to the USDOT Number field on the form and enter the USDOT number and click Search. 

If a match exists, the Apply the result Info message displays with the commercial carrier’s 
records, as shown in Figure 43. 

 

Figure 43. Apply the result Info Message (Commercial Carrier) 

 
NOTES: The Unit Type field must be 4-COMMERCIAL. i
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2. Verify that the correct carrier name displays in the search results. 

3. Click OK. 

Related fields populate with the search results and the data is stored in the External 
Information viewer on the Navigation Bar, as shown in Figure 44. 

 

Figure 44. Carrier Search Results Example 

External Information Viewer 
(Collapsed View Shown) 

Populated Fields 
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CAUTION: Changing a value in an external search information field does not 
automatically change other instances of that field in other locations. 

External Search 

Information Fields

 

!
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Using a GPS Device to Populate Latitude and Longitude 
Fields 

Downloading GPS Driver and Setting Communication Port 

TraCS can use data from a user-provided GPS device to automatically populate the Latitude 
and Longitude fields on the NCCRF. When a GPS is enabled, TraCS also displays current GPS 
coordinates at the bottom of the Forms Manager and Forms Viewer. 

To connect the GPS:  

1. Connect the user-provided GPS to your machine. 

2. Go to the GPS manufacturer’s website and download the latest driver for your device.  

3. Follow the GPS manufacturer’s instructions for installing the driver. 

4. Select Control Panel from the Windows Start menu and double-click Device Manager to 
open.  

 

NOTE:  NMEA has traditionally been implemented as a serial protocol and therefore, 
if a USB connection is used, there needs to be a USB to Serial Port conversion. 

The driver for the GPS device maps the USB connection to a serial port. 

i
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5. Locate the Ports (COM and LPT) line and click on the plus (+) sign to expand. The ports 
recognized by Windows are listed here. Note the port name that is listed as Serial Comm 
Port (COMx), where x is the number of the port. COM3 is the port number shown in the 
example in Figure 45. 

 

Figure 45. USB-to-Serial Comm Port Example 

6. Test your GPS to verify that it is working. 

7. Log in to Tracs. 
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8. From the Forms Manager window, click Set GPS CommPort on the Administrative tab. The 
Set GPS Com Port Number dialog box opens, as shown in Figure 45. 

 

Figure 46. Set GPS CommPort Dialog Window 

9. Enter the port number and click Yes. 

10. Click OK to close the confirmation message. The GPS is now ready to use in TraCS. 
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Activating GPS on the Form 

To activate GPS coordinates on the form: 

1. Open the form. 

2. Click in either the Latitude field or Longitude field to make the field active and click GPS. 
Both fields populate with the coordinates from the GPS. Figure 47 shows the fields before 
activation. 

 

Figure 47. Latitude and Longitude Fields 

 

 



  

 

TraCS 10 User's Guide for Supervisors and Reporters    

3-24 Chapter 3: Completing and Submitting the NCCRF 

Creating a Diagram 

Figure 48 shows two examples of a crash diagram; one created using the ESD tool and the 
other using the TraCS Diagram tool. 

 

Figure 48. Crash Diagram Examples 

 

WARNING: DO NOT USE COLOR. When the NCCRF is burned to the DMV-349 all 
objects display as black or white. The first example below shows how a fill of yellow 
displays after the NCCRF is burned to the DMV. NCDMV does not accept diagrams 
that use color. 

 

!

ESD Diagram TraCS Diagram 
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Drawing Requirements 

When creating the diagram of the crash scene, the following should be included: 

 Roads and intersecting roads, widths of roads, shoulders, and median strips. 

 Direction of travel for each traffic lane. 

 All roadside features pertinent to the crash (such as parked cars, trees, buildings, traffic 
signs and signals). 

 Paths of travel for involved vehicles and pedestrians prior to, during, and after the crash. 

 Tire marks and debris, if important in the crash or otherwise needed. 

 Measurements pertinent to the location of the point of impact should be shown on the 
diagram. Measure distances up to 500 feet with a tape, use odometer measurement of 
distances over 500 feet (528 ft = 1/10 mi). 

 Use the diagram tool’s compass symbol or draw an arrow pointing true north (relative to 
scene). 

 Add “Not to Scale” to each diagram. 
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Launching a Diagram Tool 

To launch a diagram tool: 

1. Go to the Diagram group on the form (Figure 49) and select ESD Diagram or TraCS 

Diagram and click Open. The launch window opens. 

 

Figure 49. Chose Diagram Tool 

2. Click Launch to open the tool. 

3. Complete the drawing. 

If you chose the ESD diagram tool, refer to the Easy Street Draw user guide for instructions 
on how to create a diagram using the program. If you are using ESD for the first time, see 
“Set Easy Street Draw (ESD) Version in TraCS” on page 3-27 for instructions on setting the 
version number. 

If you chose the TraCS diagram tool, see Chapter 8:“TraCS Diagram Tool Guide” for 
instructions on how to create a diagram using the program. 
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Set Easy Street Draw (ESD) Version in TraCS 

 Before using ESD 5 for the first time, set the ESD version to 5. 

1. From the Forms Manager, click Set ESD Version on the Administrative tab. The ESD 
Setting dialog window opens, as shown in Figure 50. 

 

Figure 50. EDS Setting Dialog Window 

2. Enter 5 in the box and click Yes. 
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Entering a Narrative 

Insert a word description of events occurring prior to, during, and after the crash which are not 
elsewhere on the form. Include in the description an explanation for Other options selected 
during data entry. The description should note all pertinent and unusual aspects of the crash. 
The statements made in this narrative should be in the opinion of the investigating officer. The 
crash narrative or description provides valuable information to traffic researchers, enabling them 
to design and promote Highway Safety Programs. 

To enter a narrative: 

1. Select NARRATIVE in the Navigation Tree, as shown in Figure 51. 

 

Figure 51. Narrative Selected in Navigation Tree 

  

 
NOTE: The narrative is limited to 4,000 characters. i
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2. Enter text directly in the Narrative databar box, or click Edit to open the Narrative box 
(shown in Figure 52) and enter the data there. 

 

Figure 52. Narrative Dialog Box 

3. If you entered the narrative in the Narrative databar, click Next (or press Enter) to save the 
data and move to the next field. 

If you entered the narrative in the Narrative box, click Save to save the data and close the 
Narrative box. The text entered displays in the Narrative group on the NCCRF. 

The data entered displays in the Narrative group on the NCCRF. 

 

  

 
NOTE: A narrative cannot exceed 4,000 characters. 

 
NOTE: The Narrative box has a Find button to search text within the narrative. 

i

i
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Edit Contact Information 

The contact name, date, time, and description for existing contacts can be edited from the 
Forms Viewer. 

To edit contact information: 

1. If the form is in edit mode, click Edit Form on the Home tab in the Forms Viewer to turn it 
off. 

2. Select Contact Information on the Home tab. The Contact Information dialog box opens, 
as shown in Figure 53. 

 

Figure 53. Contact Information Dialog Box 

3. Optional. Replace the contact name. 

 

NOTES: 

1. All forms in the contact must be closed or have the Edit Mode turned off before 
any information can be entered in the Contact Information dialog box. 

2. When a contact is created, the contact date and time default to the current time. 
The date and time should be changed to the date and time of the crash. Data 
entered in the Contact Information box display only on the TraCS interface—not 
on the form. The time and date on the NCCRF can only be changed in the 
Accident Date and Accident Time fields on the NCCRF. 

i
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4. Change the date and time to the date and time the crash occurred. The changes display in 
the Contact column on the Forms Manager Forms Grid and on the Forms Viewer title bar. 

5. Optional. Replace the contact description. 

6. Click Update. 

7. Click Yes to confirm. 
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Officer’s Notes 

Officers Notes provide an option to add information related to a crash that does not display on 
the form. 

Adding Officer’s Notes 

To add officer’s notes: 

1. Open the Officer Notes Notepad from the Forms Manager or Forms Viewer: 

 From the Forms Manager, select a form and click Officer Notes on the 
Administrative tab. 

 From the Forms Viewer, click Officer Notes on the Actions tab. 

2. Enter text. 

Saving and Closing Officer’s Notes 

There are two options when saving officer’s notes: 

 Officer’s notes can be saved to the local database and can be viewed by the supervisor 
after he or she receives the form from the reporter. Officer Notes saved to the local 
database are accessed within TraCS from the active form. 

 Officer’s notes can be saved to another location. Officer’s notes that are not saved to the 
local database are not included with the form when it is sent and cannot be accessed 
from within TraCS. 

  

 

NOTE: Officers Notes are associated with a form in TraCS, but do not print on the 
form. Officers Notes are not sent to the Crash Reporting System. 

Officers Notes may be subject to discovery in a court proceeding. 

i
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To save and close Officers Notes to the local database: 

1. Click Save on the File menu. The notes are saved to the local database. 

2. Click  to close the Notepad. 

An alternate way to save and close Officers Notes to the TraCS database: 

1. Click . The Do you want to save changes? message displays, as shown in Figure 54 

 

Figure 54. Do You Want to Save Changes to Officers Notes Message 

2. Click Save. The message closes. 

By default, TraCS saves the Officers Notes Notepad in the local database. To save and close 
Officers Notes in another location: 

1. Click Save As on the File menu. The Save As dialog box opens to the default folder. 

2. In the File name box, enter a new file name or keep the system-assigned file name. 

3. Select the folder in the folder list to which you want to save the Notepad and click Save. 

 

NOTE: The Do you want to save changes message displays only the first time the 
officer’s notes are saved. i
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Validating a Form 

Validating performs a cross-check between the crash data entered and a set of standard rules 
that confirm the form is complete and accurate. 

Two types of messages can display after initiating the validation–errors and warnings: 

 Error messages. Error messages provide suggestions for correcting the errors. All 
errors must be corrected and the form successfully validated and saved before it will 
transmit. 

 Warning messages. Warning messages identify conditions that do not violate rules, but 
they are illogical (for example, omitting insurance information on a vehicle). The form 
can successfully complete validation and still display warning messages. 

To validate a form: 

1. Click Validate on the Home tab in the Validation group. The validation fails if errors were 
made during data entry. 

2. If no errors are found, the form status changes to Validated. Continue to step 3. 

If errors are found, skip to step 5. 

3. If the form contains warnings, the Validate Form dialog box opens, as shown in Figure 55. 
Click Yes to see the warnings or No to complete validation. 

 

Figure 55. Validate Form Dialog Box 

 
NOTE: The NCCRF form must be in Edit mode to validate. 

 
NOTE: The validated form remains unlocked until it is transmitted. 

i
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4. The form is ready to be sent. Go to “Sending and Receiving Forms” on page 3-38, for 
instructions on how to transmit the form. 

5. A warning message displays. Click OK to close. 

The Validation Errors panel opens at the bottom of the Forms Viewer listing all errors and 
warnings, as shown in Figure 56. Table BB describes the Validation Errors panel elements. 

 

Figure 56. Validation Errors Panel 

Table BB. Validation Errors Panel Description 

Element Description 

Show Errors check box Select this check box to display or hide the errors on the Error Message 
Table. 

Show Warnings check box Select this check box to display or hide the warnings on the Error 
Message Table. 

Error Message Table  The Rule Number helps Technical Support troubleshoot the error if 
you cannot resolve the error yourself. 

 The message provides a brief explanation of the reason for each 
error and provides suggestions for correcting the error. 

 Double-click this row to go to the field on the form. 

Field and Group Name box Displays the field name and group name. Double-click the text to go to 
the field on the form. 

Validate button After errors are corrected, click Validate to perform another validation 
function to confirm that all entries in the form are correct. 

Validation Buttons  

Field and Group Name 

Error Message Table 
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Element Description 

Print button Click this button to open the TraCS Viewer – Validation Errors window. 
Errors and warnings are formatted on a letter-size document. From the 
Print Preview tab you can print, export, navigate, and zoom the 
Validation Errors document. 

Email button Click this button to send an email message listing the errors and 
warnings. 

Go To button Click this button to go to the field selected on the Error Message table. 

Close button Click this button to close the validation error window. 

NOTE: On the Home tab, in the Validation group, click Validation 
Errors to reopen the Validation Errors panel. 

 

6. Double-click the row or the field and group name. The field becomes active on the form. 

7. Make the correction. The error disappears from the Validation Errors panel. 

8. Continue until all errors are corrected. When the last error is corrected, the status of the 
form changes to Validated. 

9. The form is ready to be sent. See “Sending and Receiving Forms” on page 3-38 for 
instructions on how to transmit the form. 

 
NOTE: Editing an unlocked, validated form changes the form status back to “Open.” 

 
NOTE: The validated form remains unlocked until it is transmitted. 

i
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Closing a Form 

You can save and close a form in a contact without closing the Forms Viewer. 

To close the form, click the form close button, shown in Figure 57. 

The form is saved when you close the form. The Forms Viewer remains open. 

 

Figure 57. Close Buttons 

Closing a Contact 

To close a Contact, do one of the following: 

 On the Home tab, in the File group, click Close Contact. 

 Click the Forms Viewer close button. 

Open forms, the contact and the Forms Viewer close. Forms are automatically saved. 
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Sending and Receiving Forms 

The send and receive forms function is the crash report transmission piece of TraCS. The 
information that is communicated as part of the Send and Receive Forms function varies 
depending on the user’s access level. 

To perform a send and receive forms function: 

1. Click Send/Receive Forms in the Send Receive group on the Tools tab in the Forms 
Manager. 

If there are forms to be received, the Select reports to receive dialog box opens, as shown 
in Figure 58. This dialog box allows you to choose which forms you receive. 

 

Figure 58. Select Reports to Receive Reports Dialog Box 



  

 

TraCS 10 User's Guide for Supervisors and Reporters    

Chapter 3: Completing and Submitting the NCCRF 3-39 

2. Select the forms you want to receive and click OK. 

If one or more of the reports selected are a previous version of TraCS, a warning message 
displays, as shown in Figure 59. 

 

Figure 59. Previous Version Warning Message 

3. If the Previous Version Warning message displays, do one of the following: 

 Click Yes to continue. 

 Click No to receive only the reports created in the current TraCS version. 

 Click Cancel to return to the Select reports to receive dialog box. 

When the transmission is complete, a confirmation message displays with the number of 
reports sent and received, as shown in Figure 60. 

 

Figure 60. Transmission Results Message 

4. Click OK. 

 

CAUTION: Opening a form created in a previous version of TraCS permanently 
converts the form to TraCS 10. The form can no longer be opened in the previous 
version.  

!
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5. Click Search on the Search Panel to update the forms on the Forms Grid. 

After transmission: 

 The reporter’s validated forms that were sent to the supervisor are locked on the 
reporter’s TraCS Forms Manager. The reporter can view, but not edit the form. 

 Validated forms received from the reporter are unlocked on the supervisor’s TraCS 
Forms Manager. 

 Accepted Forms are sent to DMV. 

 Forms rejected by the supervisor or DMV have a Rejected status. 

6. Open and close TraCS 7.3 forms to complete the conversion to TraCS 10. 

Viewing and Editing a Form 

The form must be in edit mode before changes can be made. 

To edit a form: 

1. Double-click the form on the Forms Grid to open. The form opens in the Forms Viewer. 

2. Click Edit Form on the Home tab in the File group. The form is now in edit mode. 

 

CAUTION: Do not perform a send and receive forms function until after all TraCS 7.3 
forms have been opened and closed. Doing so locks the forms and they cannot be 
processed. 

 

NOTE: See “Form Status by Access Level” on page 1-6 for a description of all 
statuses. 

 

NOTE: The Edit button changes the edit mode of the form from view-only to edit and 
back to view-only. Locked forms cannot be changed to edit mode. 

!
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Transferring Forms to Another Machine 

The Transfer Reports to Disk and Transfer Reports From Disk functions are used to move 
forms from one machine to another. Transferring forms is necessary when: 

 An unfinished form needs to be transferred to another machine for completion  

 An officer is working on an machine without connectivity and has to move forms to 
another machine 

The Transfer Reports to Disk function selects and transfers all unlocked, open, validated, and 
rejected forms to a portable storage device, such as a USB flash drive or writable CD. 

Retrieving forms from the portable storage device completes the process of moving forms from 
one machine to another. The Transfer Reports From Disk function moves all forms on the 
device to the local machine. 

  

 

NOTE: Users can only transfer forms created with their user ID. When a supervisor 
performs a Transfer Reports to Disk command, their associated reporters’ forms are 
not transferred. 

i
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Transferring Forms to Disk 

To transfer forms to disk: 

1. Insert the portable storage device into the drive. 

2. Click Transfer Reports to Disk Tools on the Forms Manager Tools tab. 

The About to Transfer Crash Reports to Disk message displays, as shown in Figure 61. 

 

Figure 61. About to Transfer Crash Reports To Disk Message 

3. Click OK. 

The Choose Drive where Crash Reports should be transferred to dialog box opens, as 
shown in Figure 62. 

 

Figure 62. Choose Drive Where Crash Reports Should Be Transferred To 

4. Select a drive from the drive list and click OK. 

 

CAUTION: Transferring forms permanently removes the transferred forms from the 
originating machine. !
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5. TraCS creates a TraCSXfer folder (containing the reports extracted from TraCS) on the 
selected drive. When the transfer is complete, a message displays confirming the number 
of transferred reports, as shown in Figure 63. 

 

Figure 63. Number of Reports Transferred To Disk 

6. Click OK. 

7. Click Search on the Search Panel to update the forms on the Forms Grid. 

8. Continue to “Transferring Reports from Disk” to complete the process. 
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Transferring Forms from Disk 

Transferring forms from the disk completes the process of moving forms from one machine to 
another. 

To transfer forms from disk: 

1. Insert the portable device into the drive. 

2. Click Transfer Reports From Disk on the Forms Manager Tools tab in the Transfer To 

From Disk group. 

The About to Transfer all Crash Reports From Disk message displays, as shown in 
Figure 64. 

 

Figure 64. About to Transfer all Crash Reports From Disk Message 

3. Click OK. 

The Choose Drive where Crash Reports should be transferred from dialog box opens, as 
shown in Figure 65. 

 

Figure 65. Choose Drive where Crash Reports should be transferred from Dialog Box 

 

CAUTION: Transferring forms from disk permanently deletes the reports from the 
storage device. !
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4. Select a drive from the drive list and click OK. 

TraCS locates the TraCSXfer folder (containing the reports extracted from TraCS) on the 
selected drive. When the transfer is complete, a message displays confirming how many 
reports were transferred, as shown in Figure 66. 

 

Figure 66. Number of Reports Transferred From Disk 

5. Click OK. 

6. Click Search on the Search Panel to update the forms on the Forms Grid. 

Processing a Validated Form (Supervisor Only) 

This section provides instructions for supervisors processing validated forms. The procedure 
includes receiving, opening, and accepting or rejecting forms. 

Receiving and Opening Validated Forms 

To receive and open validated forms from reporters: 

1. Perform the send and receive function. See “Sending and Receiving Forms” on page 3-38 
for instructions. 

2. Click Search on the General tab of the Search Panel to display and update all forms on the 
Forms Grid. 

3. Open and close any TraCS 7.3 forms received during the send and receive function them to 
complete the form conversion to TraCS 10. 

4. Select and open the form to process. To open: 

 Double-click the form on the Forms Grid, or 

 From the File tab, click Open Form. 

 

CAUTION: Performing a send/receive function before opening and closing all 
TraCS 7.3 forms locks the form and prevents processing. !
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5. Review the form. 

6. To accept the form and send to DMV, continue to “Accepting the Form” on page 3-46. To 
reject the form, skip to “Rejecting the Form” on page 3-46. 

Accepting the Form 

To accept the validated form: 

1. Click Accept on the Actions tab in the Forms Viewer. The Form has been accepted 
message displays. 

2. Click OK. The form status changes from “Validated” to “Accepted.” 

The Accepted and unlocked status indicates that the form is ready to be sent to DMV for 
processing. 

3. Perform the send and receive function to send the form to DMV. See “Sending and 
Receiving Forms” on page 3-38 for instructions. 

The form status changes from Accepted-unlocked to Accepted-locked. 

Rejecting the Form 

To reject a validated form: 

1. From the Actions tab, click Reject. The Are you sure you want to reject Form dialog box 
opens. 

2. Click Yes. The Rejection Reason dialog box opens, as shown in Figure 67. 

 

Figure 67. Rejection Reason Dialog Box 
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3. Enter the reason for the rejection and click OK. The confirmation message displays. 

4. Click OK. 

The form status changes from Validated to Rejected. 

5. Click Save Form on the Home tab. 

6. Perform the send and receive function to send the form back to the submitting officer. See 
“Sending and Receiving Forms” on page 3-38 for instructions. 

The form status changes from Rejected/unlocked to Rejected/locked. “Rejected” displays 
as the form status in the Forms View title bar and the Navigation Bar. On the Forms Grid, 
the form displays as “Rejected” and locked. 

After the reporter performs the Send/Receive Forms function, the forms displays as 
Rejected and unlocked on his or her TraCS.  

Clearing a Form's Accepted or Rejected Status 

The supervisor can use the Clear command to remove an Accepted or Rejected status from a 
form.  

To clear a form's Accepted or Rejected status: 

1. Open the form in which you want to clear the status. 

2. Click Clear on the Actions tab. A confirmation message displays. 

3. Click Yes. The status of the form changes back to its original status. 

Viewing Accepted and Rejected Forms 

To check the status of forms submitted to the supervisor or DMV: 

1. Perform Send and Receive Crash Forms function. See “Sending and Receiving Forms” on 
page 3-38 for instructions. 

2. Click Search on the General tab of the Search Panel. All forms display on the Forms Grid. 
Check the Status column for accepted, rejected, and transmitted forms. 
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Viewing Form Rejection Reason 

To view rejection reason: 

1. Open the rejected form. 

2. If the form is rejected by a supervisor, select the Narrative group in the Navigation Tree in 
the Forms Viewer. The reason is located in the Reject Reason field. See “Supervisor’s 
Rejection Reason” on page 4-62 for more information. 

3. If a form is rejected by DMV, select the Violation group in the Navigation Tree in the Forms 
Viewer. The reason is located in the DMV Validation Messages field. See “DMV Validation 
Messages” on page 4-66 for more information. 

Correcting and Resubmitting a Rejected Form 

If a form is rejected, the originator (the person who initiated the form) corrects and resubmits the 
form. 

To correct and resubmit a form: 

1. Open rejected form. 

2. Make all corrections. 

3. Validate the form. For validation instructions, see “Validating a Form” on page 3-34. 

4. Save the form. 

5. Supervisor only. Click Accept on the Actions tab. 

6. Click Send/Receive on the Tools tab in the Forms Manager. 

Reporter only. The form is sent to your supervisor for approval. 

Supervisor only. The form is sent to DMV. 

  

 

NOTE: Always click the Search button on the Search Panel after clicking 
Send/Receive to update and display the forms status on the Forms Grid. 

 

NOTE: See “Sending and Receiving Forms” on page 3-38 for complete transmitting 
instructions. 

i
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Archive and Unarchive Forms 

Unlocked forms can be moved from your current database to your archive database. Archived 
forms do not display on the Forms Grid unless you include archive as the data source for the 
search criteria when performing a search.  

Archiving Forms 

To archive forms: 

1. Select one or more forms to be archived on the Forms Grid. 

2. Click Archive on the Data Transfer tab. 

The forms are moved to the archive database. 

Unarchiving Forms 

An archived form must be unarchived before you can open or delete it. Use the Unarchive 
command to move archived forms to your current database. 

To unarchive forms: 

1. Select Archive or All and the year from the Archive list on the Data Source section on the 
Search Panel, as shown in Figure 68. 

 

Figure 68. Search Panel (General Tab Displayed) 

2. Select the year from the Archive year list. 

3. Click Search. 

Archived forms display on the Forms Grid. 
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4. Select the forms to be unarchived and click Unarchive on the Data Transfer tab. 

The forms are moved from the archive database to the current database. 

Display Forms Based on Person’s Name 

You can search all forms in your current database by a person’s name. A person search based 
only on the name displays all forms matching the name entered. The person search can be 
narrowed further by selecting the person type in addition to the person name. 

To perform a person search: 

1. Click the Custom tab on the Forms Manager Search panel (Figure 69). 

 

Figure 69. Search Panel – Custom Tab 

 

NOTE: For more information on how to search for forms, see “Search Panel” on 
page 2-24. 

 
NOTE: Archived files are identified by an archive flag and date on the Forms Grid. 

 

NOTE: A person search only applies to names entered in the PERSON group on the 
form. 

i
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2. Enter a name for the person search. A wildcard * (asterisk) can be used in text search 
fields. Fields are not case-sensitive. 

The person name fields are: 

 Person First Name 

 Person Middle Name 

 Person Last Name 

 Person Suffix 

Any combination of person fields can be searched. For example, if you enter “Ben” as the 
search value for the Person First Name, the search results display all persons with the first 
name of “Ben.” To narrow the person search, enter data in one or more of the other person 
fields. 

3. To narrow the name search to a specific person type, click Person Type in the Custom 

Search Fields and select a person type in the Select the search values list. 

4. Click Search. 

The Forms Grid displays forms using the search criteria you entered. 

Creating a Supplemental Report 

A supplemental report modifies a report that has been accepted by DMV. A supplemental traffic 
crash report must be submitted when: 

 The original report was incomplete because of lack of information or an incomplete 
investigation. 

 A correction on the original report is necessary because of inaccurate information. 

 A person injured in a crash dies within twelve months as a result of the crash, and the 
death was not reported in the original report. 

  

 

NOTE: For more information on how to search for forms, see “Search Panel” on 
page 2-24. i
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Identifying NCDMV Transmitted Reports in TraCS 

A supplemental can only be applied to a form with a status of “Transmitted.” To create a 
supplemental report, the accepted crash report with a valid NCDMV Crash ID number must 
display in your current TraCS database. 

The NCDMV Crash ID number replaces the form and case numbers. NCDMV Crash ID 
numbers start with “1”. Figure 70 shows an example of the numbers and status display in TraCS 
before and after NCDMV acceptance. 

 

Figure 70. Form and Case Numbers and Status Before and After NCDMV Acceptance 

  

 

NOTE: If the form is in your archive database, you must transfer it to your current 
database before you can create a supplemental. (See “Archive and Unarchive 
Forms” on page 3-49 for instructions.) 

If the report is not in either your current or archived database, download it from the 
TRCS server. Go to Chapter 6: “Search Crashweb for Reports” for instructions on 
how to search for the DMV Crash ID number. 

i
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After NCDMV Acceptance 

 

 

Before NCDMV Acceptance 
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Downloading a Report from the TRCS Server 

To download a report from the TRCS server: 

1. If you do not know the DMV Crash ID you can search for it on Crashweb. Go to Chapter 
6: “Search Crashweb for Reports” for instructions. 

2. Select Create Supplemental on the Forms Manager Tools tab. The Enter DMV Crash ID for 

Supplemental dialog box opens, as shown in Figure 71. 

 

Figure 71. Enter DMV Crash ID for Supplemental 

3. Enter the DMV Crash ID and click OK. The report downloads to your local database. The 
Crash Report Saved message displays, as shown in Figure 72. 

 

Figure 72. Crash Report Saved Message 

4. Click OK again to close the Crash Report Saved message. 

5. Click Search on the Search Panel to update the Forms Grid with the downloaded form. 

6. Continue to “Submitting a Supplemental Report” to complete the process. 

 

NOTE: Any TraCS user (supervisor or reporter) can download any DMV-accepted 
crash report from the TRCS server that was submitted by their agency. 

 

NOTE: Reports completed in TraCS 7.3 are permanently converted to TraCS 10 
when they are opened in TraCS 10. 

TraCS 7.3 users cannot submit a supplemental for a TraCS 10 report. 

i
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Submitting a Supplemental Report 

After receiving the processed report back from DMV (with a valid DMV Crash ID) follow these 
steps to submit a supplemental report. 

1. Locate and open the form on the Forms Grid. 

2. Click Edit Form on the Home tab in the File group. 

3. The Do you want to proceed? message displays (as shown in Figure 73) to let you know 
that the status will change from “Transmitted” to “Open.” Click Yes. The form converts to 
edit mode and the databar displays. 

 

Figure 73. Do You Want to Proceed Message 

4. The first field of the form is the Supplemental Report field. Select Yes on the databar and 
click Next. 

5. Make the required corrections to the report. 

6. Validate and send through the normal submission process. 

 

 
NOTE: A DMV Crash ID starts with "1" and replaces the NCCRF form number. 

 

NOTE: If the original report included a hit and run driver and the driver has been 
apprehended the supplemental report must include all information for that respective 
driver and vehicle. 

i
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Chapter 4: The North Carolina Crash 
Report Form 

In North Carolina, TraCS is used to submit an electronic version of the paper-based NC Crash 
Report Form DMV-349. The electronic form is called the North Carolina Crash Report Form 
(NCCRF). In the state of North Carolina, the NCCRF is the only form defined in TraCS. 

See Chapter 10: “Glossary of Terms” for definitions, interpretations, and examples related to 
motor vehicles and other road vehicle crashes. 

Follow the instructions on the databars to successfully enter data in the form. 

NCCRF Group and Collections 

The NCCRF form is separated into logical groups. Some groups are further separated into 
collections. All groups contain fields in which data is entered to complete the form. Figure 74 
shows an example of the UNIT 1 group and UNIT 1 group collections in the Navigation Tree. 

 

Figure 74. Group and Collection Example 

Non-Recurring Groups 

Groups that occur only once on the form are known as non-recurring groups. The NCCRF 
contains the following four non-recurring groups: 

 Crash Data, page 4-2 

 Diagram, page 4-60 

 Narrative, page 4-61 

 DMV Validation Messages, page 4-66 
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Recurring Groups 

Groups that can occur more than one time on the form are known as recurring groups. The 
NCCRF contains the following five recurring groups: 

 Unit, page 4-23 

 Person, page 4-55 

 Property Damage, page 4-62 

 Witness, page 4-64 

 Violation, page 4-65 

Crash Data Group 

The Crash Data group is used to collect information about the location, road conditions, and 
environment of the crash site. The collections that make up the Crash Data group are: 

 Header, page 4-2  

 Location, page 4-4 

 Accident Environment, page 4-12 

 Roadway Information, page 4-17 

 Work Zone Related, page 4-21 

 System Generated Auto-Populated Fields, page 4-22 

Header Fields 

Figure 75 shows the fields in the header of the crash data group. Table CC describes the fields. 

 

Figure 75. Crash Data Group – Header Fields 
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Table CC. Header Fields 

Field Description 

Supplemental Report Select Yes if the form was previously accepted by DMV and has a valid DMV 
Crash ID and requires correction or additional information. 

NOTE: A DMV Crash ID starts with “1” and replaces the NCCRF form number. 

 

CAUTION: Do not select Yes when filling out the initial report. The 
purpose of a Supplemental Report is to modify a report that has been 
previously accepted by DMV. 

See “Creating a Supplemental Report” on page 3-51 for complete instructions. 

Non-Reportable Agencies can choose to report a crash that does not meet the State's criteria 
for a reportable crash. If submitting a non-reportable crash to the State, select 
Yes. 

A reportable motor vehicle traffic crash must include a fatality, injury, property 
damage of $1,000.00 or greater or property damage of any amount to a vehicle 
seized. A reportable crash must occur on a trafficway or occur after the motor 
vehicle runs off the roadway but before events are stabilized. 

Accident Date When the form opens for the first time this field displays the current date. The 
date should be changed to the actual date of the crash. 

Accident Time When the form opens for the first time this field displays the current time. The 
time should be changed to the actual time of the crash. The time of the crash is 
recorded in 24-hour clock time. Noon is 12:00 and midnight is 24:00. For 
crashes that occur exactly at midnight use 23:59. 

For example, 8:00 AM is recorded as 08:00 and 8:15 PM is recorded as 20:15. 

Case Number The system automatically populates this field. 

County Select the county in which the crash occurred.  

Local Use This field is optional, but highly recommended. Enter the local identification of 
an accident. The maximum length is 20 characters. If entered, the identification 
can be used to search for the form. 

Patrol Area This field is optional. Enter the patrol area. The maximum length is five 
characters. 

User Defined 1 This field is available for local agency use. No DMV edits applied. The 
maximum length is 32 characters. 

User Defined 2 This field is available for local agency use. No DMV edits applied. The 
maximum length is 32 characters. 

!
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Location Fields 

Figure 76 shows the fields in the Location section of the Crash Data group. Table DD describes 
the fields. 

 

Figure 76. Crash Data Group – Location Section 

Table DD. Location Fields 

Field Description 

Relation to Roadway 
Surface 

Indicates the specific location of the first harmful event at the crash level. 
Select one of the following: 

1 – On Roadway surface 

2 – Shoulder 

3 – Median 

4 – Roadside 

5 – Outside Trafficway (off roadway) 

6 – Unknown 

Crash Occurred Select I – In if the crash occurred inside the corporate city or town limits. 

Select N – Near if the crash occurred outside the corporate city or town limits. 
The Miles Outside City and Direction Outside City fields become available. 
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Field Description 

Municipality The Municipality list contains only municipalities that are in the selected county. 

If the municipality is not listed, select Other. The Other Name or Municipality 
field becomes available. 

Other Name or 
Municipality 

Enter the name of the municipality or town the crash occurred.  

Miles Outside City Enter the miles outside the municipality that the crash occurred. 

NOTE: This field is unavailable if I – In is selected in the Crash Occurred field. 

Direction Outside 
City 

Indicate the direction outside the municipality that the crash occurred. Select 
one of the following: 

E – East 

N – North 

NE – Northeast 

NW – Northwest 

S – South 

SE – Southeast 

SW – Southwest 

W – West 

NOTE: This field is unavailable if I – In is selected in the Crash Occurred field. 

Ramp or Service 
Road 

Select Yes if the crash occurred on a ramp or service road. 

On Road Class Select the highest classification of the road: 

I – Interstate route 

LCL – Local 

NC – North Carolina numbered route 

PP – Private road, property or driveway 

PVA – Public vehicular area 

SR – Secondary road 

US – US numbered route 

UNK – Unknown 
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Field Description 

On Road Name Enter the route number, road name, or street name of the road, or select 
Locate from the databar to open the Incident Location Tool (ILT). When the 
Incident Location Tool (ILT) is used to identify the crash location, the On Road 
Name, At Frm, From Road Class, and the From Road Name fields 
automatically populate. See Chapter 7: “Incident Location Tool Guide” for more 
information. 

Enter a route number when the Road Class is US, NC, I, or SR. 

Enter the text name associated with the location of the crash when the Road 
Class is LCL, PVA, PP, or UNK. 

NOTE: Do not enter periods in the street name. 

Use the following abbreviations for the street type suffix:  

RD – Road 

ST – Street 

AV – Avenue 

PL – Place 

CT – Court 

LN – Lane 

TR – Trail 

CIR – Circle 

BLVD – Boulevard 

PKWY – Parkway 

FRWY – Freeway 

HWY – Highway 

Directional abbreviations are: N, S, E, W, NW, NE, SE, and SW. 

On Road Type Select one of the following road types: 

No special type 

ALT – Alternate 

BUS – Business 

P – Bypass 

NOTE: This field is optional and can be entered when the Road Class is 
Interstate, NC, or US. Alternate, Business or Bypass routes have signs posted. 
Typically, routes do not have special types. 

RR Crossing # Enter the Rail Road Crossing number if the crash occurred at or near a rail-
highway grade crossing. 

If not a rail-highway grade crossing, leave this field blank. If the crash occurred 
at or near a rail-highway grade crossing, enter the number posted at the site. 
The number is composed of six digits and a letter, such as 687422t (this field 
accepts 7 digits only). If the number is missing or illegible, include the name of 
the railroad company owning or operating the tracks in the narrative. 
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Field Description 

At Frm Select At if the crash occurred at intersecting streets. 

Select From to indicating the crash occurred between two streets. Miles Frm, 
Feet Frm, and From Direction field become available. 

Miles Frm Enter the miles to the nearest intersection. If the distance is only feet to the 
nearest intersection, leave this field blank. 

Feet Frm Enter the distance in feet from the nearest intersecting street. If the distance is 
miles to the nearest intersection, leave this field blank. 

From Direction Select the direction from the nearest intersecting street to the scene of the 
crash. City streets may run in intermediate compass directions and should be 
listed as such (for example, Northeast). Select one of the following: 

E – East 

N – North 

NE – Northeast 

NW – Northwest 

S – South 

SE – Southeast 

SW – Southwest 

W – West 

From Road Class Select the highest classification of the road: 

CL – County line 

I – Interstate route 

LCL – Local 

MILE – Mile marker 

ML – Municipal line 

NC – NC numbered route 

PP – Private road, property or driveway 

PVA – Public vehicular area 

SL – State line 

SR – Secondary road 

US – US numbered route 

UNK – Unknown 

After the From Road Class and Toward Road Class fields are selected, the 
Toward SL-State, Toward CL-County, and Toward ML fields become 
available based on the road class entered. 
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Field Description 

From Road Name Enter the US, NC, I, or SR number or text name of the road name. 

Enter a route number when the From Road Class is US, NC, I, or SR. 

Enter the text name associated with the location of the crash when the From 
Road Class is LCL, PVA, PP, or UNK. 

NOTE: Do not enter periods in the street name. 

Use the following abbreviations for the street type suffix: 

RD – Road 

ST – Street 

AV – Avenue 

PL – Place 

CT – Court 

LN – Lane 

TR – Trail 

CIR – Circle 

BLVD – Boulevard 

PKWY – Parkway 

FRWY – Freeway 

HWY – Highway 

Directional abbreviations: N, S, E, W, NW, NE, SE, and SW. 

From Rd type Select one of the following road types: 

No special type 

ALT – Alternate 

BUS – Business 

P – Bypass 

NOTE: This field is optional and can be entered when the From Road Class is 
Interstate, US, or NC. Alternate, Business or Bypass routes have signs posted. 
Typically, routes do not have special types. 

From SL-State This field becomes available when SL – State line is selected in the From 
Road Class field. Select the state line where the crash occurred: 

Georgia 

South Carolina 

Tennessee 

Virginia 

From CL-County This field becomes available when SL – County line is selected in the From 
Road Class field. Select the county line. The CL-County Line Road 
classification requires that the appropriate North Carolina county be selected. 
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Field Description 

From ML This field becomes available when ML – Municipal line is selected in the From 
Road Class field. 

Select the municipality (city or town), or select Other when the municipality is 
not listed. 

From Other ML 
Name 

This field becomes available when Other is selected in the From ML field. 

Enter the name of the municipality. 

Toward Direction Enter the direction toward the nearest intersecting street to the crash site. City 
streets may run in intermediate compass directions and should be listed as 
such (for example, Northeast). Select one of the following: 

E – East 

N – North 

NE – Northeast 

NW – Northwest 

S – South 

SE – Southeast 

SW – Southwest 

W – West 

Toward Road Class Select the highest classification of the road or street: 

CL – County line 

I – Interstate route 

LCL – Local 

MILE – Mile marker 

ML – Municipal line 

NC – NC numbered route 

PP – Private road, property or driveway 

PVA – Public vehicular area 

SL – State line 

SR – Secondary road 

UNK – Unknown 

US – US numbered route 

After the From Road Class and Toward Road Class fields are selected, the 
Toward SL-State, Toward CL-County, and Toward ML fields become 
available based on the road class entered. 
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Field Description 

Toward Road Name Enter the US, NC, I, or SR number or text name of the crash location. 

Enter a route number when the Toward Road Class is US, NC, I, or SR. 

Enter the text name associated with the location of the crash when the Toward 
Road Class is LCL, PVA, PP, or UNK. 

NOTE: Do not enter periods in the street name. 

Use the following abbreviations for the street type suffix: 

RD – Road 

ST – Street 

AV – Avenue 

PL – Place 

CT – Court 

LN – Lane 

TR – Trail 

CIR – Circle 

BLVD – Boulevard 

PKWY – Parkway 

FRWY – Freeway 

HWY – Highway 

Directional abbreviations: N, S, E, W, NW, NE, SE, and SW. 

Toward RD type Select one of the following road types: 

No special type 

ALT – Alternate 

BUS – Business 

P – Bypass 

NOTE: This field is optional and can be entered when the Toward Road Class 
is Interstate, US, or NC. Alternate, Business or Bypass routes have signs 
posted. Typically, routes do not have special types. 

Toward SL-State Select the State Line where the crash occurred: 

Georgia 

South Carolina 

Tennessee 

Virginia 

Toward CL-County Select the appropriate County. 

NOTE: When CL-County line is selected for the Toward Road Class field, 
the Toward CL-County field becomes available. 

Toward ML Select the municipality name. 
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Field Description 

Toward Other ML 
Name 

When Other is selected in the Toward ML field, this field becomes available. 

Enter the name of the municipality. 

Latitude If available, enter the geographical latitude location in decimal degrees. 
See NOTE. 

Longitude If available, enter the geographical longitude location in decimal degrees. 
See NOTE. 

Altitude If available, enter the geographical altitude (elevation) in feet. 

 

  

 

NOTE: TraCS can use data from a GPS device to automatically populate fields on a 
form. When a GPS is enabled, TraCS also displays current GPS coordinates at the 
bottom of the Forms Manager and Forms Viewer. 

For a GPS receiver to work with TraCS it must be able to broadcast NMEA to a COM 
port. Even though a GPS device connects to a machine through a USB port, most 
come with USB to COM drivers. Go to the Administrative tab on the Forms Manager 
to enter the GPS communication ports and coordinates (see “Administrative Tab” on 
page 2-12 for descriptions). 

i
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Accident Environment Fields 

Figure 77 shows the fields in the Accident Environment of the Crash Data group. Table EE 
describes the fields. 

 

Figure 77. Crash Data Group – Accident Environment Section 

Table EE. Accident Environment Fields 

Field Description 

Locality Select a locality development: 

1 – Rural (<30% developed) 

2 – Mixed (30% to 70% developed) 

3 – Urban (>70% developed) 

The locality refers to the general type and level of development near the 
collision. If the estimated total development is less than 30%, or about 1/3 of 
road frontage on both sides over a substantial distance from the scene of the 
collision, select Rural. 

Predominant 
Development Type 

Select the predominant development type: 

1 – Farms, woods, pastures 

2 – Residential 

3 – Commercial (mainly retail stores) 

4 – Institutional (schools, hospitals, government buildings) 

5 – Industrial 
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Field Description 

Road Surface 
Condition 

Select the road surface condition that describes the roadway surface 
conditions at the time and place of the crash. Select one of the following: 

01 – Dry 

02 – Wet 

03 – Water (standing, moving) 

04 – Ice 

05 – Snow 

06 – Slush 

07 – Sand, Mud, Dirt, Gravel 

08 – Fuel, Oil 

09 – Other (explain in the narrative) 

10 – Unknown 

Weather Condition 1 Select the general atmospheric conditions that existed at the time of the crash. 
Select one of the following: 

1 – Clear 

2 – Cloudy 

3 – Rain 

4 – Snow 

5 – Fog, smog, smoke 

6 – Sleet, hail, freezing rain/drizzle 

7 – Severe cross winds 

8 – Blowing sand, dirt, snow 

9 – Other (explain in the narrative) 

Weather Condition 2 NOTE: When data is entered in the Weather Condition 1 field, the Weather 
Condition 2 field becomes available. 

If pertinent, select the second general atmospheric conditions that existed at 
the time of the crash. 

Weather Contributed Select an indication, in the officer’s opinion as to whether or not weather was a 
contributing factor in the crash. Select one of the following: 

1 – Yes 

2 – No 

3 – Unknown 
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Field Description 

Ambient Light Ambient light refers to the type of light that existed at the time of the crash. 
Select one of the following: 

1 – Daylight 

2 – Dusk 

3 – Dawn 

4 – Dark-lighted roadway 

5 – Dark-roadway not lighted 

6 – Dark-unknown lighting 

7 – Other (explain in the narrative) 

8 – Unknown 

NOTE: Extremely cloudy conditions may be classified as Dawn or Dusk if the 
ambient light conditions are similar (explain in the narrative).  
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Field Description 

Crash First Harmful 
Event 

Select the first injury or damage producing event that characterizes the crash 
type and identifies the nature of the first harmful event. Select one of the 
following: 

00 – Unknown 

01 – Ran off road-right 

02 – Ran off road-left 

03 – Ran off road-straight 

04 – Jackknife 

05 – Overturn/rollover 

13 – Other non-collision (explain in the narrative) 

14 – Pedestrian 

15 – Pedalcyclist 

16 – Railway train, engine 

17 – Animal 

18 – Movable object (explain in the narrative) 

19 – Fixed object (explain in the narrative) 

20 – Parked motor vehicle 

21 – Rear end, slow or stop 

22 – Rear end, turn 

23 – Left turn, same roadway 

24 – Left turn, different roadways 

25 – Right turn, same roadway 

26 – Right turn, different roadways 

27 – Head on 

28 – Sideswipe, same direction 

29 – Sideswipe, opposite direction 

30 – Angle Collision 

31 – Backing up 

32 – Other collision with vehicle (explain in the narrative) 
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Field Description 

Crash Most Harmful 
Event 

Select the most harmful event that produced the greatest property damage or 
most severe injury in the crash. If several vehicles are involved in a crash, 
select the harmful event that was the most harmful in the crash. 

Select one of the following: 

00 – Unknown 

01 – Ran off road-right 

02 – Ran off road-left 

03 – Ran off road-straight 

04 – Jackknife 

05 – Overturn/rollover 

13 – Other non-collision (explain in the narrative) 

14 – Pedestrian 

15 – Pedalcyclist 

16 – RR train, engine 

17 – Animal 

18 – Movable object (explain in the narrative) 

19 – Fixed object (explain in the narrative) 

20 – Parked motor vehicle 

21 – Rear end, slow or stop 

22 – Rear end, turn 

23 – Left turn, same roadway 

24 – Left turn, different roadways 

25 – Right turn, same roadway 

26 – Right turn, different roadways 

27 – Head on 

28 – Sideswipe, same direction 

29 – Sideswipe, opposite direction 

30 – Angle 

31 – Backing up 

32 – Other collision with vehicle (explain in the narrative) 
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Field Description 

Roadway 
Contributing 
Circumstance 1 

Select the apparent condition of the road which contributed to the crash. Select 
one of the following: 

00 – None (no unusual conditions) 

01 – Road Surface Condition 

02 – Debris 

03 – Rut, holes, bumps 

04 – Work zone (construction, maintenance, utility) 

05 – Worn travel-polished surface 

06 – Obstruction in roadway 

07 – Traffic control device inoperative, not visible or missing 

08 – Shoulders low, soft or high 

09 – No shoulders 

10 – Non-highway work 

11 – Other (explain in the narrative) 

12 – Unknown 

Roadway 
Contributing 
Circumstance 2 

NOTE: When data is entered in the Roadway Contributing Circumstance 1 
field, this field becomes available. 

Indicate the second contributing circumstance (if applicable), that contributed to 
the crash. 

 

Roadway Information Fields 

Figure 78 shows the fields in the Roadway Information section of the Crash Data group. 
Table FF describes the fields. 

 

Figure 78. Crash Data Group – Roadway Information Section 
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Table FF. Roadway Information Fields 

Field Description 

Road Feature Select the road feature: 

00 – No special feature 

01 – Bridge 

02 – Bridge approach 

03 – Underpass 

04 – Driveway, public 

05 – Driveway, private 

06 – Alley intersection 

07 – Four-way intersection 

08 – T-intersection 

09 – Y-intersection 

10 – Traffic circle/roundabout 

11 – Five-point, or more 

12 – Related to intersection 

13 – Non-intersection median crossing 

14 – End or beginning-divided highway 

15 – Off-ramp entry 

16 – Off-ramp proper 

17 – Off-ramp terminal on crossroad 

18 – Merge lane between on and off ramp 

19 – On ramp entry 

20 – On ramp proper 

21 – On ramp terminal on crossroad 

22 – Railroad crossing 

23 – Tunnel 

24 – Shared use path or trails 

25 – Other (explain in the narrative) 

NOTE: If the location of the first harmful event coincides with one of the road 
features indicated, select the specific road feature. 
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Field Description 

Road Character Road character describes the change in horizontal direction of a roadway, 
determined at the point of curvature. Select one of the following: 

1 – Straight, level 

2 – Straight, hillcrest 

3 – Straight, grade 

4 – Straight, bottom (sag) 

5 – Curve, level 

6 – Curve, hillcrest 

7 – Curve, grade 

8 – Curve, bottom (sag) 

9 – Other (explain in the narrative) 

Road Classification The road classification describes the character of service or function of streets 
or highways. Use the highest class (use road class for local streets having 
route designation). Select one of the following: 

1 – Interstate 

2 – US Route 

3 – NC Route 

4 – State Secondary Route 

5 – Local Street 

6 – Public Vehicular Area 

7 – Private Road, Driveway 

8 – Other (explain in the narrative) 

Road Surface Type The Road Surface Type is the actual surface type of the roadway on the area 
in which the crash occurred. Select one of the following: 

1 – Concrete 

2 – Grooved Concrete 

3 – Smooth asphalt 

4 – Coarse asphalt 

5 – Gravel 

6 – Sand 

7 – Soil 

8 – Other (explain in the narrative) 
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Field Description 

Road Configuration Road configuration indicates whether or not a trafficway is divided and whether 
it serves one-way or two-way traffic. A median must be present for a divided 
road. Select one of the following: 

1 – One-way, not divided 

2 – Two-way, not divided 

3 – Two-way, divided, unprotected median 

4 – Two-way, divided, positive median barrier 

5 – Unknown 

Access Control The Access Control indicates the degree of access to a roadway controlled by 
public authority. Select one of the following: 

1 – No access control 

2 – Full access control 

3 – Partial access control 

Number of Lanes Enter the total number of thru lanes of the “road-on” at the point of the collision. 
If two-way, then the total number for both directions is entered. Do not count 

turning lanes unless they are continuous between intersections. Enter 0 for 

parking lots. 

Traffic Control Type Select the type of traffic control device present at the collision site and whether 
it was operating and visible at the time. Examples include RR crossbucks only 
(the black on white cross-arm device), human control (for example, law officer 
or railroad flagman). Select one of the following: 

00 – No control present 

01 – Stop sign 

02 – Yield sign 

03 – Stop and go signal 

04 – Flashing signal with stop sign 

05 – Flashing signal without stop sign 

06 – RR gate & flasher 

07 – RR flasher 

08 – RR crossbucks only 

09 – Human control 

10 – Warning sign 

11 – School zone signs 

12 – Flashing stop and go signal 

13 – Double yellow line, no passing zone 

14 – Other (explain in the narrative) 

Traffic Control 
Operating? 

Select Yes, No, or Unknown to indicate whether the device was operating 
properly at the time of the collision. 
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Work Zone Related Fields 

Figure 79 shows the fields in the Work Zone Related fields of the Crash Data group. Table GG 
describes the fields. 

 

Figure 79. Crash Data Group – Work Zone Related Section 

Table GG. Work Zone Related Fields 

Field Description 

Work Zone Area? Work zone related information is used to assess the impact of work activities 
and crash statistics. Select one of the following: 

1 – Construction work area 

2 – Maintenance work area 

3 – Utility work area 

4 – Intermittent work (such as patching a pothole) 

5 – No (disables the next three fields) 

Work Activity at time 
of crash 

Indicate if there was work activity at the time of the crash. Select one of the 
following: 

1 – On going 

2 – No apparent activity 

Work area marked at 
time of crash? 

Select how the work area was marked at the time of the crash: 

1 – Yes, marked with warning signs, cones 

2 – No, not marked 

Work Zone Related 
Crash Location 

Select the location of the crash in relation to the work area: 

1 – Before work area 

2 – In work area approach taper 

3 – Adjacent to actual work area 
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System Generated Auto-Populated Fields 

Figure 80 shows the fields that are automatically populated by the TraCS system in the Crash 
Data group. Table HH describes the fields. If the information is incorrect, contact your agency 
administrator. 

 

Figure 80. Crash Data Group – Auto-Populated Fields Section 

Table HH. Auto-Populated Fields 

Field Description 

Name of Agency Displays the name of the Police Department. 

Agency Identification Displays the agency’s ID number. 

Host Name* The identification of the machine that the form resides on. 

Date of Report Initiated Displays the date the form was created. 

DMV Crash ID The crash identification number displays in this field after DMV approves 
the report. 

DMV Report Status Not used. 

Officer Last Name* Displays the officer’s last name. 

Officer First Name* Displays the officer’s first name. 

Officer Middle Name* If applicable, displays the officer’s middle name. 

Suffix* If applicable, displays the officer’s name suffix. 

Officer Number* Displays the officer’s badge number. 

Officer Name* Displays the officer’s full name. 

Release Number Displays the version of TRCS used when the form was created. 
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Field Description 

Original Case Number Displays the system-assigned case number. 

Accepted User ID Displays the supervisor’s ID. 

* Agency-defined. 

Unit Group 

The Unit group is a recurring group that is used to collect information on the following items: 

 Unit Description, page 4-24 

 Driver, page 4-28 

 Vehicle, page 4-36 

 Owner, page 4-48 

 Trailer Information, page 4-50  

 Carrier, page 4-51 

 Hazardous Materials, page 4-53 
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Unit Description Fields 

Figure 81 shows the fields in the Unit description fields of the Crash Data group. Table II 
describes the fields. 

 

Figure 81. Unit Group – Unit Description Section 

Table II. Unit Description Fields 

Field Description 

Unit Number Indicates the unit number. 

Unit Type 1 – Vehicle: A motor vehicle or combination of motor vehicles for private use. 

2 – Pedestrian: Non-motorist involved in accident. When Pedestrian is 
selected for the Unit Type field, the Non-Motorist Contributing 
Circumstances 1 field becomes available. 

3 – Hit & Run: Unknown motor vehicle involved in accident. See “Hit and Run 
Related Fields” on page 4-25 for detailed instructions. 

4 – Commercial: A motor vehicle or combination of motor vehicles used in 
commerce. 

5 – Other: Miscellaneous other units. For example, train, farm tractor, bicycle, 
or moped. 

When Other is selected for the Unit Type field, the Unit Other Description 
field and the Non-Motorist Indicator check box become available. 

Unit Other 
Description 

This field is available when 5-Other is selected for the Unit Type. Enter the 
description of the other vehicle type. 

Non-Motorist 
Indicator 

This box is available if 5-Other is selected for the Unit Type. Select Yes if a 
non-motorist unit contributed to the crash (related non-motorist contributing 
circumstances fields become enabled). 

 

NOTE: See “Adding a Recurring Group” on page 3-9 for instructions on how to add 
another Unit group to the form. i
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Hit-and-Run Related Fields 

If 3-Hit & Run is selected as the Unit Type, leave all fields empty in the Driver section except the 
Driver Contributing Circumstances 1 field. Owner fields can be completed if the information is 
known. 

The form does not allow incomplete descriptive information for the driver and vehicle. If you 
have a partial description, enter the information in the Narrative section. 

There is one field in the Driver section and nine fields in the Vehicle section that require data. 
Complete these fields to the best of your ability, and then explain any discrepancies in the 
Narrative section. Table JJ lists the mandatory fields for a hit-and-run. 

Table JJ. Hit-and-Run Related Fields 

Section Field Selection 

Unit 
Description 

Unit Type 3 – Hit & Run 

Driver Driver Contributing 
Circumstances 1 

33 – Unable to determine 

Vehicle Vehicle Style Type 32 – Unknown 

Vehicle Drivable Yes 

Direction Select the traveling or parked direction. Select one of the 
following: 

E – East 

N – North 

NE – Northeast 

NW – Northwest 

S – South 

SE – Southeast 

SW – Southwest 

W – West 

 

NOTE: You do not need a Person group for a hit-and-run if the driver information is 
unknown although you will receive a warning when validating the NCCRF. i
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Section Field Selection 

Vehicle 
(cont.) 

Road Class Select the highest classification of the road or street the 
vehicle was traveling or parked. Select one of the following: 

I – Interstate route 

LCL – Local 

NC – NC numbered route 

PP – Private road, property or driveway 

PVA – Public vehicular area 

SR – Secondary road 

UNK – Unknown 

US – US numbered route 

Road Name Enter the route number, road name or street name of the 
road. If the street does not have a route number, use the city 
street name. 
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Section Field Selection 

Vehicle 
(cont.) 

Points of Initial Contact Select points of initial contact. A maximum of five can be 
selected. If contacts overlap areas, more than one number 
should be recorded. 

For back distributed impact on an automobile, select 14, 15, 
or 16. Points of initial contact consists of parts which the 
vehicle first contacts, not secondary. 

00 – Pedestrians & Non-Contact Vehicle (that remained on 
the scene) 

1 thru 21 – Vehicle (Passenger Cars/Small Trucks) 

 

22 thru 24 – Vehicle (Underneath) 

 

1 thru 25 and 31 thru 40 – Vehicle (Tractor-Trailers) 

 

27 thru 30 and Motorcycles, Bicycles, and Mopeds 

 

25 –Vehicle rolled over and it is impossible to determine 
initial impact 

26 – Unknown 

00 – No contact (fell from moving vehicle, for example) 

Vehicle 
Maneuver/Action 

16 – Other (explain in the narrative) 

22 24 

23 

Front Rear 

Front Rear 
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Section Field Selection 

Vehicle 
(cont.) 

First Harmful Event for 
this unit 

32 – Other collision with vehicle (explain in the narrative) 

Most Harmful Event for 
this unit 

32 – Other collision with vehicle (explain in the narrative) 

 

Driver Fields 

Figure 82 shows the fields in the Driver section of the Unit group. Table KK describes the fields. 

 

Figure 82. Unit Group – Driver Section 
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Table KK. Driver Fields 

Field Description 

DL State Select the state in which the driver license was issued. 

DL Number Enter the driver license number. If the driver has a permit, enter the permit 
number. 

NC licensed drivers only. The driver license number is used to access a 
driver’s records by searching the NCDMV driver license database. See 
“Searching for Driver Information (North Carolina Driver Licenses Only)” on 
page 3-10. 

DL Class Enter the driver license class. 

Commercial Driver 
License 

Select Yes if the driver license is a commercial driver license.  

Driver Address same 
on DL 

Select Yes if the driver’s address is the same as the address on the driver’s 
license. 
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Field Description 

DL Restriction 1 NC licensed drivers only. Enter the alpha and/or numeric code that 
corresponds to the Driver License Restriction. 

 L – No Air Brakes 

 S – School Bus Only (duplicates only) 

 0 – None 

 1 – Corrective Lenses 

 2 – 45 mph Speed Limit/No Interstate Highways 

 3 – Daylight Driving Only 

 4 – NC Intrastate Only - CDL 

 5 – Wrecker Only 

 6 – Mobile Home Transport Only 

 7 – Outside Mirror 

 8 – No Tractor Trailers 

 9 – Other – as shown on license 

10 – Accompanied By Driver Licensed For Class Driven 

12 – 6 a.m. Until 8 p.m. Only 

13 – Automatic Transmission 

14 – Passenger Class B + C Only 

15 – Passenger Class C Only 

16 – Limited Learner Permit (Level 1) 

17 – Limited Provisional License (Level 2) 

18 – Motorcycle Learner Permit 

19 – Blood/Alcohol Concentration .04 

20 – Blood/Alcohol Concentration .04/Ignition Interlock 

21 – Blood Alcohol Concentration .00 

22 – Blood/Alcohol Concentration .00/Ignition Interlock 

23 – Ignition Interlock Only 

DL Restriction 2 NOTE: When data is entered in the DL Restriction 1 field, this field becomes 
available. 

DL Restriction 3 NOTE: When data is entered in the DL Restriction 2 field, this field becomes 
available. 

DL Restriction 4 NOTE: When data is entered in the DL Restriction 3 field, this field becomes 
available. 
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Field Description 

Driver License 
Restrictions 

NC licensed drivers only. The restrictions entered in the DL Restriction 1, 
DL Restriction 2, DL Restriction 3, and DL Restriction 4 fields populate in this 
field. 

Out-of-state licensed drivers. Enter driver license restrictions. The maximum 
length is 20 characters.  

Driver Last Name Enter the driver’s last name exactly as it appears on the driver license. 

Driver First Name Enter the driver’s first name exactly as it appears on the driver license. 

Driver Middle Name Enter the driver’s middle name exactly as it appears on the driver license. 

Suffix If applicable, select the individual's name suffix. 

Driver Street 
Address 1 

Enter the driver’s street address or rural road number. Post office box numbers 
are not acceptable. The maximum length is 25 characters. Use the Driver 
Street Address 2 field if more room is needed. 

Driver Street 
Address 2 

Use only if the address exceeds the space in Driver Street Address 1. The 
maximum length is 25 characters. 

Driver Address City Enter the driver’s address city. 

Driver Address State Select the driver’s address state or province. 

Driver Address Zip 
Code 

Enter the driver’s address zip code. 

Driver Date of Birth Enter the driver’s date of birth. The age is automatically calculated after the 
date is entered.  

Driver Age The Driver Age field is automatically calculated based on the data entered in 
the Driver Date of Birth and the Accident Date fields. 

Driver Gender Select Male or Female. 

Driver Ethnicity Select the ethnicity of the driver: 

A – Asian 

B – Black 

H – Hispanic 

N – Native American 

O – Other (explain in the narrative) 

U – Unknown 

W – White 

Driver Home Phone Enter the driver’s home phone number, including the area code. 

Driver Work Phone Enter the driver’s work phone number, including the area code. 
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Field Description 

Driver Vision 
Obstruction 

Select what prevented the driver or non-motorist from seeing whether such 
movement(s) could be made in a safe manner. Select one of the following: 

00 – None 

01 – Vehicle window(s) obscured 

02 – Trees, crops, brush, etc. 

03 – Building(s) 

04 – Embankment 

05 – Sign(s) 

06 – Hillcrest 

07 – Parked vehicle(s) 

08 – Vehicle(s) in traffic/moving 

09 – Blinded, headlights 

10 – Blinded, sunlight 

11 – Blinded, other lights 

12 – Other (explain in the narrative) 

13 – Unknown 

Driver Physical 
Condition 

Select the condition of the driver and/or non-motorist at the time of the crash. 
Select one of the following: 

01 – Apparently normal 

02 – Illness 

03 – Fatigue 

04 – Fell asleep, fainted, loss consciousness 

05 – Impairment due to medications, drugs, alcohol 

06 – Medical condition 

07 – Other physical impairment 

08 – Restriction not complied with 

09 – Other (explain in the narrative) 

10 – Unknown 
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Field Description 

Driver Alcohol/Drugs 
Suspected 

Select the investigating police officer’s assessment of whether alcohol or other 
drugs were used by the vehicle driver or non-motorist. Select one of the 
following: 

0 – No 

1 – Yes alcohol, impairment suspected 

2 – Yes alcohol, no impairment detected 

3 – Yes other drugs, impairment suspected 

4 – Yes other drugs, no impairment detected 

5 – Yes alcohol and other drugs, impairment suspected 

6 – Yes alcohol and other drugs, no impairment detected 

7 – Unknown 

Driver Alcohol/Drug 
Test Status 

Select whether or not an alcohol drug test was given. Select one of the 
following: 

0 – No test 

1 – Alcohol test (no drug test) 

2 – Test for other drugs (no alcohol test) 

3 – Alcohol & other drugs test (both alcohol & drug test) 

4 – Test refused 

5 – Unknown 

Driver Test Results Select the driver’s test results: 

0 – No test 

1 – No alcohol or other drugs 

2 – Alcohol (percent BAC or BrAC) 

3 – Other drugs reported 

4 – Contaminated sample/unusable 

5 – Pending 

6 – Unknown 

Test BAC or BrAC Enter the alcohol test results in a two-digit format. Do not enter the decimal. 
Include additional test result information in the narrative. 
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Field Description 

Driver Contributing 
Circumstances 1 

Select the actions of the driver that may have contributed to the crash. Select 
one of the following: 

00 – No contributing circumstances indicated 

01 – Disregarded yield sign 

02 – Disregarded stop sign 

03 – Disregarded other traffic signs 

04 – Disregarded traffic signals 

05 – Disregarded road markings 

06 – Exceeded authorized speed limit 

07 – Exceeded safe speed for conditions 

08 – Failure to reduce speed 

09 – Improper turn 

10 – Right turn on red 

11 – Crossed centerline/going wrong way 

12 – Improper lane change 

13 – Use of improper lane 

14 – Overcorrected/oversteered 

15 – Passed stopped school bus 

16 – Passed on hill 

17 – Passed on curve 

18 – Other improper passing 

19 – Failed to yield right of way 

20 – Inattention 

21 – Improper backing 

22 – Improper parking 

23 – Invalid entry (not used in TraCS) 

24 – Improper or no signal 

25 – Followed too closely 

26 – Operated vehicle in erratic, reckless, careless, negligent, or aggressive 
manner 

27 – Swerved or avoided due to wind, slippery surface, vehicle, object, non-
motorist 

28 – Visibility obstructed 
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Field Description 

Driver Contributing 
Circumstances 2 

29 – Operated defective equipment 

30 – Alcohol use 

31 – Drug use 

32 – Other (explain in the narrative) 

33 – Unable to determine 

35 – Driver distracted by electronic communication device (cell phone, texting, 
etc.) 

36 – Driver distracted by other electronic device (navigation device, DVD 
player, etc.) 

37 – Driver distracted by other inside the vehicle 

38 – Driver distracted by external distraction (outside the vehicle) 

34 – Unknown 

NOTE: When data is entered in the Driver Contributing Circumstances 1 
field, this field becomes available. 

Driver Contributing 
Circumstances 3 

NOTE: When data is entered in the Driver Contributing Circumstances 2 
field, this field becomes available. 

Non-Motorist 
Contributing 
Circumstances 1 

Select the non-motorist contributing events, circumstances, or actions which 
may have contributed to the crash: 

00 – None 

01 – Coming from behind parked vehicle 

02 – Darting 

03 – Lying and/or illegally in roadway 

04 – Failure to yield right of way 

05 – Not visible (dark clothing, etc.) 

06 – Inattentive (talking, eating, etc.) 

07 – Failure to obey traffic signs, signal 

08 – Wrong side of road 

09 – Other (explain in the narrative) 

10 – Unknown 

Non-Motorist 
Contributing 
Circumstances 2 

NOTE: When data is entered in the Non-Motorist Contributing 
Circumstances 1 field, this field becomes available. 
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Vehicle Fields 

Figure 83 shows the fields in the Vehicle section of the Unit group. Table LL describes the 
fields. 

 

Figure 83. Unit Group – Vehicle Section 
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Table LL. Vehicle Fields 

Field Description 

License Plate State Select the state in which the license plate was issued. 

License Plate 
Number 

Enter the license plate number exactly as displayed on the registration plate or 
tag affixed to the vehicle. For combination trucks, the vehicle plate number is 
obtained from the power unit or tractor. If no vehicle plate exists (for example, 
military or postal vehicles), refer to the vehicle registration document or other 
forms of identification. 

NC registered vehicles only. The license plate number can be used to access 
registration records by searching through the NC Vehicle Registration 
database. See “Searching for Vehicle Registration Records (NC Registered 
Vehicles Only)” on page 3-14 for instructions. 

License Plate Year Enter the year that the license plate was valid. 

VIN Number Enter the vehicle identification number (VIN) which may be found on or near the 
left front door post, or on or near the firewall and on the registration card. To 
insure accuracy, enter the number and check it in reverse order. 

NC registered vehicles only. The VIN number can be used to access 
registration records by searching through the NC Vehicle Registration 
database. See “Searching for Vehicle Registration Records (NC Registered 
Vehicles Only)” on page 3-14 for instructions. 

Vehicle Year Enter the model year of the vehicle. 

Vehicle Make Enter the make of the vehicle (for example, Ford, Lexus, or Nissan). 
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Field Description 

Vehicle Style Type Select the style or type of vehicle: 

01 – Passenger Car 

02 – Pickup 

03 – Light truck (minivan, panel) 

04 – Sport Utility 

05 – Van 

06 – Commercial bus 

07 – School bus 

08 – Activity bus 

09 – Other bus 

10 – Single unit truck (2-axle, 6-tire) 

11 – Single unit truck (3 or more axles) 

12 – Truck/trailer 

13 – Truck/tractor (for example, bobtail) 

14 – Tractor/semi-trailer 

15 – Tractor/doubles 

16 – Unknown heavy truck 

17 – Taxicab 

18 – Farm equipment 

19 – Farm tractor 

20 – Motorcycle 

21 – Moped 

22 – Motor scooter or motor bike 

23 – Pedal cycle 

24 – Pedestrian 

25 – Motor home/recreational vehicle 

26 – Other (explain in the narrative) 

27 – All Terrain Vehicle (ATV) 

28 – Fire truck 

29 – EMS Vehicle, Ambulance, Rescue Squad 

30 – Military 

31 – Police 

32 – Unknown 

Is there insurance on 
this vehicle? 

Select Yes when the insurance company or policy number is available for this 
vehicle. If there is no insurance, select No. If information is unknown, select 
Unknown. 
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Field Description 

Vehicle Insurance 
Company 

Enter the insurance company name for the vehicle involved in the collision. 

NOTE: This field becomes available when Yes is selected in the Is there 
insurance on this vehicle? field.  

Vehicle Insurance 
Policy Number 

Enter the insurance policy number. 

NOTE: This field becomes available when data is entered in the Vehicle 
Insurance Company field. 

Vehicle Drivable Select Yes if the vehicle was drivable. Select No if the vehicle was not drivable. 

Vehicle Seizure 
(DWI) 

Select Yes if the vehicle is a DWI seizure. Select No if the vehicle was not 
seized. 

Vehicle was 
Traveling/Parked 

Select Traveling or Parked Facing to indicate whether the vehicle was parked. 

IMPORTANT: For parked vehicles, the best approach is to leave all the fields 
empty in the Driver section. If partial information is entered, the system 
requires all information to be entered. Any information about the driver should 
be entered in the Narrative section. 

The following are mandatory fields for the Driver section (leave all others 
empty): 

 Unit Type: Choose Appropriate Unit Type (1, 4, or 5) 

 Driver Contributing Circumstances 1: 0 or other appropriate field 

For the Vehicle section, fill in all the information like any other unit. Select 
Parked Facing for the Vehicle was Traveling/Parked field. 

NOTE: You do not need a Person group for a parked unit (unless there were 
passengers in it), although you will receive a warning when validating the 
NCCRF. 

Parked vehicle with person in the driver seat. Follow the above instructions 
and do not enter any information in the Driver section. Add a Person group for 
this Unit and enter all the information and make sure the following fields are set: 

 Person Type: 2 – Passenger 

 Seating: 01 – Front Left 

Direction Select the traveling or parked direction. Select one of the following: 

E – East 

N – North 

NE – Northeast 

NW – Northwest 

S – South 

SE – Southeast 

SW – Southwest 

W – West 
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Field Description 

Road Class Select the highest classification of the road or street the vehicle was traveling or 
parked. Select one of the following: 

I – Interstate route 

LCL – Local 

NC – NC numbered route 

PP – Private road, property or driveway 

PVA – Public vehicular area 

SR – Secondary road 

UNK – Unknown 

US – US numbered route 

Road Name Enter the route number, road name or street name of the road. If the street 
does not have a route number, use the city street name. 

Road Type Select one of the following road types: 

No special type 

ALT – alternate 

BUS – business 

P – Bypass 

NOTE: Road type is optional and can be entered when the Road Class is US, 
NC, or Interstate. 
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Field Description 

Points of Initial 
Contact 

Select points of initial contact. A maximum of five can be selected. If contacts 
overlap areas, more than one number should be recorded. 

For back distributed impact on an automobile, select 14, 15, or 16. Points of 
initial contact consists of parts which the vehicle first contacts, not secondary. 

00 – Pedestrians & Non-Contact Vehicle (that remained on the scene) 

1 thru 21 – Vehicle (Passenger Cars/Small Trucks) 

 

22 thru 24 – Vehicle (Underneath) 

 

1 thru 25 and 31 thru 40 – Vehicle (Tractor-Trailers) 

 

27 thru 30 and Motorcycles, Bicycles, and Mopeds 

 

25 –Vehicle rolled over and it is impossible to determine initial impact 

26 – Unknown 

00 – No contact (for example, fell from moving vehicle) 

22 24 

23 

Front Rear 

Front Rear 
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Field Description 

TAD 1 The traffic accident damage (TAD). Select the area of the vehicle that was 
damaged in the collision. Complete TAD 2, Severity 2 and TAD 3, Severity 3 
fields if needed to describe additional areas and severity of vehicle damage. 

Severity 1 NOTE: This field becomes available when data is entered in the TAD 1 field. 

Select the severity of the damage to the vehicle for TAD 1 area using a scale of 
0 to 7 with 0 being no damage and 7 being the most damage.  

TAD 2 NOTE: This field becomes available when data is entered in the Severity 1 
field. 

Select the second area of the vehicle that was damaged in the collision. 

Severity 2 NOTE: This field becomes available when data is entered in the TAD 2 field. 

Select the severity of the damage to the vehicle for the TAD 2 area using a 
scale of 0 to 7 with 0 being no damage and 7 being the most damage. 

TAD 3 NOTE: This field becomes available when data is entered in the Severity 2 
field. 

Select the third area of the vehicle that was damaged in the collision. 

Severity 3 NOTE: This field becomes available when data is entered in the TAD 3 field. 

Select the severity of the damage to the vehicle for the TAD 3 area using a 
scale of 0 to 7 with 0 being no damage and 7 being the most damage.  

Estimated Damage Enter a dollar estimate (up to 7 digits, numbers only) of the cost to restore the 
vehicle to its condition just prior to the collision or an estimate of the value of 
the vehicle before the crash – whichever is less. For a totaled vehicle, enter a 
dollar estimate of the retail value of the vehicle prior to the crash. 

Vehicle Towed By Enter the name and location of the towing company. The maximum length is 
50 characters. 

NOTE: When No is selected for the Vehicle Drivable field, this field becomes 
available. 

Vehicle Towed To 
Same as Towed By 

Select Yes if the towed to is the same as the towed by business and location. 

Vehicle Towed To Enter the towed to name and location. The maximum length is 50 characters. 
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Field Description 

Vehicle 
Maneuver/Action 

Select the vehicle maneuver action, in the investigating officer’s opinion, just 
prior to the crash. Select one of the following: 

01 – Stopped in travel lane (driver still in vehicle) 

02 – Parked out of travel lanes 

03 – Parked in travel lanes 

04 – Going straight ahead 

05 – Changing lanes or merging 

06 – Passing 

07 – Making right turn 

08 – Making left turn 

09 – Making U turn 

10 – Backing 

11 – Slowing or stopping 

12 – Starting in roadway 

13 – Parking 

14 – Leaving parked position 

15 – Avoiding object in road 

16 – Other (explain in the narrative) 

Non-Motorist Action Select the non-motorist action just prior to the crash: 

1 – Entering or crossing specified location 

2 – Walking, riding, running/jogging with traffic 

3 – Walking, riding, running/jogging against traffic 

4 – Working 

5 – Pushing vehicle 

6 – Approaching or leaving vehicle 

7 – Playing 

8 – Standing 

9 – Other (explain in the narrative) 
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Field Description 

Non-Motorist 
Location Prior to 
Impact 

Select the non-motorist location just prior to the crash: 

01 – Marked crosswalk at intersection 

02 – At intersection but no crosswalk 

03 – Non-intersection crosswalk 

04 – Driveway access crosswalk 

05 – In roadway 

06 – Not in roadway 

07 – Median (but not on shoulder) 

08 – Island 

09 – Shoulder 

10 – Sidewalk 

11 – Within 10 feet of roadway (not on shoulder, median, sidewalk, island) 

12 – Beyond 10 feet of roadway (within trafficway) 

13 – Outside trafficway 

14 – Shared-use path or trails 

First Harmful Event 
for this unit 

Select the first harmful event in a continuous series of events which resulted in 
damage or personal injury. For example, if a vehicle runs off the roadway to the 
right, returns to the roadway out of control, and runs head-on into another 
motor vehicle, select 01 – Ran off road right as the first harmful event. Select 
one of the following: 

00 – Unknown 

01 – Ran off road right 

02 – Ran off road left 

03 – Ran off road straight ahead 

04 – Jackknife 

05 – Overturn/rollover 

06 – Crossed centerline/median 

07 – Downhill runaway 

08 – Cargo/equipment loss or shift 

09 – Fire/explosion 

10 – Immersion 

11 – Equipment failure (tires, brakes, etc.) 

12 – Separation of units 

13 – Other non-collision (include in the narrative) 

14 – Pedestrian 

15 – Pedalcyclist 

16 – Railway vehicle (train, engine) 
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Field Description 

17 – Animal 

18 – Movable object (explain in the narrative) 

20 – Parked motor vehicle 

21 – Rear end, slow or stop 

22 – Rear end, turn 

23 – Left turn, same roadway 

24 – Left turn, different roadways 

25 – Right turn, same roadway 

26 – Right turn, different roadways 

27 – Head on 

28 – Sideswipe, same direction 

29 – Sideswipe, opposite direction 

30 – Angle 

31 – Backing up 

32 – Other collision with vehicle (explain in the narrative) 

33 – Tree 

34 – Utility pole (with or without light) 

35 – Luminaire pole (non-breakaway) 

36 – Luminaire pole (breakaway) 

37 – Official highway sign (non-breakaway) 

38 – Official highway sign (breakaway) 

39 – Overhead sign support 

40 – Commercial sign 

41 – Guardrail end on shoulder 

42 – Guardrail face on shoulder 

43 – Guardrail end in median 

44 – Guardrail face in median 

45 – Shoulder barrier end (non-guardrail) 

46 – Shoulder barrier face (non-guardrail) 

47 – Median barrier end (non-guardrail) 

48 – Median barrier face (non-guardrail) 

49 – Bridge rail end 

50 – Bridge rail face 

51 – Overhead part of underpass 

52 – Pier on shoulder or underpass 

53 – Pier in median of underpass 
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Field Description 

54 – Abutment (supporting wall) of underpass 

55 – Traffic island curb or median 

56 – Catch basin or culvert on shoulder 

57 – Catch basin or culvert in median 

58 – Ditch 

59 – Embankment 

60 – Mailbox 

61 – Fence or fence post 

62 – Construction barrier 

63 – Crash cushion 

64 – Other fixed object (explain in the narrative) 

NOTE: An entry for “19” is purposely absent from the above list. 

Second Harmful 
Event for this unit 

NOTE: When data is entered in First Harmful Event field, this field becomes 
available. 

Select the second harmful event for this unit. 

Third Harmful Event 
for this unit 

Select the third harmful event for this unit. 

NOTE: When data is entered in Second Harmful Event field, this field 
becomes available. 

Fourth Harmful 
Event for this unit 

Select the fourth harmful event for this unit. 

NOTE: When data is entered in Third Harmful Event field, this field becomes 
available. 

Most Harmful Event 
for this unit 

Select the most harmful event for this unit. 

Distance/Direction to 
Object Struck 

Select the distance and direction from the road to the object struck. Select one 
of the following: 

00 – None 

01 – In road 

02 – Right of road, 0-10 ft 

03 – Right of road, 11-30 ft 

04 – Right of road, over 30 ft 

05 – Left of road, 0-10 ft 

06 – Left of road, 11-30 ft 

07 – Left of road, over 30 ft 

08 – Straight ahead, 0-10 ft 

09 – Straight ahead, 11-30 ft 

10 – Straight ahead, over 30 ft 
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Field Description 

Vehicle 
Underride/Override 

An underride refers to a vehicle sliding under another vehicle during a crash. 
An override refers to a vehicle riding up over another vehicle. Select one of the 
following: 

1 – Underride 

2 – Override 

3 – Neither underride or override 

4 – Unknown 

Vehicle Defects 1 Select the appropriate code for each vehicle. If 6 – Other defects is selected, 
describe in the Narrative. 

0 – None detected 

1 – Brakes 

2 – Headlights 

3 – Rear lights 

4 – Steering 

5 – Tires 

6 – Other defects (include in narrative) 

7 – Unknown 

Vehicle Defects 2 Select the appropriate code for each vehicle. If 6 – Other defects is selected, 
describe in the Narrative. 

Authorized Speed 
Limit 

Enter the authorized speed limit for the vehicle at the time of the crash. The 
authorization may be indicated by the posted speed limit, blinking sign at 
construction zones or restricted speed for permitted vehicles. 

Estimate of Original 
Traveling Speed 

Enter the estimated speed in miles per hour. The estimate reflects the speed of 
the vehicle the moment the driver initially perceived an existing hazard. 

Estimate of Speed at 
Impact 

Enter the estimated speed in miles per hour at the moment of impact. 

Tire Impressions 
Before Impact 

Enter length in feet of the tire impressions, skid marks, tire print yaw. 

Distance Traveled 
After Impact 

Enter the distance in feet traveled after impact as a result of the force of the 
collision. 
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Field Description 

Emergency Vehicle 
Use 

Select the emergency vehicle involved in the crash. Emergency vehicle refers 
to a vehicle that is traveling with emergency signals in use, such as flashing 
blue or red lights or a siren sounding. 

NOTE: DOES NOT apply to a vehicle responding to the crash. 

1 – Fire truck 

2 – EMS Vehicle, Ambulance, Rescue Squad, etc. 

3 – Military 

4 – Police 

5 – Other 

Post-Crash Fire Select Yes if there is a fire after the crash involving this unit. 

School Bus Contact 
Vehicle 

Select Yes when the unit is a school bus and is directly involved in the crash as 
a contact vehicle.  

School Bus Non-
Contact Vehicle 

Select Yes when the unit is a school bus and is indirectly involved in the crash 
as a non-contact vehicle.  

 

Owner Fields 

Figure 84 shows the fields in the Owner section of the Unit group. Table MM describes the 
fields. 

 

Figure 84. Unit Group – Owner Fields 
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Table MM. Owner Fields 

Field Description 

Owner Same as 
Driver 

Select Yes if the owner is the same as the driver. Driver information is copied 
to owner data fields. 

Address Same As 
Driver 

Select Yes if the owner’s address is the same as the driver’s address. Driver 
address is copied to the owner’s address data fields. 

Owned by Company Select Yes if the vehicle is owned by a business. When the owner is a 
business, the Company Name fields become available and the Last Name, 
First Name, and Suffix data fields become disabled. 

Owner Company 
Name 

Enter the company’s name. The maximum length is 72 characters. 

Owner Last Name Enter the vehicle owner’s last name as it appears on the vehicle registration or 
other legal documentation. 

Owner First Name Enter the vehicle owner’s first name as it appears on the vehicle registration or 
other legal documentation. 

Owner Middle Name Enter the vehicle owner’s middle name as it appears on the vehicle registration 
or other legal documentation. 

Suffix If applicable, select the individual's name suffix. 

Owner Street 
Address 1 

Enter the owner’s street address or rural road number. The maximum length is 
25 characters. Use the Owner Street Address 2 field if more room is needed. 

Owner Street 
Address 2 

Use only if the address exceeds the space in Owner Street Address 1. The 
maximum length is 25 characters. 

Owner Address City Enter the owner’s address city.  

Owner Address State Select the owner’s address state.  

Owner Address Zip 
Code 

Enter the owner’s address zip code. 
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Trailer Information Fields 

Figure 85 shows the fields in the Trailer Information section of the Unit group. Table NN 
describes the fields. 

 

Figure 85. Unit Group – Trailer Information Section 

Table NN. Trailer Information Fields 

Field Description 

Vehicle Trailer Type If this vehicle was pulling a trailer, select the appropriate trailer type: 

00 – No trailer (default) 

Non-Semi-Trailers 

01 – Boat 

02 – Camper 

03 – Utility 

04 – Horse 

05 – House trailer (mobile home) 

06 – Towed vehicle 

07 – Other non-semi 

Semi-Trailers 

08 – Tanker 

09 – Enclosed van 

10 – Flatbed or platform 

11 – Other semi-trailer 

12 – Double trailer 

First Trailer No. Axles Enter the number of axles for the first trailer. If the trailer is a semi-trailer, 
only the axles under the first trailer are recorded. 

First Trailer Width (in) Enter the actual width of the first trailer in inches. 

First Trailer Length (ft) Enter the actual length of the first trailer in feet. 

Second Trailer No. 
Axles 

Enter the number of axles for the second trailer. If the trailer is a semi-trailer, 
only the axles under the second trailer are recorded.  
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Field Description 

Secord Trailer 
Width (in) 

Enter the actual width of the second trailer in inches. 

Second Trailer 
Length (ft) 

Enter the actual length of the second trailer in feet. 

Overwidth Permit Enter the overwidth permit number. Overwidth trailers may be carrying 
special equipment. Overwidth mobile homes include 12 ft, 14 ft, and 16 ft 
width variations. 

 

Carrier Fields 

Carrier fields become available when 4-Commercial is selected as the Unit Type, as shown 

Figure 86. Table OO describes the fields. 

 

Figure 86. Unit Group – Carrier Section 

Table OO. Carrier Fields 

Field Description 

Carrier Same as 
Owner 

Select Yes when the carrier owner and the vehicle owner are the same. The 
vehicle owner information is copied to the carrier owner data input fields. 

Carrier Name Enter the name of the motor carrier company from the first available source 
(vehicle side, shipping papers, or driver). 

Carrier Street 
Address 1 

Enter the carrier’s street address or rural road number. The maximum length is 
25 characters. Use the Carrier Street Address 2 field if more room is needed. 

 

NOTE: See Chapter 5: “Commercial Motor Vehicles” for additional requirements and 
steps for completing carrier-related fields. i
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Field Description 

Carrier Street 
Address 2 

Use only if the address exceeds the space in Carrier Street Address 1. The 
maximum length is 25 characters. 

Carrier Address City Enter the carrier’s address city. The maximum length is 22 characters. 

Address State Select the carrier’s address state. 

Carrier Zip Code Enter the carrier’s address zip code. 

Carrier Source of 
Data 

Select the source of the carrier information: 

1 – Truck 

2 – Shipping papers 

3 – Driver 

Cargo Body Type Select the cargo body type: 

01 – Bus (seats for 16 or more, including driver) 

02 – Bus (seats for less than 16, including driver) 

03 – Van/enclosed box 

04 – Grain/chips/gravel truck 

05 – Pole truck 

06 – Cargo tank 

07 – Flatbed 

08 – Dump 

09 – Concrete mixer 

10 – Auto transporter 

11 – Garbage/refuse 

12 – Log truck 

13 – Other (explain in the narrative) 

14 – Intermodal cargo container 

US DOT Number If available, enter the six-digit USDOT number. If the number is not available, 
enter the state and state number of the carrier. 

NOTE: The USDOT number can be used to access carrier records. See 
“Searching for Commercial Carrier Records” on page 3-17 for instructions. 

ICC Number If available, enter the carrier’s ICC number. If the number is not available, enter 
the state and state number of the carrier. 

Carrier Axles Enter the total number of axles on the truck or bus. Include the axles on the 
truck semi-trailers and trailers. 

Carrier State Select the carrier’s state of business. 
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Field Description 

State Number Enter the carrier’s state identification number. The maximum length is 
12 characters. 

IFTA Number Enter the carrier’s International Fuel Tax Agreement (IFTA) number contained 
on the vehicle registration or cab card. 

FEI Number Enter the carrier’s Federal Employee Identification (FEI) number contained on 
the vehicle registration or cab card. 

Carrier Fleet # Enter the carrier’s Fleet number contained on the vehicle registration or cab 
card. 

Gross Vehicle 
Weight Rating 

Enter the manufacturer’s gross vehicle weight rating (GVWR). 

 

Hazardous Materials Fields 

Figure 87 shows the fields in the Hazardous Materials section of the Unit group. Table PP 
describes the fields. 

 

Figure 87. Unit Group – Hazardous Materials Section 

Table PP. Hazardous Materials Fields 

Field Description 

Hazardous Material 
Involvement? 

Select Yes whenever the unit has explosives; dissolved, refrigerated, or 
compressed gasses; flammable liquid; flammable solids (combustible or water 
reactive); oxidizing substances (organic peroxides); poisonous (toxic) and 
infectious substances; radioactive material; corrosive; or miscellaneous 
dangerous goods involved. 

Hazardous Material 
Placard Exists 

Select Yes if a hazardous materials placard exists.  

Hazardous Cargo 
Released 

Select Yes if hazardous materials were released. This does not include fuel 
from the tank. 

Carrying Hazardous 
Material 

Select Yes if the carrier is carrying hazardous materials. 
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Field Description 

4-Digit Placard 
Number 

If available, enter the 4-digit placard number from the diamond or box. 

1-Digit Placard 
Number 

Select the 1-digit hazardous placard number: 

1 – Explosives 

2 – Gases – Compressed, Dissolved, or Refrigerated 

3 – Flammable Liquid 

4 – Flammable Solids – Combustible, Water reactive 

5 – Oxidizing Substances – Organic Peroxides 

6 – Poisonous (Toxic) and Infectious Substances 

7 – Radioactive Material 

8 – Corrosives 

9 – Miscellaneous Dangerous Goods 

Hazardous Material 
Name 

Enter the hazardous material name when the hazardous placard information is 
not available. 
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Person Group 

The Person group is a recurring group used to collect information on all people associated with 
each unit involved in the crash. Figure 88 shows the fields in the Persons group. Table QQ 
describes the fields. 

See “Adding a Recurring Group” on page 3-9 for instructions on how to add another Person 
group to the form. 

 

Figure 88. Person Group 
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Table QQ. Person Group Fields 

Field Description 

Unit Number Enter the unit number the person is associated with. 

Person Type Select the person type: 

1 – Driver 

2 – Passenger 

Non-Motorist 

3 – Pedestrian 

4 – Pedalcyclist 

5 – Roller skater, rollerblader, etc. 

6 – Other (explain in the narrative) 

7 – Unknown 

NOTE: If Driver is selected and the Unit Type is Vehicle or Commercial, the 
driver’s demographic information is copied from the Unit group to the Person 
group. 

Same Address as 
Drivers? 

Select Yes when the person’s address is the same as the driver’s address. 

Last Name Select or enter the person’s last name. The maximum length is 25 characters. 

First Name Enter the person’s first name. The maximum length is 20 characters. 

Middle Name Enter the person’s middle name. The maximum length is 20 characters. 

Suffix If applicable, select the individual's name suffix. 

Address 1 Enter the person’s street address or rural road number. The maximum length is 
25 characters. Use the Address 2 field if more room is needed. 

Address 2 Use only if the address exceeds the space in Address 1. The maximum length 
is 25 characters. 

City Enter the person’s address city. 

State Select the person’s address state. 

Zip Code Select the person’s address zip code. 

Phone Number Enter the person’s phone number, including the area code. 

Date of Birth Enter the date of birth for each person involved in the crash. If the date of birth 
is not available, enter the approximate age of the person. 

Age The Age field automatically populates when the date of birth is entered. 

Gender Select Female, Male, or Unknown. 
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Field Description 

Ethnicity Select the person’s ethnicity: 

A – Asian 

B – Black 

H – Hispanic 

N – Native American 

O – Other (explain in the narrative) 

U – Unknown 

W – White 

Seating Select the location of this occupant in, on, or outside of the motor vehicle prior 
to the crash impact: 

01 – Front-left (Driver, motorcycle driver) 

02 – Front-middle 

03 – Front-right 

04 – Second seat-left (motorcycle passenger) 

05 – Second seat-middle 

06 – Second seat-right 

07 – Third row-left (motorcycle passenger) 

08 – Third row-middle 

09 – Third row-right 

10 – Sleep section of cab (truck) 

11 – Passenger in other enclosed area 

12 – Passenger in enclosed area (pickup) 

13 – Trailing Unit 

14 – Riding on vehicle exterior 

15 – Unknown 
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Field Description 

Occupant Non-
Motorist Protection 

Select the occupant protection or non-motorist protection used by the person 
involved in the crash: 

00 – None used 

01 – Lap belt only 

02 – Shoulder and lap belt 

03 – Shoulder belt only 

04 – Child restraint 

05 – Helmet (motorcycle or non-motorist) 

Codes 6-8 for non-motorist only 

06 – Protective pads 

07 – Reflective clothing 

08 – Lighting 

09 – Other (explain in the narrative) 

10 – Unable to determine 

Air Bag Deployment Select the deployment status of an airbag, relative to each specific occupant: 

0 – No Air bag(s) 

1 – Not deployed 

2 – Deployed front 

3 – Deployed side 

4 – Deployed both front and side 

5 – Unknown 

Air Bag Switch 
Status 

Select the air bag switch status: 

0 – No On/Off switch 

1 – Switch in On position 

2 – Switch in Off position 

3 – Unknown if switch is present 

4 – Unknown position in vehicle 

Trapped Status Select the trapped status of the person: 

1 – Yes 

2 – No 

3 – Unknown 
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Field Description 

Ejection Status The ejection status indicates the location of the occupant’s body as being 
completely or partially thrown from the vehicle as a result of the crash. Select 
one of the following: 

1 – Not ejected 

2 – Totally ejected 

3 – Partially ejected 

4 – Unknown 

Injury Status Select the injury status that indicates the most severe injury to the person 
involved in the crash: 

1 – Killed 

2 – A type injury (disabling) 

3 – B type injury (evident) 

4 – C type injury (possible) 

5 – No injury 

6 – Unknown 

EMS Name Enter the name of the Emergency Medical Service (EMS) unit. The maximum 
length is 50 characters. 

When a name is entered, the Treatment Facility Name, Treatment Facility 
City, and Treatment Facility State fields become available. 

Treatment Facility 
Name 

Enter the destination treatment facility name where the injured person is being 
taken. 

Treatment Facility 
City 

Enter the treatment facility city or town. 

Treatment Facility 
State 

Select the state the treatment facility is located. 
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Diagram Group 

The Diagram group (shown in Figure 89) is used to enter a diagram of the crash scene. Two 
drawing programs are available in TraCS: Easy Street Draw (ESD) and TraCS Diagram Tool. 
See “Creating a Diagram” on page 3-20 for diagram instructions and requirements. 

 

Figure 89. Diagram Group 
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Narrative Group 

The Narrative is a written description of the crash entered directly into TraCS. The Narrative 
group is shown in Figure 90. See “Entering a Narrative” on page 3-28 for instructions on 
completing the narrative. 

 

Figure 90. Narrative 
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Supervisor’s Rejection Reason 

The supervisor’s rejection reason follows the Narrative section on the form. The Reject Reason 
field (shown in Figure 91) is blank when initialized and only displays data if reviewing a rejected 
crash report from a supervisor. See “Rejecting the Form” on page 3-46 for instructions on how 
to reject a form (supervisors only). 

 

Figure 91. Reject Reason 

Property Damage Group 

The Property Damage group (shown in Figure 92) is a recurring group used to collect 
information regarding all property damage caused by the crash (excluding vehicle damage).  

See “Adding a Recurring Group” on page 3-9 for instructions on how to add another Property 
Damage group to the form. 

 

Figure 92. Property Damage Group 
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Table RR. Property Damage Group Fields 

Field Description 

Non-Vehicle Property 
Damage Text 

Enter any property, other than motor vehicles and their loads, that was 
damaged. Damage to signs, buildings, mailboxes, fences, etc. should be 
entered here. 

NOTE: Using more than 25 characters may result in the field being illegible. 
If additional space is required, add an additional Property Damage group. 

This information must be entered before continuing with the rest of the 
Property Damage group. 

State Owned? Select Yes if the damaged property is state owned. 

Property Damage 
Estimate 

Enter an estimated value of the additional property damage. 

Company Owned? Select Yes if the additional property damage is owned by a company. 

Company Name Enter the company name of the additional property damage owner. 

Last Name Enter property damage owner’s last name. 

First Name Enter property damage owner’s first name. The maximum length is 
20 characters. 

Middle Name Enter property damage owner’s first name. The maximum length is 
20 characters. 

Suffix If applicable, select the individual's name suffix. 

Street Address 1 Enter the property damage owner’s street address or rural road number. The 
maximum length is 25 characters. Use the Street Address 2 field if more 
room is needed. 

Street Address 2 Use only if the address exceeds the space in Street Address 1. The 
maximum length is 25 characters. 

City Enter the property damage owner’s address city. 

State Select the property damage owner’s address state. 

Zip Code Enter the property damage owner’s address zip code. 

Property Damage 
Owner Phone Number 

Enter property damage owner’s phone number including the area code. 

Property Damage Unit 
Number 

Enter the striking vehicle unit number. 
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Witness Group 

The Witness group (shown in Figure 93) is a recurring group used to collect information 
regarding all witnesses to the crash. 

 

Figure 93. Witness Group 

In the Witness group, information must be entered in the Last Name field before continuing with 
the rest of the section. Identify any reliable witnesses who may be of help in future investigation 
by recording their information here. 

See “Adding a Recurring Group” on page 3-9 for instructions on how to add another Witness 
group to the form. 

Table SS. Witness Group Fields 

Field Description 

Last Name Enter the witness’ last name. The maximum length is 25 characters. 

First Name Enter the witness’ first name. The maximum length is 20 characters. 

Middle Name Enter the witness’ middle name. The maximum length is 20 characters. 

Suffix If applicable, select the individual's name suffix. 

Street Address 1 Enter the witness’ street address or rural road number. The maximum length is 
25 characters. Use the Street Address 2 field if more room is needed. 

Street Address 2 Use only if the address exceeds the space in Street Address 1. The maximum 
length is 25 characters. 

City Enter the witness’ address city. 

State Select the witness’ address state. 

Zip code Enter the witness’ address zip code. 

Phone Number Enter the witness’ phone number, including the area code. 
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Violation Group 

The Violation group (shown in Figure 94) is a recurring group used to enter information 
regarding any traffic violations incurred by persons involved in the crash. 

 

Figure 94. Violation Group 

In the Violation group, information must be entered in the Last Name field before continuing with 
the rest of the section. Enter the names of any person charged with a traffic violation, and the 
charges preferred. Violation numbers are optional. 

See “Adding a Recurring Group” on page 3-9 for instructions on how to add another Violation 
group to the form. 

Table TT. Violation Group Fields 

Field Description 

Last Name Enter the violator’s last name. The maximum length is 25 characters. 

First Name Enter the violator’s first name. The maximum length is 20 characters. 

Middle Name Enter the violator’s first name. The maximum length is 20 characters. 

Suffix If applicable, select the individual's name suffix. 

Violation Description Enter a description of the violation.  

Violation Number Enter the violation number. 

Violation Unit Number Enter the vehicle unit number the violation is associated. 

 

NOTE: The Violation group is for agency information only and is printed on the 
North Carolina DMV-349 form. i
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DMV Validation Messages 

If the NCDMV Traffic Records Communication System (TRCS) rejects a form, the rejection 
reason (or reasons) display in the DMV Validation Messages group. 

The DMV Validation Messages field (shown in Figure 95) remains blank when initialized and 
only displays data when viewing a rejected crash report from NCDMV. There can be multiple 
rejection messages, one for each exception encountered by TRCS. 

 

Figure 95. DMV Validation Messages 

 



 

 5-1 

Chapter 5: Commercial Motor Vehicles 
(CMVs) 

This chapter provides the requirements and steps for completing the UNIT group section of the 
NCCRF when the unit is a commercial motor vehicle. 

Commercial Motor Vehicle Definition 

North Carolina defines a commercial motor vehicle (CMV) as a motor vehicle or combination of 
motor vehicles used in commerce to transport passengers or property if the motor vehicle: 

1. Has a gross combination weight rating of 10,001 or more pounds inclusive of a towed unit; 
or 

2. Is designed to transport 16 or more passengers, including the driver; or 

3. Is of any size and is used in the transportation of materials found to be hazardous for the 
purposes of the Hazardous Materials Transportation Act and which require the motor 
vehicle to be placarded under the Hazardous Materials Regulations (49 CFR Part 172, 
Subpart F). 

The Federal Motor Carrier Safety Administration (FMCSA) defines a CMV as any self-propelled 
or towed motor vehicle used on a highway in interstate commerce to transport passengers or 
property when the vehicle: 

1. Has a gross vehicle weight rating or gross combination weight rating, or gross vehicle 
weight or gross combination weight of 4,536 kg (10,001 pounds) or more, whichever is 
greater; or 

2. Is designed or used to transport 9 or more people (including the driver) for compensation; 
or 

3. Is designed or used to transport more than 15 passengers, including the driver, and is not 
used to transport passengers for compensation; or 

4. Is used in transporting material found by the Secretary of Transportation to be hazardous 
under 49 U.S.C. 5103 and transported in a quantity requiring placarding under regulations 
prescribed by the Secretary under 49 CFR, subtitle B, chapter 1, subchapter C. 
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Carrier Identification 

A motor carrier is defined as a business entity, individual, partnership, corporation, or religious 
organization responsible for the transportation of the goods, property or people: 

 A motor carrier is the legal entity that directs and controls the operation of one or more 
commercial vehicles. 

 A motor carrier can be a trucking company, a bus company or any entity that uses 
vehicles for commercial purposes. 

Table UU describes four different types of motor carriers. 

Table UU. Motor Carrier Types 

Carrier Description 

For Hire A person engaged in the transportation of goods or passengers for compensation. 

Private A person who provides transportation of property or passengers by CMV and is not 
a “for hire” motor carrier. 

Interstate 
Commerce 

Trade, traffic, or transportation in the United States. 

 Between a place in a State and a place outside of such State (including a place 
outside of the U.S.). 

 Between two places in a State through another State or a place outside of the 
U.S. 

 Between two places in a State as part of trade, traffic or transportation originating 
or terminating outside the State or the U.S. 

 Required to have a USDOT number. 

Intrastate 
Commerce 

Used for a carrier that operates entirely within the state. 

Not required to have a USDOT number. 

USDOT numbers in the process of being assigned to Intrastate motor carriers in a 
number of states. 

Should include state two-character abbreviation on the end. For example, USDOT 
1234566NC. 
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Identifying Motor Carriers in Crashes 

Most motor carriers involved in crashes can be identified through a company name and USDOT 
number on the driver's side of the truck tractor or truck. Occasionally, determining the motor 
carrier and recording the important information (USDOT number, carrier name, and address) 
can be difficult. 

The U.S. Department of Transportation created quick reference cards called “Visor Cards.” 
Follow the steps on this card (shown on Figure 96) to identify the motor carrier and USDOT 
number.

 

Figure 96. United States DOT Visor Card – Identify Responsible Carrier 

The back of this card contains the following examples: 

Example 1 

John Smith owns his own truck tractor, operating under John Smith Trucking. Smith 
contracts with White Manufacturing to take one of their trailers loaded with its goods from 
New York to Los Angeles. 

Question: Who is the motor carrier? 

Answer: John Smith is the motor carrier because he is the entity that has agreed to carry 
this load. 
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Example 2 

John Smith, driving his truck tractor, utilizes a cargo broker, K&S Trucking, to obtain goods 
from a shipping company, Intermodal Inc., for his return trip back to New York. 

Question: Who is the motor carrier? 

Answer: John Smith is the motor carrier because K&S Trucking transferred the responsibly 
of the load to John Smith. 

Example 3 

John Smith, driving his truck tractor, leases his services to Polyester Chemical Company. 
Polyester directs Smith to deliver a semi-trailer from New York to St. Louis. 

Question: Who is the motor carrier? 

Answer: The lease agreement between Polyester and Smith makes Polyester the motor 
carrier responsible for the load. 

Example 4 

John Smith is driving a tractor/semi-trailer owned and operated by ABC Trucking. 

Question: Who is the motor carrier? 

Answer: ABC Trucking is the motor carrier. John Smith is just a driver for ABC Trucking. 

Example 5 

John Smith is driving a tractor owned by ABC Trucking which has been leased to XYZ 
Trucking. XYZ uses the tractor to pull XYZ trailers in its regular shipping service. 

Question: Who is the motor carrier? 

Answer: XYZ is the motor carrier because XYZ is directing the carrying of the load. 
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Problems Identifying the Correct Information on Shipping Papers 

The following situations can exist at the crash site: 

 Shipping papers are only required for hazardous material cargo. 

 Driver may say that there are no shipping papers, even when papers may be in the 
vehicle. 

 USDOT number is not available on the shipping papers or the driver's log for the carrier 
responsible for the load. 

The following must display on the outside of a CMV: 

 Legal or a single trade name of the CMV. 

 Motor carrier ID number, preceded by “USDOT.” 

 If the name of any person other than the operating carrier appears, the name of the 
operating carrier must appear and be preceded by “operated by.” 

 Other identifying information may be displayed on the vehicle if it is not inconsistent with 
the information required. 

The following issues make it difficult to identify the motor carrier: 

 Multiple or missing markings on CMVs 

 Leased CMVs (for example, Ryder Transportation Services) 

 Owner operators who lease their vehicles and driving services to other carriers 

 Agents of interstate van lines 



  

 

TraCS 10 User's Guide for Supervisors and Reporters    

5-6 Chapter 5: Commercial Motor Vehicles (CMVs) 

Rented and Leased CMVs 

Trip and long-term leasing can cause the names and numbers on doors to be different from the 
names on the shipping papers (bill of lading). A company can lease a tractor(s) or the owners’ 
services to pull its load with the company's trailer(s). The carrier name and USDOT number on 
the driver's side of the tractor may be for the owner of the tractor(s), not the company 
responsible for the load. (This also applies to leased single-unit trucks.) 

A short-term rental agreement for less than 30 days is required to be inside the vehicle. A 
carrier is required to have the carriers name and USDOT number on the side of the vehicle 
within 30 days of a long-term lease. One problem is that a company can extend a short-term 
(30 days) lease in an effort to keep from adding the company name and USDOT number on the 
vehicle. For example, a business entity rents a truck for 29 days, returns it, and then two days 
later rents the truck again. 

Ryder Transportation Services is an example of a leased CMV. They lease their services to haul 
goods. In this instance, Ryder is the motor carrier and correct information is Ryder’s USDOT 
number, as shown in Figure 97. Each Ryder vehicle has a unique number assigned to each 
vehicle. 

 

Figure 97. United States Department of Transportation Number 

The officer can call Ryder’s regional or national office, provide them with this number and Ryder 
can then provide the officer with information on the company or individual that leased the 
vehicle. 
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Completing Commercial Unit Fields 

The following sections provide the procedures for completing the commercial unit fields on the 
TraCS NCCRF. 

Commercial Driver License (CDL) 

Select Yes in the databar for the Commercial Driver License field to select the check box, as 
shown in Figure 98. 

 

Figure 98. UNIT Group – DRIVER Section – Commercial Driver License Selected 

The CDL classes and the commercial motor vehicles that they authorize the operation of are as 
follows: 

 Class A: Any combination of vehicles with a combined gross vehicle weight rating of 
26,001 pounds or more, if the gross vehicle weight rating of the vehicle or vehicles being 
towed is in excess of 10,000 pounds. 

 Class B: Any single vehicle with a gross vehicle weight rating 26,001 pounds or more or 
any such vehicle towing a vehicle having a gross vehicle weight rating that is not in 
excess of 10,000 pounds. 

 Class C: Any single vehicle, or combination of vehicles, that is not a Class A or Class B 
vehicle, but that either is designed to transport 16 or more passengers, including the 
driver, or is placarded for hazardous materials and any school bus with a gross vehicle 
weight rating of less than 26,001 pounds that is designed to transport fewer than 
16 passengers including the driver. 
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The higher CDL class allows you to drive vehicles in any of the lower classes provided you have 
the correct endorsements. Figure 99 and Figure 100 show visor cards illustrating the 
endorsements, classes, and groups. 

 

Figure 99. United States DOT Visor Card – Commercial Driver’s License Endorsements and Classes 

 

 

Figure 100. United States DOT Visor Card – Commercial Driver’s License Commercial Motor Vehicle Groups 
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There are situations where a person is not required to have a NC CDL. The following are the 
exceptions: 

 Active Duty Military with military licenses operating military vehicles. 

 Firefighters meeting approved training standards and operating authorized emergency 
vehicles. 

 Farmers in certain cases. 

 Individuals operating motor homes or other vehicles used exclusively to transport 
personal possessions or family members, for non-business purposes. 

Endorsements are necessary for the following commercial driving requirements: 

 (T) Double/Triple Trailers. 

 (P) Passenger Vehicles. For vehicles which are designed to carry 16 or more people 
(including the driver); or those which carry 15 or less people (including the driver) 
transporting children to or from school and home regularly for compensation. 

 (N) Tank Vehicles. For vehicles designed to haul liquids or liquefied gases in bulk in 
permanently mounted tanks or portable tanks rated at 1,000 gallons or more. 

 (H) Hazardous Materials. To carry hazardous materials in amounts requiring placards. 

 (X) Endorsement code designating a Tank (N) vehicle that carries Hazardous Materials 
(H). 

Gross Vehicle Weight Rating 

Table VV describes the three vehicle weight ratings. 

Table VV. Vehicle Weight Rating Types 

Rating Description 

Gross Vehicle Weight 
Rating (GVWR) 

The value specified by the manufacturer as the recommended loaded weight 
of a single motor vehicle. 

Gross Combination 
Weight Rating (GCWR) 

The value specified by the manufacturer(s) as the recommended loaded 
weight of a combination (articulated) motor vehicle. This is for truck tractors 
and single-unit trucks pulling a trailer(s). 

Gross Vehicle Weight 
(GVW) 

Used for enforcement purposes. GVW indicates the greater of the 
GVWR/GCWR or the Actual Weight, whichever is higher. 
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Enter the weight in pounds in the Gross Vehicle Weight Rating (GVWR) field (shown in 
Figure 101). 

 

Figure 101. UNIT Group – CARRIER Section – Gross Vehicle Weight Rating Selected 

The GVWR is based on the least carrying weight of the axles, springs, tires, wheels and frame 
and the gross axle weight rating (GVWR) that is applied to each axle. The example in 
Figure 102 shows the GVWR as 46,000 pounds. 

 

Figure 102. Gross Axle Weight Rating – Three Axle Example 

 

NOTE: Since the actual weight of the vehicle is often unknown by the police officer 
investigating the crash, the Federal Motor Carrier Safety Administration (FMCSA) 
uses the GVWR or GCWR for consistency in crash reporting. 

i
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The GVWR specified by the manufacturer can be less than the Gross Axle Weight Rating 
(GAWR) for the front and rear axles combined, as shown in the example in Figure 103. 

 

Figure 103. Front and Rear Gross Axle Weight Rating 

GVWR Label Location 

The weight ratings, including the GVWR, can be found on the certification label located on the: 

 Driver's door or door frame 

 Cab behind driver’s seat 

 Driver-side visor 

 

Front GAWR    4,850 

Rear GAWR     8,250 

Total GAWR   13,100 

GVWR            11,200 

Difference         1,900 lbs 
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A secondary manufacturer can increase the GVWR that the original manufacturer specifies 
when additional equipment is added to the cab-chassis. The secondary manufacturer may add 
a GVWR plate, such as the yellow sticker located on the door frame shown in Figure 104. 

 

Figure 104. Secondary Manufacturer GVWR Plate 

On a trailer, the GVWR is located as shown in Figure 105. 

 

Figure 105. Trailer Certification Label Location 

General GVWR Guidelines for Small Trailers 

 Single-axle utility trailers usually have a GVWR of 3,250 pounds or more. 

 Double-axle utility trailers have a GVWR of 7,500 pounds or more 
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Vehicle Style Type, Cargo Body Type, and Vehicle Trailer Type 

Figure 106 shows a Class A motor home with a towed vehicle. This example employs all three 
field types as described in Table WW. 

 

Figure 106. Class A Motor Home with Towed Vehicle 

Table WW. Selections for Motor Home with Towed Vehicle 

Field Selection 

Vehicle Style Type 25 – Motor home/recreational vehicle* 

Cargo Body Type Leave blank, not a qualifying vehicle 

Vehicle Trailer Type 6 – Towed vehicle 

* A motor home that weighs over 26,001 lbs is classified as a commercial motor vehicle. 

 

Vehicle Style Type 

Select the vehicle style or type from the Vehicle Style Type field (Figure 107) databar list. Use 
the Vehicle Configuration Visor Card (Figure 108) as an aid in selecting the vehicle style type. 
See Table LL on page 4-37 for the list of vehicle style types. 

 

Figure 107. UNIT Group – VEHICLE Section - Vehicle Style Type Field 
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Figure 108. United States DOT Visor Card – Vehicle Configuration 

Cargo Body Type 

Select the cargo body type from the Cargo Body Type field (Figure 109) databar list. Use the 
Cargo Body Type Visor Card (Figure 110) as an aid in determining the type. See Table OO on 
page 4-51 for the list of cargo body types. 

 

Figure 109. UNIT Group – CARRIER Section – Cargo Body Type Field 
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Figure 110. United States DOT Visor Card – Cargo Body Type 

Trailer Information 

If the vehicle is pulling a trailer, select the trailer type from the Vehicle Trailer Type field 
(Figure 111) databar list. See Table NN on page 4-50 for the list of vehicle trailer types. 

 

Figure 111. UNIT Group – TRAILER INFORMATION Section – Vehicle Trailer Type Field 
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Hazardous Cargo 

Hazardous cargo refers to any substance or material which has been determined to be capable 
of posing an unreasonable risk to health, safety and property when transported in commerce. 

A diamond-shaped point-on-point fixture comprised of various colors should be located on all 
four sides of a vehicle which is transporting placarded hazardous materials. 

If the vehicle is carrying hazardous cargo, complete the related fields in the HAZARDOUS 
MATERIALS section, (Figure 112). See Table XX for field descriptions. 

 

Figure 112. UNIT Group – HAZARDOUS MATERIALS Section 

Table XX. Hazardous Materials Fields 

Field Description 

Hazardous Material 
Involvement? 

Select Yes whenever the unit has explosives; dissolved, refrigerated, or 
compressed gasses; flammable liquid; flammable solids (combustible or water 
reactive); oxidizing substances (organic peroxides); poisonous (toxic) and 
infectious substances; radioactive material; corrosive; or miscellaneous 
dangerous goods involved. 

Hazardous Material 
Placard Exists 

Select Yes if a hazardous materials placard exists.  

Hazardous Cargo 
Released 

Select Yes if hazardous materials were released. This does not include fuel 
from the tank. 

Carrying Hazardous 
Material 

Select Yes if the carrier is transporting hazardous materials. 

4-Digit Placard 
Number 

If available, enter the 4-digit placard number from the diamond or box. 

 

NOTE: Hazardous materials may be present even though no placard is displayed on 
the vehicle. i
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Field Description 

1-Digit Placard 
Number 

Select the 1-digit hazardous placard number: 

1 – Explosives 

2 – Gases – Compressed, Dissolved, or Refrigerated 

3 – Flammable Liquid 

4 – Flammable Solids – Combustible, Water reactive 

5 – Oxidizing Substances – Organic Peroxides 

6 – Poisonous (Toxic) and Infectious Substances 

7 – Radioactive Material 

8 – Corrosives 

9 – Miscellaneous Dangerous Goods 

Hazardous Material 
Name 

Enter the hazardous material name when the hazardous placard information is 
not available. 
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Use the Nine Classes of Hazardous Materials (Figure 113) and Reporting Hazardous Materials 
Information visor cards (Figure 114) as references when completing the HAZARDOUS 
MATERIALS section. 

 

Figure 113. United States DOT Visor Card – Nine classes of Hazardous Materials 

 

Figure 114. United States DOT Visor Card – Reporting Hazardous Materials Information 
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Figure 115 shows where to locate the 4-digit placard number (2315 in this example) and the 
1-digit placard number (9 in this example) on shipping papers. 

 

Figure 115. Identifying 4-Digit and 1-Digit Placard Numbers on a Uniform Hazardous Waste Manifest Form 

Bulk Packages 

Bulk packaging is a package with no intermediate form of containment (for example, a cargo 
tank or tank cars) and having a: 

 Maximum capacity greater than 119 gallons as a receptacle for liquid,  

 Maximum mass greater than 882 lbs. and maximum capacity greater than 119 gallons 
as a receptacle for a solid, or 

 Water capacity greater than 1,000 lbs. for gas. 

Non-bulk packaging has a capacity less than or equal to bulk packages. 

Bulk packages must be placarded unless cleaned and purged. A gas tanker that is empty and 
has not been cleaned or purged must remain placarded. 

Containers with bulk packages inside must be marked, on each side and on each end, with the 
identification number specified for the hazardous material. 
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Chapter 6: Search Crashweb for Reports 

Introduction 

You can search and display DMV-level statuses of all crash reports submitted by your agency 
through Crashweb. If a report is rejected by the supervisor or DMV, the error messages can be 
displayed. 

The search results table lists the following information: 

 NCDMV Crash ID (assigned after acceptance by DMV) 

 Accident date 

 Officer’s name 

 Local use ID 

 County 

 On road name 

 Status 

 History of crash report 

DMV statuses are: 

 Pending supervisor approval (PS) 

 Rejected by Supervisor (RS) 

 Pending DMV Approval (PD) 

 Rejected by DMV (RD) 

 Accepted by DMV (AD) 
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Searching for Crash Reports 

To log on Crashweb and go to the search function: 

1. Go to https://dmvcrashweb.dot.state.nc.us/. You will be redirected to the North Carolina 
Identity Management (NCID) login page (https://ncid.nc.gov/login/login.html), as shown in 
Figure 116. 

 

Figure 116. NCID Login Page 

https://dmvcrashweb.dot.state.nc.us/
https://ncid.nc.gov/login/login.html
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2. Enter your NCID user ID and password and click Login. 

The North Carolina DMV Crash Reporting Site Welcome page displays, as shown in 
Figure 117. 

 

Figure 117. North Carolina DMV Crash Reporting Site Welcome Page 
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3. Click the “External User Crash Report Requests” GO button. 

The TRAC Status search page displays, as shown in Figure 118. 

 

Figure 118. TRAC Status Search Page 
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4. Click Search on the menu bar to display the Search TRCS Status page, as shown in 
Figure 119. Click Help for directions on completing the search. 

 

Figure 119. Search TRCS Status Page 
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NCDMV Crash ID Number for Supplemental Reports 

 The Crash ID number assigned by NCDMV is used in TraCS to download the report from the 
TRCS server when creating a supplemental to that report in TraCS. Use the search to find the 
crash ID number. Figure 120 shows search results with crash ID numbers assigned. Go to 
“Creating a Supplemental Report” on page 3-51 for instructions on creating a supplement to a 
crash report in TraCS. 

 

Figure 120. Crash Report Search Results 
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Chapter 7: Incident Location Tool Guide 

Introduction 

The Incident Location Tool (ILT) is an integrated component of TraCS and can be launched 
from within an open TraCS NCCRF form. ILT is used to locate crashes on the ILT map and 
populate the related location fields on the form. The ILT is an integrated component of TraCS. 

This chapter provides: 

 An overview of the ILT map and descriptions of ILT control elements 

 Instructions on how to locate a crash on the map and apply results to the form 

Fields that are populated by the ILT are: 

 On Road Name 

 At Frm* 

 Miles Frm (populated only if the distance to the nearest intersection is 500 ft or more)* 

 Feet Frm (populated only if the distance to the nearest intersection is less than 500 ft)* 

 From Direction 

 From Road Class 

 From Road Name 

 Toward Direction 

 Toward Road Class (populated only if crash occurred at intersection) 

 Toward Road Name (populated only if crash occurred at intersection) 

 Latitude* 

 Longitude* 

* If crash occurred on a ramp, these fields are not automatically populated. 
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ILT Control Elements 

After opening ILT, a map of North Carolina displays. ILT opens to the same location and zoom 
level that displayed when the program was previously closed. Figure 121 shows an example of 
the map with the main control elements identified. 

 

Figure 121. ILT Map View 

See the following sections for detailed instructions on using the ILT control elements: 

 “Command Toolbar” on page 7-3  

 “Inset Map” on page 7-5  

 “Locator Puck” on page 7-6 



  

 

TraCS 10 User's Guide for Supervisors and Reporters    

Chapter 7: Incident Location Tool Guide 7-3 

Command Toolbar 

The command toolbar buttons provide a means to view a map displaying all counties in 
North Carolina, change the pointer mode from zoom in, zoom out, and pan, enter Global 
Positioning System (GPS) coordinates, and display or hide the locator puck. See Figure 122 
and Table YY for detailed information. 

 

Figure 122. Command Toolbar 

Table YY. Command Toolbar Elements 

Element Description 

 

View Entire Map 

Displays the entire state. The inset map closes until you zoom in again. 

 

Previous Map View 

Displays the previously viewed map. This button functions like the back 
button in Web browsers. 

 

Next Map View 

Displays the next map. This button functions like the forward button in 
Web browsers. 

 

Zoom In 

Changes the pointer mode to zoom in. Drag to select the area you want 
to zoom in on. 

 

Zoom Out 

Changes the pointer mode to zoom out. Click the point on the map you 
want to zoom out on. 

 

Pan 

Changes the pointer to a pan. Click on the map to move the map in any 
direction without zooming in or out. 
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Element Description 

 

Enter GPS Coordinates 

Enter the crash location coordinates from a user-provided GPS. The 
locator puck will go to this location on the map. 

 

Show/Hide Locator Puck 

Displays or hides the locator puck. 

Hide Toolbar Tab 

 

Double-click the tab to close the toolbar. 

Show Toolbar Tab 

 

Double-click the upper right corner of the ILT window to open the 
toolbar. 
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Inset Map 

The inset map provides a means to quickly move to different areas across the map. The 
rectangle shows the current zoomed area displayed on the main map. See Figure 123 and 
Table ZZ for detailed information. 

 

Figure 123. Inset Map 

Table ZZ. Inset Map Element 

Element Description 

Flashing Rectangle Represents the area displayed on the main map. As you zoom out the 
rectangle gets larger and stops flashing. Drag the rectangle to quickly 
move to an area on the main map. 

Hide Inset Map Tab Double-click the tab to close the Inset Map. Double-click the upper left 
corner of the ILT window to open the inset map. 

Initial View 

Flashing Rectangle 

View After Zooming Out 

Hide Inset Map Tab 
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Locator Puck 

The locator puck is used to select the crash location and apply the results to the NCCRF. 
Figure 124 identifies puck controls. Table AAA describes the controls. 

 

Figure 124. Locator Puck Controls 
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Table AAA. Locator Puck Controls 

Control Description 

Eyepiece The road or intersection where the crash occurred must display within 
the eyepiece. 

Snap switch Slide the switch to the right to turn snap function on. The green on 
indicator displays. As you move the locator puck, a flashing red dot 
displays when a road enters the eye piece circle. The dot snaps to the 
road. 

NOTE: If the crash is located close to (but not on) an intersection, zoom 
in until the intersection no longer displays in the eyepiece to avoid 
snapping to the intersection. Another option is disable the snap tool and 
use the crosshairs to select the crash location. 

Grip point The grip point is where you can grab and move the locator puck with the 
mouse. However, any part of the puck that is not a button or a switch 
can be used to grip the puck. Arrow keys can also be used to move the 
locator puck. 

Label switch Slide the switch to the right to display the road name. The green on 
indicator displays. If the dot or crosshairs are positioned on an 
intersection, both road names display. 

Measure switch Slide this switch to the right to display the distance in feet to the nearest 
intersection. The green on indicator displays. 

Manual crosshairs Displays if snap is turned off. Use the crosshairs to position the puck 
over the road manually. When you have positioned the crosshairs 
correctly, the street or intersection names display on the label. 

Snap Tool Displays if the SNAP switch is turned on and at least one road displays 
in the eyepiece. The snap tool snaps to the closest road or intersection. 

Zoom In Message Indicates that the puck is zoomed out to a level that cannot precisely 
identify roads. 

Locate incident button Press this button to process the crash location and display results. The 
button is not visible until the zoom level is close enough to identify road 
names. 

Zoom In message Flashes until the zoom level is close enough to identify road names.  
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Opening ILT 

To open ILT: 

1. Go to the On Road Name field in the Crash Data group, as shown in Figure 125. 

 

Figure 125. On Road Name Field 

2. Click Locate on the databar to open ILT, as shown in Figure 126. 

 

Figure 126. On Road Name Field Databar 

 
NOTE: The form must be in edit mode before you can open ILT. 

 

NOTE: Opening ILT requires additional time to load due to the complexity of 
identifying all points on the map. To improve performance, keep the ILT open for the 
remainder of the TraCS session. The ILT closes when you close TraCS. 

i

i
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Locating a Crash on the Map and Applying the Results 

If the crash occurred on a ramp, skip to “Crash Occurred on a Ramp” on page 7-13. 

Crash Occurred on a Road 

Follow these steps to locate a crash on the ILT map and apply the results in the related fields on 
the NCCRF: 

1. Use the ILT control elements to find the location of the crash. 

Example: 

This crash occurred at the intersection of Forest Hill Drive and Wildwood Lane in the town 
of Boone. On the ILT map (shown in Figure 127) the officer has zoomed in close enough to 
locate Boone on the map, but not close enough to identify road names. The Zoom In 
message continues to flash. 

 

Figure 127. Boone Located on the ILT Map 
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The officer has zoomed in until the Zoom In message is replaced with the Locate Incident 
button. The officer has turned on the snap tool and moved the puck until the crash area is 
within the eyepiece. 

When the snap tool snaps to the correct location the Locate Incident button is ready to 
press, as shown in Figure 128. 

 

Figure 128. Intersection Selected 



  

 

TraCS 10 User's Guide for Supervisors and Reporters    

Chapter 7: Incident Location Tool Guide 7-11 

2. Press the Locate Incident button. 

If the location is at an intersection, the ILT – Get Road of Occurrence dialog box opens. 
Figure 129 shows the results from the location selected in the previous example. 

 

Figure 129. ILT – Get Road of Occurrence Dialog Box 
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3. Select the road name or number on which the crash occurred and click the arrow button to 
move the name to the Road of Occurrence box and click OK. The Incident Location Tool 
Results window opens, as shown in Figure 130. 

 

Figure 130. Incident Location Tool Results 

4. Verify that the On Road and From Road results are correct. 

5. Click Yes. ILT minimizes to the task bar and related NCCRF location fields automatically 
populate. 

  

 

CRASH LOCATION NOTES: 

1. When a crash does not occur at an intersection the From Road and Toward 
Road are returned. 

2. When a crash occurs at an intersection the On Road and From Road are 
returned. 

3. Most roads do not have a road type. 

 

NOTE: Populated fields are editable. Applying a different location through the ILT 
overwrites the fields. 

i

i
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Crash Occurred on a Ramp 

Ramp numbers are not entered in the NCCRF. If the crash occurs on a ramp, the ILT identifies 
both roads and prompts the user to identify the On Road Name and From Road Name. No 
results are returned for distance, direction, and toward road information.  

Follow these steps to locate a crash that occurred on a ramp on the ILT map and apply the 
results in the related fields on the NCCRF: 

1. Use the ILT control elements to find the location of the crash. 

Example: 

This crash occurred on ramp RMP-5554 from US-64 to I-540. On the ILT map (shown in 
Figure 131) the officer has zoomed in close enough to locate the town of Knightdale on the 
map, but not close enough to identify road names. The Zoom In message continues to 
flash. 

 

Figure 131. Knightdale Located on the ILT Map 
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The officer has zoomed in until the Zoom In message is replaced with the Locate Incident 
button. The officer has turned on the snap tool and moved the puck until the crash area is 
within the eyepiece. When the snap tool snaps to the correct location the Locate Incident 
button is ready to press, as shown in Figure 128. 

 

Figure 132. RMP-5554 Selected 
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2. Press the Locate Incident button. 

The Select Ramp Features dialog box opens. The results for this example are shown in 
Figure 133.  

 

Figure 133. ILT – Select Ramp Features Dialog Box 
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3. Select the road name or number that best reflects the On Highway/Street and click the 
arrow button. 

4. Select the road name or number that best reflects the From Highway/Street and click the 
arrow button. 

Figure 134 shows the roads selected for this example. 

 

Figure 134. On and From Roads Selected 

5. Click Done. 
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6. The Incident Location Tool Results window opens, as shown in Figure 130. Verify that the 
On Road and From Road results are correct. 

 

Figure 135. Incident Location Tool Results 

7. Click Yes. ILT minimizes to the task bar and related NCCRF location fields automatically 
populate. 

 

 

 

NOTE: Populated fields are editable. Applying a different location through the ILT 
overwrites the fields. i
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Chapter 8: TraCS Diagram Tool Guide 

The TraCS Diagram Tool allows you to quickly create a diagram that depicts a crash. The 
diagram can then be applied directly to the TraCS form. The steps to create a diagram are 
outlined in this chapter. 

The diagram tool is opened from the Diagram databar on the NCCRF form. See “Diagram 
Group” on page 4-60 for drawing requirements and instructions on how to open the TraCS 
Diagram Tool. The diagram is automatically saved to the form when you exit the diagram tool. 
Diagrams can also be saved on your machine in the Symbol Palettes folder. Saved diagram 

files have an extension of .tdd (the last "d" stands for “diagram”). 

This section explains how to use the tool bars, menus, symbols, symbol palettes, and the 
drawing page to create the diagram. Figure 136 identifies the main elements of the tool. 

 

Figure 136. TraCS Diagram Tool Window 

Open 
Palettes 

Pane 

 
Tool Bar 

Menu Bar 

 

Symbols 

Drawing Page 
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Palettes and Palette Groups 

A Symbol Palette is a group of symbols. For example, the Signs palette contains a symbol for 
each of the different types of street signs. TraCS comes with five symbol palettes (shown in 
Figure 137) that contain all the symbols needed to create a diagram of a crash. Symbol palettes 
that do not display on the open palette pane can be added to the pane. The files are located in 
the Symbol Palettes folder. After you open the symbol palettes, you can save them as default 
palettes so they display every time you open the TraCS Diagram Tool. 

 

Figure 137. Default Palettes 

Opening Palette or Palette Group 

To add a palette or palette group to the open palettes pane and save as a default: 

1. Select Add Palette or Palette Group from the File menu, as shown in Figure 138. The 
TraCS palette files display. 

 

Figure 138. File Menu – Add Palette or Palette Group 

2. Select a file type from the list on the Open Palette or Template dialog box. 

 

NOTE: The agency administrator has the option of creating additional symbol 
palettes for users within the agency. i
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Figure 139. Open Palette or Template Dialog Box 

3. Click Open. The palette or palette group is added to the palette bar. 

 

NOTE: Palette file extensions are .tdp. Palette group extensions are .tdg. Only 

one type of extension displays at a time in the dialog box, as shown in Figure 139. 

 

NOTE: Palettes that are not saved as default palettes are only available for the 
current TraCS Diagram Tool session. Continue to step 4 to save the palettes as 
defaults. Default palettes display every time the TraCS Diagram Tool is opened. 

i

i

Palettes 

Palette Group 
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4. To save all palettes displayed on the palette bar as default palettes, select Save Open 

Palettes as Default from the File menu, as shown in Figure 140. 

 

Figure 140. File Menu – Save Open Palettes as Defaults 

Closing a Palette 

To remove a palette from the open palettes pane: 

1. Select the palette. 

2. Right-click and select Remove Palette (or select Remove Palette from the File menu). 
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Creating a New Palette Group 

When a symbol palette is created in the Symbol Designer, it can be saved as an individual 
palette file, or it can be saved along with other open symbol palettes to form a new palette 
group. Opening a palette group file in the TraCS Diagram Tool opens all symbol palettes saved 
to that group file. 

To create a palette group: 

1. Open the palettes that you want to include in the palette group. Remove palette groups 
from the Symbol Palettes pane that you do not want to include in the group. 

2. Select Create Palette Group from the File menu. The Save Palette Group dialog box 
opens, as shown in Figure 141. 

 

Figure 141. Save Palette Group Dialog Box 

3. Enter a file name for the new palette group and click Save. All palettes in the new group 
display in the Open Palette pane. 

  

 

NOTE: All open palettes (that is, all palettes that display in the Open Palettes pane) 
will be included in the Palette Group. i
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Symbols 

Symbols are objects that are used when creating a diagram of a crash scene. For example, a 
car symbol and a tree symbol could be used in a diagram that depicts a crash in which a car 
struck a tree. 

Adding a Symbol 

To add a symbol to a diagram: 

1. Select the palette that contains the symbol that you want to add to the diagram. 

2. Drag the symbol to the drawing page, as shown in Figure 142. 

 

Figure 142. Dragging Symbol to Drawing Page 

  

 

WARNING: DO NOT use fill or color. When the NCCRF is burned to the DMV-349 all 
diagram colors (including shades of gray) display as black. Fills can make the 
diagram unreadable. Both examples below show how the same sign displays in the 
NCCRF and how it displays in the DMV-349. One example uses color and fill; the 
other does not. NCDMV does not accept diagrams that use color or fill. 

 

!
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Working with Symbols 

This section provides instructions to rotate, size, align, group, and link symbols on the drawing 
page. Text in symbols (such as roadway signs) can be replaced. 

To replace text in a sign: 

1. Drag the symbol to the drawing page, as shown in Figure 142. 

2. Double-click the symbol number text to change to overtype mode and enter text, as shown 
in Figure 143. 

 

Figure 143. Replacing Symbol Text 

To rotate a symbol: 

1. Drag the rotate (green) handle to rotate the symbol, as shown in Figure 144. 

 

Figure 144. Rotating a Symbol 

2. Right-click the selected symbol, and then select Rotate > Rotate 90 clockwise or Rotate > 

Rotate 90 counter-clockwise to rotate the symbol in 90 degree increments. 

 
NOTE: Multiple symbols can be selected and rotated together. i

Overtype Mode Updated Value 

Rotate Handle 
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To resize a symbol: 

Select the symbol and then place the pointer over one of square sizing handles and drag to the 
preferred size, as shown in Figure 145 

 

Figure 145. Resizing a Symbol 

Symbols can be resized to be the same height and width as other symbols, as well as be 
proportionally spaced on the drawing page. The change is based on the first selected symbol in 
the group. In the example in Figure 146, the cone on the left was the first selected symbol 
before the Same Size command was selected. 

To size, rotate, space, and align symbols: 

1. Resize symbols from the Actions menu, as shown in Figure 146. 

 

Figure 146. Resizing Symbols Example 

2. Use the controls on the toolbar to arrange the selected symbols (as shown in Figure 147). 

 

Figure 147. Symbol Controls 

Size Handle 

Select symbols Select sizing action Result 

Rotate and Flip Space and Size Align 
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Group a set of symbols so that you can work with them collectively. Resize, rotate, flip, move, or 
format all the symbols in the group as if they were a single object. 

To group symbols: 

1. Press Ctrl and then click each symbol to be group together, as shown in Figure 148. 

 

Figure 148. Selected Symbols 

2. Click Group  on the toolbar. 

Linking two symbols draws a line between them. The line automatically adjusts and remains in 
place when either symbol is moved. 

To link symbols: 

1. Click one of the link buttons  on the toolbar. The pointer changes to a cross. 

2. Click the first of the two symbols to be linked together, as shown in Figure 149. 

 

Figure 149. Select First Symbol 

 

NOTE: Select the grouped symbols and click Ungroup  to return the symbols to 
their original ungrouped state. 

i
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3. Drag to the second symbol until a second blue box displays, as shown in Figure 150. When 
the mouse button is released, the connecting line displays. 

 

Figure 150. Drag to Second Symbol 

Saving the Diagram and Closing the TraCS Diagram Tool 

To save the diagram and close the diagram tool: 

1. Select Exit from the File menu or click  . 

The diagram is saved and the TraCS Diagram Builder closes. 

2. Click Close to close the TraCS Diagram Tool launch window. 

The diagram displays on the form and the Accident Report Narrative field becomes active. 

 

 

 

NOTE: To close the diagram tool without saving the diagram, select Exit Without 

Save from the File menu. i
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Chapter 9: TraCS Auto Update 

TraCS Auto Update keeps your TraCS 10 program current. One machine at your agency is 
designated as the master computer for receiving TraCS updates. The master computer is the 
first machine to receive TraCS updates. When new updates are available, the user is prompted 
to install them. After the master computer updates successfully, the update will be available on 
the remaining agency machines when the users logs in. 

There are two types of updates: required and optional. If the update is required, you will not be 
able to log in to TraCS until the update is installed. 

Required Updates 

To install required updates: 

1. Log in to TraCS. If required updates are available the Required Update Available window 
opens, as shown in Figure 151. 

 

Figure 151. Required Update Available Window 

 

NOTE: If you do not know the machine ID of the master computer or if no machine 
at your agency has been designated as the master machine for updates, contact 
Operations Support at (919) 861-3084, Monday through Friday, 8:00 a.m. to 
5:00 p.m. 

 

CAUTION: If you do not install required updates you will not be able to log in to 
TraCS in any mode; online or offline. 

i

!
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2. Click Yes. The TraCS Update window opens, as shown in Figure 152. 

 

Figure 152. TraCS Update Window 

3. When the update is complete, click Close. 

If you are logged in to the master computer, the Master Computer Updated window opens, 
as shown in Figure 153. 

If you are not logged in to the master computer, the update is complete. The log in window 
opens so you can log into TraCS. 

 

Figure 153. Master Computer Updated Window (Master Computer Only) 
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4. Click Yes. The Confirmation window opens, as shown in Figure 154. 

 

Figure 154. Confirmation Window (Master Computer Only) 

5. Click Yes. The login window opens so you can log into TraCS. All other machines at this 
location can update when the user logs in to TraCS. 
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Optional Updates 

To install optional updates: 

1. Log in to TraCS. If optional updates are available the TraCS Update icon in the notification 
area displays the “You have new TraCS Updates to install. Restart TraCS to install them.” 
notification, as shown in Figure 155. 

 

Figure 155. Optional Update Available Window 

2. Log off and then log in again. The Updates Available window opens, as shown in 
Figure 156. 

 

Figure 156. Update Available Window 
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3. Click Yes. The TraCS Update window opens, as shown in Figure 157. 

 

Figure 157. TraCS Update Window 

4. When the update is complete, click Close. 

If you are logged in to the master computer, the Master Computer Updated window opens, 
as shown in Figure 158. 

If you are not logged in to the master computer, the update is complete. The log in window 
opens so you can log in to TraCS. 

 

Figure 158. Master Computer Updated Window (Master Computer Only) 
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5. Click Yes. The Confirmation window opens, as shown in Figure 159. 

 

Figure 159. Confirmation Window (Master Computer Only) 

6. Click Yes. The login window opens so you can log into TraCS. All other machines at this 
location can now update when the user logs into TraCS. 

 

 



 

 10-1 

Chapter 10: Glossary of Terms 

This section contains definitions, interpretations, and examples related to motor vehicles and 
other road vehicle crashes. 

A 

 

Access Control 

When the rights of owners or occupants of abutting land or other persons to access light, air, or 
view in connection with a highway is fully or partially controlled by public authority. 

Air Bag Deployed 

An air bag is out of its cover and protruding into the occupant compartment. The bag can be 
fully or partially inflated. 

Alcohol/Drug Suspected 

The officer suspects drugs or alcohol have been used by the person. 

Alcohol/Drug Involvement 

The officer’s assessment of whether alcohol or other drug use was suspected or demonstrated 
to be present by test for any vehicle driver or non-motorist in the crash. 

Alcohol 

The percent of blood alcohol content (BAC) or breath alcohol content (BrAC). 

Alignment 

The geometric characteristics or layout of a roadway. Alignment is usually subdivided into 
horizontal or vertical. 

Ambient Light 

The type of light that exists at the time of a motor vehicle crash. 

Angle – Manner of Impact 

A crash involving two vehicles that impact at an angle. For example, the front of one vehicle 
impacts the side of another vehicle. 
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Animal in Roadway 

Living beings which have the capacity for movement and motor response to stimulation but are 
not human beings. If a motor vehicle strikes an animal (other than a domestic animal) and harm 
results ONLY to the animal, the event is NOT a motor vehicle collision. 

Approaching or Leaving Vehicle 

Physical movement in the direction of or in the direction away from the vehicle. 

At Intersection but No Crosswalk 

An area which contains a crossing or connection of two or more roadways not classified as a 
driveway access but without the street crossing distinctly indicated for pedestrian crossing by 
lines or other markings on the surface of the roadway. 

Auxiliary Lane 

The portion of the roadway adjoining the through traveled way for parking, speed change, 
turning, storage for turning, weaving, truck climbing, or for other purposes supplementary to 
through traffic movement. 

B  

 

Backing 

A start from a parked or stopped position in the direction of the rear of the vehicle. 

Barrier 

A device which provides a physical limitation through which a vehicle would not normally pass 
and is designed to contain or redirect an errant vehicle. 

Bridge Parapet End 

A low wall built along the edge of a bridge deck. 

Bridge – Pier or Abutment 

A bridge pier is a support for a bridge structure other than at the ends. A bridge abutment is the 
end support for a bridge. 

Bridge – Overhead Structure 

Any part of a bridge that is over the reference or subject roadway. In crash reporting, this 
typically refers to the beams or other structural elements supporting a bridge deck. 

Bridge 

A structure (including supports) carrying a roadway over an obstruction such as water, a 
railway, or other roadway, having an opening of 20 feet (6 m) or more measured along the 
center of the structure. 
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Bridge – Rail 

A barrier attached to a bridge deck or a bridge parapet to restrain vehicles, pedestrians, or other 
users. 

C  

 

Cargo Body Type 

Coded for buses and trucks over 10,000 pounds GVWR. 

Cargo Tank 

A single-unit truck, truck/trailer, or tractor/semi-trailer having a cargo body designed to transport 
either dry bulk (fly ash, etc.), liquid bulk (gasoline, milk, etc.), or gas bulk (propane, etc.). 

Cargo/Loss or Shift 

The release of the goods being transported from the cargo compartment of the truck, or the 
change in the position of the goods within the cargo compartment. 

Cargo Released 

The goods being transported by a truck spill out of the vehicle cargo compartment. 

Carrier Identification Number 

A unique number assigned by the U.S. Department of Transportation, Interstate Commerce 
Commission, or by the state to a motor carrier. 

Carrier Name 

The name of an individual, partnership, or corporation responsible for the transportation of 
persons or property. 

Carrier Name Source 

Where the name of the motor carrier was noted, be it the power unit of the truck, the trailer, the 
shipping papers, or other documents. 

Cataclysm 

A cloudburst, cyclone, earthquake, flood, tornado, or volcanic eruption. 

Center Line 

A yellow pavement marking used to separate traffic traveling in opposite directions. A center line 
need not be at the geometrical center of the pavement. 

Changing Lanes 

A vehicle shift from one traffic lane to another traffic lane moving in the same direction. 
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Cited 

Driver or non-motorist issued a citation for actions which contributed to the crash. 

Clear Zone Distance 

The total roadside border area, starting at the edge of the traveled way, available for safe use 
by errant vehicles. This area may consist of a shoulder, a recoverable slope, a non-recoverable 
slope, and/or a clear run-out area. The desired width is dependent on the traffic volumes and 
speeds, and roadside geometry. 

Cloudy 

Overcast with clouds. 

Collision 

A road vehicle crash other than an overturning crash in which the first harmful event is a 
collision of a road vehicle in transport with another road vehicle, other property, animal or 
pedestrian. 

Collision with Object Not Fixed 

A collision crash in which the first harmful event is the striking by a road vehicle in transport of 
an object that is not fixed. 

Collision with Fixed Object 

A collision crash in which the first harmful event is the striking of a fixed object by a road vehicle 
in transport. 

Commercial Sign 

A sign placed by an area business as a means of advertising. Logo signs (advertising upcoming 
businesses along the roadway) placed by DOT are not commercial signs. 

Concrete Mixer 

A single-unit truck with a body specifically designed to mix or agitate concrete. 

Construction Barrier 

A traffic barrier designed to protect traffic from entering work areas, provide protection for 
workers, separate two-way traffic, protect construction, and separate pedestrian and vehicular 
traffic. 

Contributing Circumstances 

The actions of the driver or non-motorist, and/or the apparent condition of the road which 
contributed to the crash. 
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Crash Cushion 

A barrier at a spot location designed to prevent an errant vehicle from impacting a fixed object 
hazard by gradually decelerating the vehicle to a safe stop or by redirecting the vehicle away 
from the hazard. 

Crash City/Place 

The city/place in which the crash occurred. 

Crash Date and Time 

The date (month, day, and year) and time (hour and minute) at which the crash occurred. 

Crash Roadway Location 

Exact location on the roadway indicating where the crash occurred. 

Crash Severity 

The severity of a crash based on the most severe injury to any person or, if none injured, so 
designating. 

Crossover 
Area in the median of a divided roadway where vehicles are permitted to travel, cross the 
opposing lanes of traffic or do a U-turn. 

Culvert 

An enclosed structure providing free passage of water under a roadway with a clear opening of 
twenty feet (6 m) or less measured along the center of the roadway. 

Curb 

A raised edge or border to a roadway. Curbs may be constructed of concrete, asphalt, or wood 
and typically have a face height of less than 9 inches (225 mm). 

D  

 

Dark – Lighted Roadway 

It is dark but the roadway is lighted by lights designed and installed to illuminate the roadway. 
This is not lighting from store fronts or house lamps. 

Dark – Roadway Not Lighted 

It is dark and the roadway is not lighted by lights designed and installed to illuminate the 
roadway. 

Dart Out 

Pedestrian enters the street mid-block and is struck by or walks or runs into a moving vehicle. 
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Date and Time Crash Reported to Police Agency 

The date and time at which the call was placed notifying the police agency about the crash. 

Date of Birth 

Month, day, and year of birth of person involved in the crash. 

Dawn 

The first appearance of light in the morning. 

Debris 

The remains of something broken or destroyed. 

Deliberate Intent 

Suicide, homicide and other harmful events under human control. 

Derived Data Elements 

Derived data elements are not collected at the scene by the police. Instead they are obtained by 
counting or recoding information contained in existing data elements that have already been 
collected and computerized. 

Direction of Travel before Crash 

The direction of a vehicle’s normal/general travel on the roadway before the crash. This is NOT 
a compass direction but a direction consistent with the overall direction of the road. 

Disabling Damage 

Damage which precludes departure of the vehicle from the scene of the crash in its usual 
operating manner after simple repairs. 

Disregarded Traffic Signs, Signals, Road Markings, or Officer 

Driver or non-motorist failed to comply with the instructions directed by traffic signs, signals, 
road markings, or a police officer at the scene. 

Ditch 

An open channel dug into the ground, usually parallel to the highway embankment and within 
the limits of the highway right-of-way. 

Downhill Runaway 

A motor vehicle that is moving down a hill without the ability to stop. 

Driver 

An occupant who is in actual physical control of a transport vehicle or, for an out-of-control 
vehicle, an occupant who was in control until control was lost. 



  

 

TraCS 10 User's Guide for Supervisors and Reporters    

Chapter 10: Glossary of Terms 10-7 

Driver Condition 

State of being, health, or physical fitness of the occupant who is in actual physical control of a 
transport vehicle at the time of the crash. 

Driverless Motor Vehicle 

A driverless motor vehicle, though previously parked, or a motor vehicle out of control while 
being towed or pushed, is considered to be a motor vehicle in transport. Also, an abandoned 
motor vehicle, upon a roadway, is considered to be a motor vehicle in transport. This principle 
does not apply to such devices as farm or industrial machinery, highway graders, construction 
machinery, or similar devices which are not in use at the time of the crash for transport. 

Driver License Number 

A unique number assigned by the authorizing agent issuing a driver license to an individual. 

Driveway 

A roadway providing access to property adjacent to a trafficway. 

Driving Too Fast for Conditions 

Traveling at a speed that was unsafe for the road, weather, traffic or other environmental 
conditions at the time. 

Dump Truck 

A truck which can be tilted or otherwise manipulated to discharge its load by gravity. 

Dusk 

The beginning of darkness in the evening. 

E  

 

Edge Line 

A pavement marking used to mark the edge of pavement for driver guidance. 

Ejection 

An occupant’s body completely or partially thrown from the vehicle as a result of a crash. 

Embankment 

A mound of earth or stone above the original ground, built to hold back water, or to support a 
roadway. 
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Emergency Use 

Indicates vehicles, such as military, police, ambulance, or fire, which are on an emergency 
response. Emergency use refers to a vehicle that is traveling with emergency signals in use, 
such as, flashing blue or red lights and a siren sounding. 

EMS Response Unit Name 

Name of Emergency Medical Services (EMS) unit that responded to the crash. 

Exceeded Authorized Speed Limit 

Driver was operating vehicle faster than posted speed limit at time of the crash. 

F  

 

Failed to Yield Right of Way 

Driver or non-motorist did not give way to another vehicle or non-motorist as required. 

Fatal Crash 

Any motor vehicle or other road vehicle crash resulting in fatal injuries to one or more persons. 

Fell Asleep, Fainted, Fatigue, etc. 

Driver experienced a temporary loss of consciousness or was operating in a reduced physical 
and mental capacity due to weariness, medication, or other drugs. 

Fire/Explosion 

Fire/explosion which was the cause or product of the crash. 

First Harmful Event 

The first injury or damage producing event which characterizes the crash type and identifies the 
nature of the first harmful event, such as an explosion in the vehicle. 

Flashing Traffic Control Signal 

Traffic control signal that is flashing or a single light flashing red or yellow. 

Flatbed 

A single-unit truck, truck/trailer, or tractor/semi-trailer whose body is without sides or roof, with 
or without readily removable stakes which may be tied together with chains, slats, or panels. 
This includes trucks transporting containerized loads. 

Followed Too Closely 

Driver was positioned too close to another vehicle or non-motorist to permit safe response to 
any change in movement or behavior of the other vehicle or non-motorist. 
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Full Access Control 

Authority to control access is exercised to give preference to through traffic by providing access 
connections with selected public roads only, by prohibiting crossings at grade or direct private 
driveway connections. 

Functional Classification 

A classification system in which highways and streets are grouped into classes, or systems, 
according to the character of the service they are intended to provide. 

Functional Damage 

Damage which is not disabling, but affects operation of the road vehicle or its parts. 

G  

 

Geographic Information System (GIS) 

System which associates information with specific geographic locations, for example, roadway 
characteristics by latitude/longitude. 

Global Positioning System (GPS) 

Exact geographic location indicated in terms of latitude and longitude. 

Grade 

The rate of ascent or descent of a roadway, expressed as a percent; the change in roadway 
elevation per unit of horizontal length. 

Guardrail 

A longitudinal barrier consisting of posts and rails or cables, whose primary function is to 
prevent penetration or to safely redirect an errant vehicle away from a roadside or median. 

H  

 

Harmful Event 

An occurrence of injury or damage. 

Hazardous Materials 

Any substance or material which has been determined by the U.S. Secretary of Transportation 
to be capable of posing an unreasonable risk to health, safety, and property when transported in 
commerce and which has been so designed under regulations of the USDOT. 
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Hazardous Materials Involvement (Cargo Only) 

Indication that a motor vehicle had a hazardous materials placard as required by federal 
regulations. 

Highway Traffic Sign Post 

A pole, post, or structure constructed to support a highway sign intended to guide, regulate, or 
inform highway users. 

Highway, Street, or Road 

A general term denoting a public way for purpose of vehicular travel, including the entire area 
within the right-of-way. Recommended usage in urban areas: highway or street. Recommended 
usage in rural areas: highway or road. 

Hit & Run 

A vehicle involved in the crash as the “striking vehicle” or as the “vehicle struck” but which left 
the scene. The appropriate box must be checked, e.g., vehicle 1, vehicle 2, etc., and any 
information that is known, included in the Driver and/or Vehicle areas. 

Horizontal Alignment 

The plan view of a roadway. Horizontal alignment is described in terms of lengths of tangents 
and degree of curves. 

I  

 

In Roadway 

Physically located in that part of the trafficway designed, improved, and ordinarily used for motor 
vehicle travel. 

In Transport 

The state or condition of a vehicle when it is in use primarily for moving persons or property 
(including the vehicle itself) from one place to another, and is 

 In motion; 

 In readiness for motion; or 

 On a roadway, but not parked in a designated parking area. 

Injury Status 

The most severe injury to a person involved in the crash. Injury statuses are: 

 Killed – Deaths (which must occur within 12 months after the crash) resulting from 
injuries sustained in a specific road vehicle crash. 



  

 

TraCS 10 User's Guide for Supervisors and Reporters    

Chapter 10: Glossary of Terms 10-11 

 A type injury (disabling) – Injury obviously serious enough to prevent the person injured 
from performing his normal activities for at least one day beyond the day of the collision. 
Massive loss of blood, broken bone, and unconsciousness of more than momentary 
duration are examples. 

 B type injury (evident) – Obvious injury, other than killed or disabling, which is evident at 
the scene. Bruises, swelling, limping, soreness, are examples. Class B injury would not 
necessarily prevent the person from carrying on his normal activities. 

 C type injury (possible) – No visible injury, but person complains of pain, or has been 
momentarily unconscious. 

Insufficient Information 

When available information is insufficient to determine whether the injury or damage resulted 
from a motor vehicle in a transport collision, assume that it did and that the event is a motor 
vehicle collision. 

Intersection 

An area which (1) contains a crossing or connection of two or more roadways not classified as 
driveway access and (2) is embraced within the prolongation of the lateral curb lines or, if none, 
the lateral boundary lines of the roadways. Where the distance along a roadway between two 
areas meeting these criteria is less than 33 feet, the two areas and the roadway connecting 
them are considered to be parts of a single intersection. 

Intersection Related 

May refer to a crash that occurs within the influence area of the intersection and is caused by 
the operation of the intersection. The influence area is a variable distance that depends on the 
intersection design, traffic control and operating characteristics. 

Island 

Cement or grassy area in the middle of a trafficway. 

J  

 

Jackknife 

An event involving a truck pulling a semi-trailer or trailers where the trailing unit(s) and the 
pulling vehicle rotate opposite of each other. 

L  

 

Lap Belt Only Used 

Use of only a lap safety belt, either because the vehicle is equipped only with lap belts or 
because the shoulder belt was not used. 
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Latitude/Longitude 

For those agencies/municipalities which are able to record the geographic location of a crash in 
terms of latitude, longitude and altitude (elevation), fields exist in the Crash Data section on the 
NCCRF for capturing this information. 

Light Truck with Only Four Tires 

Trucks (mini-van, panel, pickup, sport utility) of 10,000 pounds gross vehicle weight rating or 
less. 

Logbook 

A document carried in the truck cab or bus in which commercial motor vehicle drivers must 
enter their record of duty status for each 24-hour period using methods prescribed by the 
USDOT. 

Luminaire 

A complete lighting unit consisting of one or more lamps (bulbs or tubes that emit light), along 
with the socket and other parts that hold the lamp in place and protect it, and wiring that 
connects the lamp to a power source. 

Luminaire Pole 

A pole or post constructed to support a luminaire for lighting a roadway. 

M  

 

Marked Crosswalk at Intersection 

That portion of the roadway at the intersection that is distinctly indicated for a pedestrian 
crossing by lines or other markings on the surface of the roadway. 

Mechanical Failure 

Any mechanical failure, such as, a tire blowout, broken fan belt, broken axle, or similar event 
does not, by itself, constitute a motor vehicle collision. However, any subsequent injury or 
damage producing event resulting from the mechanical failure would be a motor vehicle collision 
if the motor vehicle is in transport. 

Median 

The portion of a divided trafficway separating the traveled way for traffic in opposing directions. 

Median Barrier 

A longitudinal barrier (such as concrete) used to prevent an errant vehicle from crossing the 
portion of a divided highway separating the traveled ways for traffic in opposite directions. 

Most Damaged Area/Extent of Deformity 

The location and severity of most damage on vehicle from crash. 
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Most Harmful Event for this Vehicle 

The most harmful event in terms of property damage or injury caused by this vehicle. 

Motor Home 

A van where a frame-mounted recreational unit is added behind the driver or cab area or 
mounted on a bus/truck chassis. 

Motor Vehicle 

Any mechanically or electrically powered device not operated on rails, upon which or by which 
any person or property may be transported or drawn upon a highway. For purpose of this guide, 
any object such as a trailer, coaster, sled or wagon being towed by a motor vehicle is 
considered a part of the motor vehicle, including such devices when detached while in motion, 
or set in motion by a motor vehicle, such as during pushing. Also, the load, including occupants, 
upon or in the motor vehicle, or upon or in the device being towed or pushed, is considered a 
part of the motor vehicle. 

Motor Vehicle includes, but is not limited to the following devices: 

 Automobiles (any type), bus, motorcycle, motorized bicycle or scooter, motorized fire 
engine, truck, van, trolley bus not operating upon rails. 

 Construction machinery, farm and industrial machinery, road roller, tractor, army tank, 
highway grader, or similar devices equipped with wheels or treads, while in transport 
under own power. 

 Special motorized devices such as go-carts, midget racers, invalid chairs, snowmobiles, 
swamp buggies, or similar devices, while in transport under their own power. 

Motor Vehicle Crash 

Any event that results in death, injury or property damage attributable directly to a motor vehicle 
or its load in transport, but not involving aircraft or watercraft. It must occur on a trafficway or 
after the motor vehicle runs off the roadway but before events are stabilized. 

Motor Vehicle Non-traffic Crash 

Any motor vehicle crash occurring entirely in any place other than a trafficway. 

Motor Vehicle Status 

The use of the device at the time of the crash is the primary criterion for establishing motor 
vehicle status. For example: 
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 A registered motor vehicle is being drawn by a team of horses on a city street; it is 
considered other road vehicle. 

 A registered motor vehicle is being used to draw a plow engaged in breaking ground on 
a farm; it is considered farm machinery while engaged in plowing. 

 A registered truck is engaged in spreading concrete at a road construction site; it is 
construction machinery. 

 A motorized highway grader, under its own power, is moving from one work place to 
another on a public way; it is considered a motor vehicle in transport. 

 A registered truck, with a blade attached, is engaged in plowing snow from a trafficway; 
it is considered road maintenance machinery. 

 A riding, motorized lawn mower, under its own power, is being driven from one home to 
another on a city street; it is considered a motor vehicle in transport. 

 A military tank is being moved, under its own power, from the firing range to the motor 
pool, on a land way of a military post; it is considered a motor vehicle in transport. 

Motorcycle 

A two-wheeled motor vehicle having one or more riding saddles, and sometimes a third wheel 
for the support of a sidecar. The sidecar is considered a part of the motorcycle. Included are 
motor scooters, minibikes, and mopeds. 

N  

 

Non-Contact Motor Vehicles or Non-Motorists 

Units that caused the crash and remained at the scene. They are counted as units with 
identifying information, and are referred to in the narrative. 

Non-Contact Phantom Motor Vehicles or Non-Motorists 

Units that caused the crash but left the scene. They should not be counted in the number of 
units, but should be referred to in the narrative. 

Nonfatal Injury Crash 

Any motor vehicle or other road vehicle crash, other than a fatal crash, that results in injuries, 
other than fatal, to one or more persons. 

Non-Intersection Crosswalk 

A portion of the roadway, not at an intersection, that is distinctly marked a pedestrian crossing 
on the surface of the roadway. 
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Non-Motorist 

A non-motorist is any person other than a motorist, including pedestrians, pedalcyclists, roller 
bladers, and roller skaters. 

Non-Motorist Safety Equipment 

The safety equipment used by the non-motorist, such as helmets, protective pads, reflective 
clothing. 

Number of Lanes 

The total number of thru lanes of the “road on” at the point of the crash (if two-way, total for both 
directions). Do not count turning lanes unless they are continuous between intersections. Enter 
“0” for parking lots. 

O  

 

Official Highway Sign 

A pole, post, or structure used to support a highway sign intended to guide, regulate, or inform 
highway users. 

On-Off Switch (Air Bag Deployed) 

A switch that activates/deactivates the front seat passenger or driver’s airbag. 

Operating Defective Equipment (Driver) 

Vehicle in transport where any part or component of vehicle in transport is deficient, faulty, 
incomplete, or incapacitated. 

Other Road Vehicle 

Any device, except motor vehicle and pedestrian conveyance, in, upon, or by which any person 
or property may be transported upon a land way or place, such as a trafficway. 

Includes: 

 Animal-drawn vehicle (any type) 

 Animal harnessed to a conveyance 

 Animal carrying a person 

 Street car 

 Bicycle (pedal cycle) 

Other Road Vehicle Crash 

A crash involving a road vehicle in transport, but not involving an aircraft, a watercraft, a motor 
vehicle in transport, or a railway train. 
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Outside Trafficway 

Not physically located on any land way open to the public as a matter of right or custom for 
moving persons or property from one place to another. 

Overhead Part of Underpass 

Any part of an underpass that is over a roadway. For a bridge, this typically refers to the beams 
or other structural elements supporting the bridge deck. 

Overhead Sign Support 

A pole, post, or structure constructed to support a sign which is over a roadway (usually 
installed on or relocated to nearby overpasses or other structures). 

Overturn/Rollover 

A vehicle that has overturned at least 90 degrees from its upright position. 

P  

 

Pavement Markings 

Markings set into the surface of, applied upon, or attached to the pavement for the purpose of 
regulating, warning, or guiding traffic. Markings are typically paint or plastic but may be devices 
of various materials. 

Pedal cycle 

A vehicle operated solely by pedals and propelled by human power. Pedal cycle types include: 

 Bicycle (any size, with two wheels in tandem) 

 Tricycle 

 Unicycle 

 Sidecar or trailer attached to any of the above devices 

Excludes these devices when towed by a motor vehicle, including hitching. 

Pedestrian 

Any person not in or upon a motor vehicle or other road vehicle. 

Includes: 

 Person afoot, sitting, lying, or working upon a land way or place. 

 Person in or operating a pedestrian conveyance. 
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Excludes: 

 Person boarding or alighting from another conveyance, except pedestrian conveyance. 

 Person jumping or falling from a motor vehicle in transport. 

Person 

A person is any living human. Within the context of the ANSI D16.1 Classification Manual, a 
fetus is considered to be part of a pregnant woman rather than a separate individual. After 
death, a human body is not considered to be a person. 

Physical Impairment 

A condition that results in some decrease in a physical ability. 

Point of Impact 

The section of the vehicle that impacted first in a crash. 

Pole Trailer 

A trailer designed to be attached to the towing vehicle by means of a reach or pole, or by being 
boomed or otherwise secured to the towing road vehicle, and ordinarily used for transporting 
property of a long or irregular shape. 

Private Road or Driveway 

Includes every road or driveway not open for the use of the public as a matter of right or custom 
for the purpose of vehicular traffic. 

Property 

Any physical object other than a person. Includes real property, personal property, animals (wild 
or domestic), signs, guardrails, impact attenuators, and others. 

Property Damage Only 

Crash in which at least one vehicle is damaged or other property damage occurs but no 
occupants or non-motorists are injured. 

Public Vehicular Area 

Includes any area that is generally open to and used by the public for vehicular traffic, including 
any drive, driveway, road, roadway, street, alley, or parking lot on the grounds and premises of: 

 Any public or private hospital, college, university, school, orphanage, church, or any of 
the institutions, parks or other facilities maintained and supported by the state of North 
Carolina or any of its subdivisions; or 

 Any service station, drive-in theater, supermarket, store, restaurant, or office building, or 
any other business, residential, or municipal establishment providing parking space for 
customers, patrons, or the public. 
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 Any property owned by the United States and subject to the jurisdiction of the State of 
North Carolina. (The inclusion of property owned by the United States in this definition 
shall not limit assimilation of North Carolina law when applicable under the provisions of 
Title 18, United States Code, section 13). 

The term “public vehicular” area shall also include any beach area used by the public for 
vehicular traffic as well as any road opened to vehicular traffic within or leading to a subdivision 
for use by subdivision residents, their guests, and members of the public, whether or not the 
subdivision roads have been offered for dedication to the public. 

The term “public vehicular area” shall not be construed to mean any private property not 
generally open to and used by the public. Report on a PVA should contain the same information 
as if the crash occurred on the roadway. 

R  

 

Railway Grade Crossing 

An intersection between a roadway and train tracks which cross each other at the same level 
(grade). 

Railway Train 

Any device, with or without cars coupled thereto, designed for transport upon a railway, 
including any device designed to operate upon railway tracks, under its own power, such as a 
motor vehicle equipped with flanged wheels. Non-motorized devices, not set in motion by a 
railway train or vehicle, are not considered to be a railway train or vehicle. 

Relation to Roadway 

The location of the first harmful event as it relates to its position within or outside the trafficway. 

Road 

That part of a trafficway which includes both the roadway and any shoulder alongside the 
roadway. 

Road Vehicle 

Any land vehicle other than a railway vehicle, including motor vehicles and other road vehicles. 

Roadway 

That part of a trafficway designed, improved, and ordinarily used for vehicular travel. In the 
event the trafficway includes two or more separate roadways, the term “roadway” refers to any 
such roadway separately, but not to all such roadways collectively. 
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S  

 

School Bus 

A motor vehicle used for the transportation of any school pupil at or below the 12th-grade level 
to or from a public or private school or school-related activity. It must be externally identifiable 
by the color yellow, the words “school bus”, flashing red lights located on the front and rear, and 
identifying lettering on both sides indicating the school or school district served, or the company 
operating the bus. 

School Bus Related Crash 

A motor vehicle crash in which a school bus, with or without a pupil on board, is involved directly 
as a contact vehicle or indirectly as a noncontact vehicle. 

School Zone Signs 

Signs which change the speed limit on roads adjacent to schools on school days, signs which 
give advance warning of school and signs which warn of children crossing the road. 

Seating Position 

Location of occupant within a vehicle or on a motorcycle. 

Separation of Units 

When the truck or truck tractor becomes separated from the semi-trailer and/or trailer(s) they 
are pulling. 

Sequence of Events 

A list of the things that occurred to the vehicle in question that was relevant to the crash. 

Shipping Papers (Truck) 

The documents carried in the cab of the truck or truck tractor that indicates the cargo being 
carried and other motor carrier responsible for the movement of the cargo. 

Shoulder 

The portion of the road contiguous with the roadway for accommodation of stopped vehicles, for 
emergency use, and for lateral support of the roadway structure. The line between the roadway 
and the shoulder may be a painted edge line, a change in surface color or material, or a curb. 
On some modern trafficways, there may be a surfaced shoulder on the right side, and frequently 
a narrower shoulder on the left side of a one-way roadway. 

Shoulder and Lap Belt Used 

In a two part occupant restraint system, both the shoulder belt and lap belt portions are 
connected to a buckle. 
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Shoulder Barrier 

Concrete barrier or something other than a guardrail placed on the shoulder. 

Single-Unit Truck (2-axle, 6-tire) 

A power unit that includes a permanently mounted cargo body (also called a straight truck) that 
has only two axles and at least six tires on the ground. 

Single-Unit Truck (3-or-more axles) 

A power unit that includes a permanently mounted cargo body (also called a straight truck) that 
has three or more axles. 

Stabilized Situation 

The condition prevailing after motion and other action constituting the events of a crash have 
ceased and no further harm will ensue unless a new series of events is initiated by other means. 

T  

 

TAD 

Traffic accident damage. 

Test Status/Test Results 

Indication as to whether alcohol or other drugs test was administered; if test was refused; if the 
results showed alcohol, the percent BAC or BrAC; if the results showed other drugs reported; if 
the sample was contaminated or unusable. 

Tractor/Semi-Trailer 

A truck tractor that is pulling a semi-trailer. 

Traffic Circle/Roundabout 

An intersection of roads where vehicles must travel around a circle to continue on the same 
road or intersecting road. 

Traffic Control Signal 

An electronic device that controls traffic movement. 

Traffic Island 

The cement or grassy area in the middle of a trafficway. 

Traffic Lane 

The specific part of the roadway that is used for vehicular travel. 
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Trafficway 

The entire width between property lines, or other boundary lines, of every way or place, of which 
any part is open to the public for purposes of vehicular travel as a matter of right or custom. 

Transport Collision 

Any collision involving a device designed primarily for (or being used at the time primarily for) 
conveying persons or goods from one place to another. In classifying collisions which involve 
more than one kind of transport, the following order of precedence should be used: 

 Aircraft 

 Watercraft 

 Motor vehicle 

 Railway train 

 Other road vehicle 

This means that a collision involving aircraft and a motor vehicle or a watercraft and a motor 
vehicle will not be classified as a motor vehicle collision. 

Trapped 

Persons who are restrained in a vehicle by damages resulting from a crash. 

Truck Tractor (Bobtail) 

A motor vehicle consisting of a single motorized transport device designed primarily for pulling 
semi-trailers. 

Truck/Trailer 

A motor vehicle combination consisting of a single-unit truck and a trailer (a vehicle designed for 
carrying property and so constructed that no part of its weight rests upon or is carried by the 
towing road vehicle). 

U  

 

Underride/Override 

An underride refers to a vehicle sliding under another vehicle during a crash. An override refers 
to a vehicle riding up over another vehicle. Both can occur with a parked vehicle. 

Unit 

Any motor vehicle, pedestrian, pedalcyclist, moped or other road vehicle, excluding railway 
vehicles. 
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Unstabilized Situation 

A set of events not under human control. It originates when control is lost and terminates when 
control is regained or, in the absence of persons who are able to regain control, when all 
persons and property are at rest. 

Utility Pole 

A pole or post constructed for the primary function of supporting an electric line, telephone line 
or other line or cable. 

V  

 

Van/Enclosed Box 

A single-unit truck, truck/trailer, or tractor/semitrailer having an enclosed body integral to the 
frame of the vehicle. 

Vehicle Authorized Speed Limit 

The posted speed limit for the type of vehicle being driven. Take into account that the limit might 
be different for each vehicle type. 

Vehicle Body Type 

Code used in the Vehicle Identification Number to indicate the general configuration or shape or 
a vehicle distinguished by characteristics such as number of doors, seats, windows, roof line, 
hard top or convertible. 

Vehicle License Plate Number 

The number or other characters, exactly as displayed, on the registration plate or tag affixed to 
the vehicle. For combination trucks, vehicle plate number is obtained from the power unit or 
tractor. 

Vehicle Maneuver/Action 

What the vehicle was doing prior to the crash. 

Vertical Alignment 

The profile or elevation view of a roadway. Vertical alignment is described in terms of grades 
(uphill or downhill) and crest or sag curves. 

W  

 

Warning Signs 

Signs used to warn traffic of existing or potentially hazardous conditions on or adjacent to a 
road. 
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Weight Rating of Power Unit of the Truck 

A gross vehicle weight rating (GVWR) is a value specified by the manufacturer for a single-unit 
truck, truck tractor or trailer, or the sum of the combined units. 

Work Zone 

A segment of the roadway marked to indicate that construction, maintenance, utility or 
intermittent work is being performed. 

Y  

 

Yaw Marks 

Marks created from a tire still rolling while simultaneously sliding laterally. 
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Chapter 11: KeyTips and Other 
Keyboard Shortcuts 

KeyTips are keyboard tips that indicate what key to press to access TraCS functionality. Every 
command in TraCS ribbons can be accessed by using KeyTips. You must press F10 to see the 
KeyTips and then press the indicated keys to run the associated command. In Figure 160, 
pressing F10, V, N, I changes TraCS windows to nighttime mode. 

 

Figure 160. KeyTips Example 

 
NOTE: KeyTips are not case-sensitive. i
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Table BBB through Table JJJ list the Forms Manager KeyTips sequences and Table KKK 
through Table TTT list the Forms Viewer KeyTips sequences. A keyboard shortcut option is 
included in parentheses if available. 

Forms Manager KeyTips 

Table BBB. Forms Manager/Application Menu KeyTips 

To do this Press 

Open Export Report dialog box F10, A, P, E 

Open Print dialog box F10, A, P 

 

Table CCC. Forms Manager/File Tab KeyTips 

To do this Press 

Open Print dialog box F10, F, P, (or CTRL+P) 

Open Create Contact dialog box F10, F, N 

Open selected form F10, F, O (or CTRL+O) 

Delete selected form F10, F, D, E 
(or Delete or CTRL+D) 

Select all forms in Forms Grid F10, F, S 

Deselect all forms in Forms Grid F10, F, D, S 

Refresh current search F10, F, R, E 

Reset to last session defaults F10, F, R, S 

Reset to TraCS defaults F10, F, R, T 

Close TraCS F10, F, E 
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Table DDD. Forms Manager/View Tab KeyTips 

To do this Press 

Display or hide status bar F10, V, N, S, H 

Display or hide navigation bar F10, V, N, A, S 

Change color scheme to Blue F10, V, E, B, L 

Change color scheme to Black F10, V, E, B, A 

Change color scheme to Carmel F10, V, E, C, A 

Change color scheme to Money Twins F10, V, E, M 

Change color scheme to Lilian F10, V, E, L, I 

Change color scheme to Asphalt F10, V, E, A 

Change color scheme to iMaginary F10, V, E, I 

Change color scheme to Coffee F10, V, E, C, O 

Change color scheme to Liquid Sky F10, V, E, L, Q 

Change color scheme to London Liquid Sky F10, V, E, L, O 

Change color scheme to Glass Oceans F10, V, E, G 

Change color scheme to Stardust F10, V, E, S 

Change color scheme to Office 2007 Blue F10, V, E, O, F 

Change color scheme to Office 2007 Black F10, V, E, O, I 

Change color scheme to Office 2007 Silver F10, V, E, O, C 

Change color scheme to Night F10, V, E, N 

Turn nighttime mode on or off F10, V, N, I 

Display or hide search panel F10, V, S, O 

Move search panel to top F10, V, S, E 

Move search panel to bottom F10, V, S, A 

Turn on or off default form search after login F10, V, P 
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Table EEE. Forms Manager/Actions Tab KeyTips 

To do this Press 

Accept validated form F10, A, C, A 

Reject validated form F10, A, C, R 

Display rejection reason F10, A, C, S 

Clear rejected or accepted form status F10, A, C, C 

 

Table FFF. Forms Manager/Tools Tab KeyTips 

To do this Press 

Open Change Password dialog box F10, T, C, H 

Send and receive forms F10, T, S 

Create supplemental F10, T, C, R 

Transfer forms to portable storage device F10, T, T, R 

Transfer forms from portable storage device F10, T, T, A 

 

Table GGG. Forms Manager/Data Transfer Tab KeyTips 

To do this Press 

Archive selected forms F10, D, A 

Unarchive selected forms F10, D, U 
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Table HHH. Forms Manager/Administrative Tab KeyTips 

To do this Press 

Open Officer Notes for selected forms F10, A, D, O 

Set ESD version F10, A, D, S E 

Set GPS CommPort F10, A, D, S, T 

Set CommPort settings F10, A, D, S, C 

Set GPS enable to True or False F10, A, D, S, G 

Set GPS zone F10, A, D, S, P 

Set GPS Datum F10, A, D, S, S 

Set GPS precision F10, A, D,, S, R 

 

Table III. Forms Manager/Window Tab KeyTips 

To do this Press 

Group forms on Forms Grid by the Form Name column heading F10, W, S, A, F, O 

Group forms on the Forms Grid by the Form Number column heading F10, W, S, A, F, R 

Group forms on the Forms Grid by the Form Status column heading F10, W, S, A, F, M 

Group forms on the Forms Grid by the User ID column heading F10, W, S, A, U, S 

Group forms on the Forms Grid by the Form Date column heading F10, W, S, A, F, D 

Group forms on the Forms Grid by the Form Time column heading F10, W, S, A, F, T 

Group forms on the Forms Grid by the Is Locked column heading F10, W, S, A, I 

Group forms on the Forms Grid by the Form Description column 
heading 

F10, W, S, A, F, E 

Group forms on the Forms Grid by the Contact Name column heading F10, W, S, A, C, O 

Group forms on the Forms Grid by the Contact Date column heading F10, W, S, A, C, N 

Group forms on the Forms Grid by the Contact Time column heading F10, W, S, A, C, N 

Group forms on the Forms Grid by the Contact Key column heading F10, W, S, A, C, A 

Group forms on the Forms Grid by the Contact Description column 
heading 

F10, W, S, A, C, C 

Group forms on the Forms Grid by the Archive Date column heading F10, W, S, A, A, R 
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To do this Press 

Group forms on the Forms Grid by the Locked By column heading F10, W, S, A, L, O 

Group forms on the Forms Grid by the Location column heading F10, W, S, A, L, C 

Group forms on the Forms Grid by the User Name column heading F10, W, S, A, U, E 

Group forms on the Forms Grid by the Form Version column heading F10, W, S, A, F, V 

Group forms on the Forms Grid by the User First Name column 
heading 

F10, W, S, A, U, R 

Group forms on the Forms Grid by the User Middle Name column 
heading 

F10, W, S, A, U, M 

Group forms on the Forms Grid by the User Last Name column 
heading 

F10, W, S, A, U, L 

Group forms on the Forms Grid by the Secondary User ID column 
heading 

F10, W, S, A, S, E 

Group forms on the Forms Grid by the Saved File Name column 
heading 

F10, W, S, A, S, A 

Group forms on the Forms Grid by the Modified column heading F10, W, S, A, M 

Group forms on the Forms Grid by the Archive Flag column heading F10, W, S, A, A, C 

Undo grouping F10, W, S, A, A, C 

Table JJJ. Forms Manager/Help Tab KeyTips 

To do this Press 

Display the TraCS version, copyright, and serial number F10, H, A 

Open the NC Division of Motor Vehicles TraCS website F10, H, T, R 

Open the TraCS Technical Support Contacts page F10, H, T, E 

Opens TraCS Help F10, H, H (or F1) 
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Forms Viewer KeyTips 

Table KKK. Forms Viewer/Home Tab/File Group KeyTips 

To do this Press 

Display Forms Manager F10, H, O, F, O 

Change edit mode of form from view-only to edit and back to view-only F10, H, O, E 

Permanently delete the form F10, H, O, D, E (or CTRL+D) 

 
CAUTION: Deleted forms CANNOT be recovered. 

Save open form F10, H, O, S, A 

Open Report Manager Print dialog box F10, H, O, P (or CTRL+P) 

Save and close contact F10, H, O, C, L 

Open Contact Information dialog box F10, H, O, C, O 

Open Form Information dialog box F10, H, O, F, R 

 

Table LLL. Forms Viewer/Home Tab/Groups Group KeyTips 

To do this Press 

Add a new UNIT group F10, H, O, A, D, U 

Add a new PERSON group F10, H, O, A, D, P, E 

Add a new PROPERTY DAMAGE group F10, H, O, A, D, P, R 

Add a new WITNESS group F10, H, O, A, D, W 

Add a new VIOLATION group F10, H, O, A, D, V 

Add a new DMV Validation Messages group F10, H, O, A, D, M 

Delete CRASH DATA group 
(see “KeyTip Notes for Adding and Deleting Groups” on page 11-9) 

F10, H, O, D, L, C 

Delete UNIT group 
(see “KeyTip Notes for Adding and Deleting Groups” on page 11-9) 

F10, H, O, D, L, U 

Delete PERSON group 
(see “KeyTip Notes for Adding and Deleting Groups” on page 11-9) 

F10, H, O, D, L, P, E 

Delete DIAGRAM group 
(see “KeyTip Notes for Adding and Deleting Groups” on page 11-9) 

F10, H, O, D, L, D 

!
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To do this Press 

Delete NARRATIVE group 
(see “KeyTip Notes for Adding and Deleting Groups” on page 11-9) 

F10, H, O, D, L, N 

Delete PROPERTY DAMAGE group 
(see “KeyTip Notes for Adding and Deleting Groups” on page 11-9) 

F10, H, O, D, L, PR 

Delete WITNESS group 
(see “KeyTip Notes for Adding and Deleting Groups” on page 11-9) 

F10, H, O, D, L, W 

Delete VIOLATION group 
(see “KeyTip Notes for Adding and Deleting Groups” on page 11-9) 

F10, H, O, D, L, V 

Delete DMV Validation Messages group 
(see “KeyTip Notes for Adding and Deleting Groups” on page 11-9) 

F10, H, O, D, L, M 

Permanently delete current group and all associated data 
(see “KeyTip Notes for Adding and Deleting Groups” on page 11-9) 

F10, H, O, D, T 

Add another instance of current group type F10, H, O, A, C 

Skip to the first field in the next group F10, H, O, S, K 

 

Table MMM. Forms Viewer/Home Tab/Validation Group KeyTips 

To do this Press 

Validate the active form F10, H, O, V, A 

Open or close the validation error log F10, H, O, V, L 
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KeyTip Notes for Adding and Deleting Groups 

When a recurring group is added to the form, TraCS appends a sequential number to the end of 
the group name. The new group and number displays on the Delete Group list and on the form. 
A unique KeyTip is also assigned and displays on the Delete Group list when KeyTips are 
activated, as shown in Figure 161. 

 

Figure 161. Recurring Groups with KeyTips Activated 

 

CAUTION: If an undeletable group is selected, the data in the group is permanently deleted. 
Deleted groups and data cannot be recovered. !
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Table NNN. Forms Viewer/View Tab/View Group KeyTips 

To do this Press 

Display or hide status bar F10, V, S 

Turn nighttime mode on or off F10, V, N, I 

Display or hide Navigation Bar F10, V, N, A, S 

Move Navigation Bar to left F10, V, N, A, N, A 

Move Navigation Bar to right F10, V, N, A, N, V 

Hide Navigation Tree in Navigation Bar F10, V, N, A, F, H 

Display Navigation Tree in Navigation Bar F10, V, N, A, F, A 

Hide External Information in Navigation Bar F10, V, N, A, E, H 

Display External Information in Navigation Bar F10, V, N, A, E, S 

Activate External Information in Navigation Bar (open External 
Information viewer in the Navigation bar) 

F10, V, N, A, E, A 

 

Table OOO. Forms Viewer/View Tab/Zoom Group KeyTips 

To do this Press 

Set size and zoom options for form Press F10, V, Z and then 
select the zoom setting 
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Table PPP. Forms Viewer/View Tab/Window Group KeyTips 

To do this Press 

Restore Forms Viewer to the default workspace F10, V, R 

Arrange forms in contact in tabbed view F10, V, A, T, A 

Tile forms in contact horizontally F10, V, A, T, I 

Tile forms in contact vertically F10, V, A, T, L 

Cascade forms in contact F10, V, A, C 

List forms in viewer F10, V, V 

Expand databar F10, V, D, A 

Minimize databar F10, V, D, T 

Move databar to bottom F10, V, D, B 

Move databar to top F10, V, D, R 

 

Table QQQ. Forms Viewer/Actions Tab/Custom Actions Group KeyTips 

To do this Press 

(Supervisor only) Change status from Validated to Accepted F10, A, C, A 

(Supervisor only) Change status to Rejected F10, A, C, R 

Show rejection reason F10, A, C, S 

(Supervisor only) Clear Accepted or Rejected form status F10, A, C, C 

 

Table RRR. Forms Viewer/Actions Tab/Officer Notes Group KeyTips 

To do this Press 

Open Officer Notes notepad F10, A, C, O 

 

Table SSS. Forms Viewer/Tools Tab KeyTips 

To do this Press 

Open the View Full Narrative dialog box F10, T, F 
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Table TTT. Forms Viewer Help Tab KeyTips 

To do this Press 

Display the TraCS version, copyright, and serial number F10, H, E, A 

Open the NC Division of Motor Vehicles TraCS website F10, H, E, T, R 

Open the TraCS Technical Support Contacts page F10, H, E, T, E 

Opens TraCS Help F10, H, E, H (or F1) 
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Chapter 12: Index 

access levels, 1-3 
agency administrator, 1-3 
reporter, 1-5 
supervisor, 1-4 

Accident Environment fields, 4-12 
Actions tab, 2-38 

Forms Manager, 2-8 
add 

images to TraCS Diagram Tool, 8-10 
recurring group, 3-9 
symbol to drawing page, 8-6 

Administrative tab, 2-12 
agency administrator, 1-3 
archive form, 2-11 
archive forms, 3-49 
bulk packaging, 5-19 
cargo body types, 5-14 
Carrier fields, 4-51 
change form’s status, 3-47 
clear form’s accepted or rejected status, 3-47 
Clear status button, 2-39 
close 

contact, 2-32, 3-37 
form, 2-32, 3-37 
Navigation Bar, 2-7, 2-36 
TraCS, 2-5 

commercial carrier records 
search:, 3-17 

commercial driver license, 5-7 
Class A, 5-7 
Class B, 5-7 
Class C, 5-7 
visor card, 5-8 

commercial motor vehicle 
defined, 5-1 
motor carriers, 5-2 

commercial motor vehicle (CMV) 
leased, 5-6 
rented, 5-6 

contact 
close, 3-37 
description, 3-3 
edit information, 3-30 

correct validation errors, 3-34 
Crash Data 

Accident Environment fields, 4-12 
fields, 4-2 
groups, 4-2 
Location fields, 4-4 
pre-populated fields, 4-22 

Roadway Information fields, 4-17 
Unit Description fields, 4-24 
Work Zone Related fields, 4-21 

crash diagram, 4-60 
crash requirements, 1-1 
Crashweb, 6-1 
create 

contact description, 3-3 
diagram, 3-24 
NCCRF, 3-1 
supplemental, 3-53 

customer support, 1-7 
databar, 2-44, 3-5 
delete 

form 
Forms Manager, 3-6 
Forms Viewer, 3-6 

recurring group, 3-9 
diagram 

drawing requirements, 3-25 
launch diagram tool, 3-26 

Diagram group, 3-24, 4-60 
DMV Validation Messages field, 3-48, 4-66 
Driver fields, 4-28 
driver information 

search records, 3-10 
Easy Street Draw (ESD), 3-27, 4-60 
enter data in fields, 3-5 
field defaults 

apply, 3-8 
set, 3-7 

fields 
Crash Data, 4-2 
Diagram, 4-60 
Messages, 4-66 
Person, 4-55 
Property Damage, 4-62 
Reject Reason, 4-62 
Unit, 4-23 
Violation, 4-65 
Witness, 4-64 

File tab, 2-4 
form 

accept, 3-46, 3-47 
change status, 3-47 
clear accepted or rejected status, 3-47 
close, 3-37 
delete, 3-6 
edit, 3-40 
reject, 3-46, 3-47 
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send/receive, 3-38 
sort, 2-19 
status, 3-47 
validate, 3-34 

form errors, 3-34 
form status based on user access, 1-6 
Forms Grid, 2-19 

column headings menu, 2-21 
delete forms, 3-6 
search for forms, 2-24 
sort forms, 2-19 

Forms Manager 
Actions tab, 2-8 
Administrative tab, 2-12 
Data Transfer tab, 2-11 
File tab, 2-4 
Forms Grid, 2-19 
Navigation Bar, 2-16 
ribbon, 2-3 
Search Panel, 2-24 
Tools tab, 2-10 
View tab, 2-6 
Window tab, 2-14 

Forms Viewer, 2-30 
Actions tab, 2-38 
databar, 2-44 
Help tab, 2-40 
Home tab, 2-32 
Navigation Bar, 2-41 
Navigation Tree, 2-43 
North Carolina Crash Report Form, 2-45 
ribbon, 2-31 
View tab, 2-35 

glossary, 10-1 
GPS 

activate on the form, 3-23 
set communication port, 3-20 
settings, 2-12 

gross vehicle weight rating (GVWR) 
label locations, 5-11 
small trailers, 5-12 
types, 5-9 

group types 
non-recurring, 4-1 
recurring, 4-2 

groups 
Crash Data, 4-2 
Diagram, 4-60 
Messages, 4-66 
Narrative, 4-61 
Person, 4-55 
Property Damage, 4-62 
Unit, 4-23 
Violation, 4-65 
Witness, 4-64 

hazardous cargo, 5-16 
visor card, 5-18 

Hazardous Materials fields, 4-53 
Help tab, 2-15, 2-40 
hit-and-run related fields, 4-25 

Home tab, 2-32 
identify NCDMV accepted reports in TraCS, 3-52 
Incident Location Tool (ILT), 4-6, 7-1 
KeyTips, 11-1 
Location fields, 4-4 
Messages group, 4-66 
motor carriers, 5-3 

types, 5-2 
narrative 

enter, 3-28 
group, 4-61 

Narrative group 
rejection reason, 3-48 

Navigation Bar 
Forms Manager, 2-16 
Forms Viewer, 2-41 
Navigation Tree, 2-43 

Navigation Tree, 2-43 
NCCRF 

Crash Data group, 4-2 
create, 3-1 
defined, 4-1 
Diagram group, 4-60 
Messages group, 4-66 
Person group, 4-55 
Property Damage group, 4-62 
Reject Reason, 4-62 
submit, 3-1 
Unit group, 4-23 
Violation group, 4-65 
Witness group, 4-64 

non-recurring group, 4-1 
North Carolina Crash Report Form, 2-45 
officer notes, 3-32 
open Navigation Bar, 2-7, 2-36 
Owner fields, 4-48 
password 

change, 2-10 
forgotten, 3-1 

Person group, 4-55 
Property Damage fields, 4-62 
Records Search, 3-10 

commercial carrier records, 3-17 
driver information, 3-10 
vehicle registration information, 3-14 

recurring group, 3-9, 4-2 
add, 3-9 
clear data, 3-9 
delete, 3-9 

rejected form 
correct and resubmit, 3-48 
Reject Reason field, 4-62 
view rejection reason, 3-48 

report status, 2-25 
reporter, 1-5 
retrieve forms from portable storage device, 3-44 
ribbon, 2-3, 2-31 
Roadway Information fields, 4-17 
search 

person name fields, 3-50 
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search criteria 
accident date, 2-28 
case number, 2-28 
contact description, 2-26 
contact name, 2-26 
county, 2-28 
date range, 2-26 
form number, 2-24 
form status, 2-24 
form type, 2-24 
local use, 2-28 
location (agency), 2-24 
locked forms, 2-26 
municipality, 2-28 
person first name, 2-28 
person last name, 2-28 
person middle name, 2-28 
person suffix, 2-28 
person type, 2-28 
secondary user ID, 2-26 
user ID, 2-24 

Search Panel, 2-24 
shipping papers, 5-5 
sort forms, 2-19 
start TraCS, 3-1 
status 

Crashweb, search for reports, 6-1 
form, 3-47 
forms, 1-6 
reports, 2-25 
supervisor, 1-7 

status bar, 2-3, 2-31 
submit 

non-reportable crash, 4-3 
supplemental, 3-54 

submitting 
NCCRF, 3-1 

supervisor, 1-4 
supplemental, Error! Not a valid bookmark in entry 

on page 3-51 

create, 3-53 
creating, 3-51 
instructions, 4-3 
NCDMV Crash ID Number, 6-6 
submit, 3-54 

title bar, 2-31 
Tools tab 

Forms Manager, 2-10 
TraCS defined, 1-1 
TraCS Diagram Tool, 4-60, 8-1 
TraCS version, 3-2 
Trailer Information fields, 4-50 
trailers, gross vehicle weight rating of, 5-12 

training, 1-7 
transfer reports to another computer, 3-41 
transfer reports to portable storage device, 3-42 
unarchive forms, 3-49 
Unit 

Carrier fields, 4-51 
Driver fields, 4-28 
group, 4-23 
Hazardous Materials fields, 4-53 
Owner fields, 4-48 
Trailer Information fields, 4-50 
Vehicle fields, 4-36 

unit data for Driver Hit & Run fields, 4-25 
Unit Description fields, 4-24 
user interface, 2-1 

databar, 2-44 
Forms Grid, 2-19 
Forms Manager, 2-2 
Forms Viewer, 2-30 
KeyTips, 11-1 
Navigation Bar, Forms Manager, 2-16 
Navigation Bar, Forms Viewer, 2-41 
Navigation Tree, 2-43 
North Carolina Crash Report Form, 2-45 
reset to default, 2-5 
ribbon, 2-31 
Search Panel, 2-24 
status bar, 2-3, 2-31 
title bar, 2-31 

validate form, 3-34 
validated form 

accept, 3-46 
receive, 3-45 
reject, 3-46 

Vehicle fields, 4-36 
vehicle registration information 

search records, 3-14 
vehicle style, 5-13, 5-14 
vehicle trailer type, 5-15 
View tab 

Forms Manager, 2-6 
Forms Viewer, 2-35 

Violation 
fields, 4-65 
group, 3-48 

visor cards 
commercial driver license, 5-8 
hazardous cargo, 5-18 
motor carrier, 5-3 
US DOT number, 5-3 

Window tab, 2-14 
Witness fields, 4-64 
Work Zone Related fields, 4-21 
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